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1

About this guide

The One Identity Manager Installation Guide describes the installation and initial operation
of One Identity Manager. This shows you an overview of the architecture of One Identity
Manager and the functions of the various One Identity Manager tools. It also provides
information about the prerequisites you will need before installation of One Identity
Manager, and how to set up, install, and update the components of One Identity Manager.

This guide is intended for end users, system administrators, consultants, analysts, and any
other IT professionals using the product.

NOTE: This guide describes One Identity Manager functionality available to the default
user. It is possible that not all the functions described here are available to you. This
depends on your system configuration and permissions.

Available documentation

You can access One Identity Manager documentation in the Manager and in the Designer by
selecting the Help > Searchmenu item. The online version of One Identity Manager
documentation is available in the Support portal under Technical Documentation. You will
find videos with additional information at www.YouTube.com/OneIdentity.
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2

One Identity Manager overview

One Identity Manager simplifies the process of managing user identities, access
permissions and security policies. You allow the company control over identity
management and access decisions while the IT team focuses on their core competencies.

With this product, you can:

l Implement group management using self-service and attestation for Active Directory
with the One Identity Manager Active Directory Edition

l Simplify access decisions for restructuring data with the One Identity Manager Data
Governance Edition

l Realize Access Governance demands cross-platform within your entire company with
One Identity Manager

Every one of these scenario specific products is based on an automation-optimized
architecture that addresses major identity and access management challenges at a fraction
of the complexity, time, or expense of "traditional" solutions.

One Identity Starling

Initiate your subscription within your One Identity on-prem product and join your on-prem
solutions to our One Identity Starling cloud platform. Giving your organization immediate
access to a number of cloud-delivered microservices, which expand the capabilities of your
One Identity on-prem solutions. We will continuously make available new products and
features to One Identity Starling. For a free trial of our One Identity Starling offerings and
to get the latest product feature updates, visit cloud.oneidentity.com.

One Identity Manager editions

One Identity Manager is available in the following editions.

One Identity Manager

This edition contains all management modules (IT Shop & workflow, delegation,
management of system roles and business roles, role mining, risk assessment, attestation,
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compliance, company policies, report subscriptions), as well as Unified Namespace and
connectors for Active Directory.

One Identity Manager Active Directory Edition

This edition contains all the functionality required for Active Directory support including
connectors for Active Directory, attestation, IT Shop and workflows, and report functions.

One Identity Manager Data Governance Edition

This edition contains the features required for data governance support including the
connectors for Active Directory and SharePoint, risk assessment, attestation, compliance,
company policies, delegation, report subscriptions, and the Data Governance service.

One Identity Manager architecture

Figure 1: Overview of One Identity Manager components

One Identity Manager consists of the following components:

Database

The database represents the core of One Identity Manager. It fulfills the main tasks, which
are managing data and calculating inheritance. Object properties can be inherited along the
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hierarchical structures, such as departments, cost centers, location, or business roles. For
data management, the database maps managed target systems and ERP structures as well
as compliance rules and access permissions.

The database is separated into two logical parts; payload and metadata. The payload
contains all the information required to maintaining data, such as information about
employees, user accounts, groups, memberships, operating data, approval workflows,
attestation, recertification, and compliance rules.

The metadata contains the description of the application data model and scripts for
formatting roles and templates or conditional interactions. One Identity Manager’s entire
system configuration, all the front-end control settings, and the queues for asynchronous
processing of data and processes are also part of the metadata.

Recalculation of inheritance is started by the database trigger logic. For this purpose, the
triggers place processing tasks in a task list known as the DBQueue. The DBQueue
Processor processes these tasks and recalculates inheritance of the respective database
objects. A table labeled JobQueue is used to store processing orders that are to be run by
the object layer.

A SQL Server or a managed instance in Azure SQL Database is used as the
database system.

Server service

One Identity Manager uses processes for mapping business processes. A process consists
of process steps that represent processing tasks and are joined by predecessor/successor
relations. This functionality allows flexibility when linking actions and sequences to object
events. Processes are modeled using process templates. A process generator
(Jobgenerator) is responsible for converting script templates in processes and process
steps into a concrete process in the ’Job queue’.

The One Identity Manager Service enables the distribution throughout the network of
information that is administrated in the One Identity Manager database. The One Identity
Manager Service performs data synchronization between the database and any connected
target systems and runs actions at the database and file level.

The One Identity Manager Service retrieves process steps from the Job queue. Process
steps are run by process components. The One Identity Manager Service also creates an
instance of the required process component and transfers the process step parameters.
Decision logic monitors the performance of the process steps and determines how
processing should continue depending on the results of the run process components. The
One Identity Manager Service enables parallel processing of process steps because it can
create several instances of process components.

The One Identity Manager Service is the only One Identity Manager component authorized
to make changes in the target system.

Application server

Clients connect to an application server storing business logic. The application server
provides a connection pool for accessing the database and ensures a secure connection to
the database. Clients send their queries to the application server, which processes the
objects, for example, by determining values using templates and sending the results back
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to the clients. The data from the application is sent to the database when an object is
saved.

Clients can alternatively work without external application servers by retaining the object
layer themselves and accessing the database layer directly. In this case, only the part of
the object layer that is required for the acquisition process is mapped in the clients.

Web server

To implement browser-based user interfaces, there is an application running on a web
server that is based on a website render engine. Users use a web browser to access the
website that has been dynamically set up and customized for them. Data exchange
between database and web server can take place either directly or through the
application server.

Front-ends

There are different front-ends for different tasks. For example, a different front-end is used
to configure One Identity Manager than that for managing employee data. The contents to
be displayed and the extent to which it can be altered is determined in conjunction with the
access permissions of the respective user through the object layer. Available front-end
solutions are both client and browser-based.

Figure 2: Overview of One Identity Manager components without
application servers
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Related topics

l One Identity Manager tools on page 13
l Which components and front-ends work with an application server? on page 17

One Identity Manager tools

Different tools are provided for different tasks. For example, the tool used to configure One
Identity Manager differs from the tool used to manage employee data. The content
displayed and its editability are dependent on the permissions of the logged in user.

Tool Short description

Launchpad The Launchpad is the central tool for starting One Identity Manager
administration tools and configuration tools. You can use the
Launchpad to check the existing One Identity Manager installation
and start One Identity Manager tools to run individual tasks.

The Launchpad can be customized. In the Designer, you can define
your own menu items and actions for the Launchpad.

Web Portal The Web Portal is a web-based application for all One Identity
Manager users. The Web Portal provides stringent workflows in the
following areas:

l Changing employee main data and own password.
l Editing or entering employee main data of subordinate staff.
l Searching, requesting, canceling, or renewing products in the
IT Shop.

l Delegating own roles.
l Editing assigned approvals, attestation cases, and rule
violations.

In the information system, you may see several evaluations, for
example, about your own requests and attestation cases, employee
numbers, approvals, rule violations, or the Unified Namespace.

The Web Portal is made available over the API Server. Through a web
browser, users can access the website that has been dynamically set
up and customized for them.

The Web Designer Web Portal is deployed for compatibility reasons.
The Web Designer Web Portal requires a web server.

Password Reset
Portal

The Password Reset Portal allows users to securely reset passwords
of the user accounts they manage.

Table 1: Overview of One Identity Manager tools
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Tool Short description

The Password Reset Portal is made available over the API Server. The
necessary security is guaranteed by multi-factor authentication.

Operations
Support Web
Portal

The Operations Support Web Portal helps you to manage and use
your web applications. You can use the Operations Support Web
Portal to monitor the handling of processes and DBQueue tasks. You
can also create passcodes for your colleagues.

The Operations Support Web Portal is made available over the API
Server.

Manager The Manager is the main administration tool for setting up
information about employees and their identities. It displays and
maintains all the data required for the administration of employees,
their user accounts, permissions, and company-specific roles in a One
Identity Manager network. Company resources employees require
can be entered and assigned to them.

You can also use the Manager to:

l Define custom IT policies.
l Set up an IT Shop from which company resources and
assignments can be requested.

l Set up special approval processes for authorizing requests and
checking compliance to IT policy.

l Set up attestation procedures for regularly testing the
correctness of data about employees or roles and their
assignments.

By implementing One Identity Manager application roles, every One
Identity Manager user obtains only those permissions they require to
fulfill necessary administrative duties.

Manager functionality can be provided by web applications.

Synchronization
Editor

You use the Synchronization Editor to connect different target
systems to One Identity Manager. Use this tool to configure data
synchronization for any target system and specify which target
system data is mapped to the One Identity Manager database. You
also define the object properties mapping and the synchronization
sequence as a workflow.

Analyzer Use the Analyzer to automatically detect and analyze data
correlations in the database. This information can be used to replace,
for example, direct permissions assignments with indirect
assignments, therefore reducing the administration effort.

Job Queue Info The Job Queue Info helps you check the current status of the services
running in a One Identity Manager network. It displays, in a detailed
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Tool Short description

and comprehensive manner, the tasks in the Job queue and the
different One Identity Manager Service requests on the servers. The
tool provides on-the-fly status information and makes fast error
detection possible.

Configuration
Wizard

The Configuration Wizard is used to set up the database on a SQL
Server for use in a One Identity Manager network. All the One
Identity Manager schema tables, data types, and database
procedures are loaded into the database with the Configuration
Wizard. SQL Server logins and database users are created with
permissions for the One Identity Manager schema.

Automatic version control is integrated into One Identity Manager,
ensuring that One Identity Manager components are always
consistent with each other and with the database. If program updates
are implemented that change the structure (for example, table
extensions), database migration is then necessary. The Configuration
Wizard runs this schema installation depending on the current status
of the schema.

Designer The Designer is the main tool for configuring One Identity Manager.
The program offers an overview of the entire One Identity Manager
data model. It enables the configuration of global system settings, for
example, language, or configuration parameters, as well as
customizing the user interface for the various administration tools.
You use the Designer to specify permissions for the different
administrative tasks of individual users and user groups. Another
important task is the definition of workflows for technically illustrating
the administration procedures in a company. The Designer provides
various editors for the One Identity Manager system configuration.
The range of functions and the operating methods of the editors are
tailored to the differing configuration requirements.

Web Designer Use the Web Designer to configure and extend the Web Designer Web
Portal. It includes functions for adapting Web Designer Web Portal
workflows and developing new workflows.

Data Import With the Data Import program, One Identity Manager offers a simple
way to import data from other systems. Use this program if you want
to import company resource data from external sources into your
database. The program supports importing from files and importing
directly from other database systems. You can import data
immediately. You also have the option to import data from
customized processes using the import scripts that are created. The
import definition is saved so that you can use it for future data
imports.

Crypto In certain circumstances it is necessary store encrypted information
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Tool Short description

Configuration in the database. Use the Crypto Configuration program to carry out
encryption. This program creates a code file and converts the
contents of the affected database column. The coded information is
stored in the database.

Database
Compiler

You must compile the One Identity Manager database after making
changes to configuration data. After a migration package or full
custom configuration package is imported, database compiling begins
immediately from the Configuration Wizard or Database Transporter.

The Database Compiler compiles the One Identity Manager database
after you import hotfixes or when changes have been made to
processes, scripts, formatting rules, object definitions, task
definitions, or preprocessor-relevant configuration parameters.

Report Editor With the Report Editor, you can group One Identity Manager object
data together into reports. You can group, accumulate, and
graphically represent this data. Predefined reports are supplied
though migration but you can also create your own reports with the
Report Editor.

Schema
Extension

The Schema Extension is implemented to extend the One Identity
Manager schema by custom tables and columns. Using the object
technology in One Identity Manager, you can customize the
application data model at database level so that the extensions are
available with full functionality at object level.

System Debugger The System Debugger allows you to process and test scripts. Existing
scripts in your One Identity Manager database are imported into a
Visual Studio script library. There, you can edit and test the scripts.
Subsequently, you decide whether your changes should be
transferred to the One Identity Manager database.

Database
Transporter

The Database Transporter transfers objects and custom changes as
well as custom database procedures, triggers, functions, and sets
from the One Identity Manager database (source) to another One
Identity Manager database (target).

HistoryDB
Manager

One Identity Manager historical data is transferred at regular
intervals into a One Identity Manager History Database thus, the One
Identity Manager History Database provides an archive of change
information. The HistoryDB Manager tool displays the data in the One
Identity Manager History Database. Use the HistoryDB Manager to
set up access to the source databases.

Job Service
Configuration

Use the Job Service Configuration to create and customize the
configuration file for the One Identity Manager Service. The One
Identity Manager Service and its plugins are configured with this file.
The configuration file is necessary both for One Identity Manager

One Identity Manager 9.0 Installation Guide

One Identity Manager overview
16



Tool Short description

Service on a Windows based operating system and also for the Linux
daemon.

License Meter Using the License Meter, you can track and maintain the licenses in
your One Identity Manager database. The wizard creates a report
with license-relevant information.

Software Loader Use the Software Loader to load new or modified files, for example
custom form archives, in the One Identity Manager database in order
to distribute them to One Identity Manager network workstations and
Job servers using automatic software updating.

Server Installer Use the Server Installer to install and configure the One Identity
Manager Service. The program runs remote installation of the One
Identity Manager Service. Local installation of the service is not
possible with this program.

API Server The API Server deploys your API. It also deploys the Web Portal, the
Password Reset Portal as well as the Operations Support Web Portal
and your HTML5 web applications.

Related topics

l Which components and front-ends work with an application server? on page 17

Which components and front-ends work
with an application server?

The following list shows you which One Identity Manager components can work with an
application server. Some front-ends have only limited functionality to work with an
application server.

Component Connection
through applic-
ation server?

Restrictions

Launchpad Yes Certain application, which you can start from
the Launchpad, require a direct connection to
the database.

Web Portal Yes

Password Reset
Portal

Yes

Table 2: One Identity Manager components and application servers
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Component Connection
through applic-
ation server?

Restrictions

Operations
Support Web
Portal

Yes

Manager Yes The consistency check is not supported.

Compliance rule simulation is not supported.

Some forms are not supported.

Manager web
application

Yes Some forms are not supported.

Synchronization
Editor

Yes

Analyzer Yes

Job Queue Info No

Configuration
Wizard

No

Designer Yes The consistency check is not supported.

Process simulation is not supported.

Database compilation is not supported.

Web Designer Yes

Data Import Yes

Crypto Config-
uration

No

Database
Compiler

No

Report Editor Yes SQL query testing is not supported.

Schema
Extension

No

System Debugger Yes

Database Trans-
porter

No

HistoryDB
Manager

Yes
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Component Connection
through applic-
ation server?

Restrictions

License Meter Yes

Software Loader Yes

One Identity
Manager Service

Yes

Server Installer Yes

API Server Yes

Database Agent
Service

No
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3

Installation prerequisites

The following installation prerequisites represent only the minimum requirements for
installing and unlimited operation of One Identity Manager. These prerequisites can be
used as a starting point for other planning, depending on the size of the project and which
business processes and business transactions are supported. Determining hardware
capacities and any further development is part of project planning and dependent on the
Identity Management project specification. Particular attention must be paid to I/O
performance (in throughput and latency) and in SAN environments in particular, a targeted
performance analysis of the specify infrastructure is recommended before implementation.

Every One Identity Manager installation can be virtualized. Ensure that performance and
resources are available to the respective One Identity Manager component according to
system requirements. Ideally, resource assignments for the database server are fixed.
Virtualization of a One Identity Manager installation should only be attempted by experts
with strong knowledge of virtualization techniques. For more information about virtual
environments, see Product Support Policies.

NOTE: Other system requirements for individual One Identity Manager models are listed
in the corresponding documentation for those specific modules.

Detailed information about this topic

l Minimum system requirements for implementing SQL Servers as database
servers on page 21

l Requirements for a managed instance in Azure SQL Database on page 30
l Minimum system requirements for administrative workstations on page 36
l Minimum system requirements for Job servers on page 37
l Minimum system requirements for the web server on page 38
l Minimum system requirements for the application server on page 39
l Users for One Identity Manager on page 41
l Users with granular permission for the One Identity Manager database on an SQL
Server on page 25

l Permissions for the One Identity Manager database in a managed instance in an
Azure SQL Database on page 32
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l Setting up permissions for creating an HTTP server on page 42
l Communications ports and firewall configuration on page 43

Minimum system requirements for
implementing SQL Servers as database
servers

A server must meet the following system requirements for installation of a One Identity
Manager database. Depending on the number of One Identity Manager modules and the
accounts managed in One Identity Manager, the requirements for working memory, hard
disk storage, and processors may be significantly greater than the minimum requirements.

Processor 8 physical cores with 2.5 GHz+ frequency (non-production)

16 physical cores with 2.5 GHz+ frequency (production)

NOTE: 16 physical cores are recommended on the grounds of perform-
ance.

Memory 16 GB+ RAM (non-production)

64 GB+ RAM (production)

Hard drive
storage

100 GB

Operating
system

Windows operating systems

l Note the requirements of Microsoft for the version of SQL Server
you are using.

UNIX and Linux operating systems

l Note the operating system manufacturer's minimum requirements
for SQL Server databases.

Software Following versions are supported:

l SQL Server 2019 Standard Edition (64-bit) with the current
cumulative update

NOTE: The cumulative update 2 for SQL Server 2019 is not
supported.

NOTE: For performance reasons, the use of SQL Server Enterprise
Edition is recommended for live systems.

l SQL Server Management Studio (recommended)

Table 3: Minimum system requirements - database server
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NOTE: The minimum requirements listed above are considered to be for general use.
With each custom One Identity Manager deployment these values may need to be
increased to provide ideal performance. To determine production hardware require-
ments, it is strongly recommended to consult a qualified One Identity Partner or the One
Identity Professional Services team. Failure to do so may result in poor database
performance.

For additional hardware recommendations, read the KB article https://sup-
port.oneidentity.com/identity-manager/kb/290330/how-to-configure-settings-as-per-
the-system-information-overview, which describes the overview of the system inform-
ation available in One Identity Manager.

NOTE: In virtual environments, you must ensure that the VM host provides performance
and resources to the database server according to system requirements. Ideally,
resource assignments for the database server are fixed. Furthermore, optimal I/O
performance must be provided, in particular for the database server. For more
information about virtual environments, see Product Support Policies.

Related topics

l Settings for the database server and the One Identity Manager database on a SQL
Server on page 22

l Users with granular permission for the One Identity Manager database on an SQL
Server on page 25

Settings for the database server and the
One Identity Manager database on a SQL
Server

For installation and operation of a One Identity Manager database, the following database
server and database settings are required:

Property Value Comment

Language English

Server
Collation

Case insensitive

SQL_Latin1_General_
CP1_CI_AS
(recommended)

Extreme
transaction
processing
supported (Is

True One Identity Manager uses In-Memory-OLTP
(Online Transactional Processing) for memory-
optimized data accesses. The database server
must support extreme transaction processing

Table 4: Database server settings
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Property Value Comment

XTP
supported)

(XTP). This function is activated by default in a
default installation.

The setting is tested by the Configuration Wizard
before installing or updating One Identity
Manager database. If XTP is not activated, the
installation or update does not start.

Property Value Comment

Collation SQL_Latin1_General_
CP1_CI_AS

The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Recovery model Simple The setting is tested by the Configuration
Wizard before installing or updating One
Identity Manager database. If the recovery
model is not set to the value Simple, a
warning is issued before installing or
updating starts. You can ignore this
warning.

For performance reasons, however, it is
recommended you set the database to the
Simple recovery model for the duration of
the schema installation or update.

Compatibility level SQL Server 2019
(150)

The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Auto Create
Statistics

True The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Auto Update
Statistics

True The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Auto Update
Statistics
Asynchronously

True The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Arithmetic Abort True The setting is checked by the Configuration

Table 5: Database settings
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Property Value Comment

enabled Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Quoted Identifiers
Enabled

True The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Is Read
Committed
Snapshot On

True The default setting for transactions is
AutoCommit. If transactions are required,
they are opened explicitly.

These settings have proven to provide the
best balance between data security and
performance for One Identity Manager's
massive parallel processing. Other trans-
action modes are not supported by One
Identity Manager.

The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Parameterization Forced The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Database file and
date file group for
memory-
optimized tables

Required One Identity Manager uses In-Memory-
OLTP (Online Transactional Processing) for
memory-optimized data accesses.

For the creation of memory-optimized
tables, the following prerequisites must be
met:

l A database file with the Filestream
data file type must exist.

l A memory-optimized data filegroup
must exist.

Before installation or update of the One
Identity Manager database, the Config-
uration Wizard checks whether these
requirements are fulfilled.

In the Configuration Wizard, repair methods
are offered in order to create the database
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Property Value Comment

file and the data file group. The database file
is created by the repair method in the
directory of the data file (*.mdf).

Table variable
deferred
compilation
(DEFERRED_
COMPILATION_
TV)

ON The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Interleaved
execution
(INTERLEAVED_
EXECUTION_TVF)

ON The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

For more information about the named database server properties, see
https://docs.microsoft.com/en-us/sql/database-engine/configure-windows/view-or-
change-server-properties-sql-server.

For more information about the database properties, see https://docs.microsoft.com/en-
us/sql/relational-databases/databases/view-or-change-the-properties-of-a-database and
https://docs.microsoft.com/en-us/sql/relational-databases/system-catalog-views/sys-
databases-transact-sql.

Related topics

l Minimum system requirements for implementing SQL Servers as database
servers on page 21

l Users with granular permission for the One Identity Manager database on an SQL
Server on page 25

l Error messages when installing and updating the One Identity Manager
database on page 167

Users with granular permission for the One
Identity Manager database on an SQL Server

The following users are identified for using a One Identity Manager database on a SQL
Server with the granular permissions concept. User permissions at server and database
level are matched to their tasks.

NOTE: If you want to switch to granular permissions when you update from 8.1.x at a
later date, contact support. To access the Support Portal, go to https://sup-
port.oneidentity.com/identity-manager/.
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l Installation user

The installation user is needed for the initial installation of a One Identity Manager
database using the Configuration Wizard.

NOTE: If you want to change to the granular permissions concept when you
upgrade from version 8.0.x to 9.0, you will also require an installation user.

l Administrative user

The administrative user is used by components of One Identity Manager that require
authorizations at server level and database level, for example, the Configuration
Wizard, the DBQueue Processor, or the One Identity Manager Service.

l Configuration user

The configuration user can run configuration tasks within One Identity Manager, For
example, creating customer-specific schema extensions or working with the
Designer. Configuration users need permissions at the server and database levels.

l End users

End users are only assigned permissions at database level in order, for example, to
complete tasks with the Manager or the Web Portal.

For more information about minimum access levels for One Identity Manager tools, see the
One Identity Manager Authorization and Authentication Guide.

Permissions for installation users

A SQL Server login and a database user with the following permissions must be provided
for the installation user.

SQL Server:

l Member of dbcreator server role

The server role is only required if the database is created using the
Configuration Wizard.

l Member of the sysadmin server role

This server role is only required if the database is created by the Configuration
Wizard and the directories for the file must be selected in the file browser. If the files
are stored in the default database server directories, permissions are not necessary.

l Member of securityadmin server role

This server role is required to create SQL Server logins.
l view server state permissions with thewith grant option option and alter any
connection permissions with thewith grant option option.

The permissions are required to check connections and close these if necessary.
l alter any server role permissions

The permissions are required to create the server role for the administrative user.
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msdb database:

l alter any user permissions

The permissions are required to create the necessary database users for the admin-
istrative user.

l alter any role permissions

This permission is required to create the necessary database role for the
administrative user.

module database:

l alter any user permissions

The permissions are required to create the necessary database users for the admin-
istrative user.

l alter any role permissions

This permission is required to create the necessary database role for the
administrative user.

l Run permissions with the with grant option option for the xp_readerrorlog
procedure

The permissions are required to find out information about the database server's
system status.

One Identity Manager database:

l Member of the db_owner database role

This database role is only required if you wish to use an existing database or
a schema update is performed when installing the schema with the
Configuration Wizard.

Permissions for administrative users

During the installation of the One Identity Manager database using the Configuration
Wizard, the following principal elements and permissions are created for the
administrative user:

SQL Server:

l OneIMAdminRole_<DatabaseName> server role
l alter any server role permissions

The permissions are required to create the server role for the
configuration user.

l view any definition permissions

The permissions are required to link the SQL Server logins for the configuration
user and the end user with the corresponding database users.

l <DatabaseName>_Admin SQL server login
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l Member of the OneIMAdminRole_<DatabaseName> server role
l view server state permissions with thewith grant option option and alter
any connection permissions with thewith grant option option.

The permissions are required to check connections and close these if
necessary.

msdb database:

l OneIM_<DatabaseName> database user
l Member of the OneIMRole_<DatabaseName>database role
l The database user is assigned to the <DatabaseName>_Admin SQL
server login.

module database:

l OneIMRole_<DatabaseName> database role
l Run permissions for the xp_readerrorlog procedure

The permissions are required to find out information about the database
server's system status.

l OneIM_<DatabaseName> database user
l Member of the OneIMRole_<DatabaseName> database role
l The database user is assigned to the <DatabaseName>_Admin SQL
server login.

One Identity Manager database:

l Admin database user
l Member in db_owner database role

The database role is required to update a database with the
Configuration Wizard.

l The database user is assigned to the <DatabaseName>_Admin SQL
server login.

Permissions for configuration users

During the installation of the One Identity Manager database using the Configuration
Wizard, the following principal elements and permissions are created for
configuration users:

SQL Server:

l OneIMConfigRole_<DatabaseName> server role
l view server state and alter any connection permissions

The permissions are required to check connections and close these if
necessary.
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l <DatabaseName>_Config SQL login
l Member of the OneIMConfigRole_<DatabaseName> server role

One Identity Manager database:

l OneIMConfigRoleDB database role
l Create Procedure, Delete, Select, Create table, Update,
Checkpoint, Create View, Insert, Run, and Create function
permissions for the database

l Config database user
l Member of the OneIMConfigRoleDB database role
l The database user is connected with the <DatabaseName>_Config SQL
Server login.

Permissions for end users

The following principals are created with the permissions for end users during the
installation of the One Identity Manager database with the Configuration Wizard:

SQL Server:

l <DatabaseName>_User SQL login

One Identity Manager database:

l OneIMUserRoleDB database role
l Insert, Update, Select, and Delete permissions for selected tables in
the database

l View Definition permissions for the database
l Run and References permissions for individual functions, procedures,
and types

l User database user
l Member of the OneIMUserRoleDB database role
l The database user is connected with the <DatabaseName>_User SQL
Server login.

Tips for using integrated Windows authentication

Integrated Windows authentication can be used without restriction for the One Identity
Manager Service and the web applications. Integrated Windows authentication can be used
for FAT clients. Use of Windows groups for logging in is supported. To ensure functionality it
is strongly recommended you use SQL Server login.

To implement Windows authentication

l Set up a SQL Server login for the user account on the database server.
l Enter dbo as the default schema.
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l Assign the required permissions SQL server login.

Requirements for a managed instance
in Azure SQL Database

To manage the One Identity Manager database in a managed instance in Azure SQL
Database, you require the Business critical tier. For more detailed information, see the
Microsoft site under https://azure.microsoft.com/en-us/services/sql-database/.

Related topics

l Database server settings and the One Identity Manager database in a managed
instance in an Azure SQL Database on page 30

l Permissions for the One Identity Manager database in a managed instance in an
Azure SQL Database on page 32

Database server settings and the One
Identity Manager database in a managed
instance in an Azure SQL Database

For installation and operation of a One Identity Manager database, the following database
server and database settings are required:

Property Value Comment

Language English

Server Collation Case insensitive

SQL_Latin1_General_CP1_
CI_AS (recommended)

Extreme transaction processing supported
(Is XTP supported)

True Default
setting.

Table 6: Database server settings

Property Value Comment

Collation SQL_Latin1_General_
CP1_CI_AS

The setting is checked by the Configuration
Wizard before installing or updating the One

Table 7: Database settings
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Property Value Comment

Identity Manager database and adjusted for
the database if necessary.

Recovery model Full Default setting.

Compatibility level SQL Server 2019
(150)

The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Auto Create
Statistics

True The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Auto Update
Statistics

True The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Auto Update
Statistics
Asynchronously

True The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Arithmetic Abort
enabled

True The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Quoted Identifiers
Enabled

True The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Is Read
Committed
Snapshot On

True The default setting for transactions is
AutoCommit. If transactions are required,
they are opened explicitly.

These settings have proven to provide the
best balance between data security and
performance for One Identity Manager's
massive parallel processing. Other trans-
action modes are not supported by One
Identity Manager.

The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.
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Property Value Comment

Parameterization Forced The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Database file and
date file group for
memory-
optimized tables

Required Default setting.

Table variable
deferred
compilation
(DEFERRED_
COMPILATION_
TV)

ON The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Interleaved
execution
(INTERLEAVED_
EXECUTION_TVF)

ON The setting is checked by the Configuration
Wizard before installing or updating the One
Identity Manager database and adjusted for
the database if necessary.

Permissions for the One Identity Manager
database in a managed instance in an Azure
SQL Database

The following users are identified for using a One Identity Manager database in a managed
instance in the Azure SQL Database with the granular permissions concept. User
permissions at server and database level are matched to their tasks.

l Installation user

The installation user is needed for the initial installation of a One Identity Manager
database using the Configuration Wizard.

l Administrative user

The administrative user is used by components of One Identity Manager that require
authorizations at server level and database level, for example, the Configuration
Wizard, the DBQueue Processor, or the One Identity Manager Service.

l Configuration user

The configuration user can run configuration tasks within One Identity Manager, For
example, creating customer-specific schema extensions or working with the
Designer. Configuration users need permissions at the server and database levels.

l End users
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End users are only assigned permissions at database level in order, for example, to
complete tasks with the Manager or the Web Portal.

For more information about minimum access levels for One Identity Manager tools, see the
One Identity Manager Authorization and Authentication Guide.

Permissions for installation users

A SQL Server login and a database user with the following permissions must be provided
for the installation user.

SQL Server:

l Member of dbcreator server role

The server role is only required if the database is created using the
Configuration Wizard.

l Member of securityadmin server role

This server role is required to create SQL Server logins.
l view server state permissions with thewith grant option option and alter any
connection permissions with thewith grant option option.

The permissions are required to check connections and close these if necessary.
l alter any server role permissions

The permissions are required to create the server role for the administrative user.

msdb database:

l alter any user permissions

The permissions are required to create the necessary database users for the admin-
istrative user.

l alter any role permissions

This permission is required to create the necessary database role for the
administrative user.

module database:

l alter any user permissions

The permissions are required to create the necessary database users for the admin-
istrative user.

l alter any role permissions

This permission is required to create the necessary database role for the
administrative user.

l Run permissions with the with grant option option for the xp_readerrorlog
procedure

The permissions are required to find out information about the database server's
system status.
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One Identity Manager database:

l Member of the db_owner database role

This database role is only required if you wish to use an existing database or
a schema update is performed when installing the schema with the
Configuration Wizard.

Permissions for administrative users

During the installation of the One Identity Manager database using the Configuration
Wizard, the following principal elements and permissions are created for the
administrative user:

SQL Server:

l OneIMAdminRole_<DatabaseName> server role
l alter any server role permissions

The permissions are required to create the server role for the
configuration user.

l view any definition permissions

The permissions are required to link the SQL Server logins for the configuration
user and the end user with the corresponding database users.

l <DatabaseName>_Admin SQL server login
l Member of the OneIMAdminRole_<DatabaseName> server role
l view server state permissions with thewith grant option option and alter
any connection permissions with thewith grant option option.

The permissions are required to check connections and close these if
necessary.

msdb database:

l OneIM_<DatabaseName> database user
l Member of the OneIMRole_<DatabaseName>database role
l The database user is assigned to the <DatabaseName>_Admin SQL
server login.

module database:

l OneIMRole_<DatabaseName> database role
l Run permissions for the xp_readerrorlog procedure

The permissions are required to find out information about the database
server's system status.

l OneIM_<DatabaseName> database user
l Member of the OneIMRole_<DatabaseName> database role
l The database user is assigned to the <DatabaseName>_Admin SQL
server login.
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One Identity Manager database:

l Admin database user
l Member in db_owner database role

The database role is required to update a database with the
Configuration Wizard.

l The database user is assigned to the <DatabaseName>_Admin SQL
server login.

Permissions for configuration users

During the installation of the One Identity Manager database using the Configuration
Wizard, the following principal elements and permissions are created for
configuration users:

SQL Server:

l OneIMConfigRole_<DatabaseName> server role
l view server state and alter any connection permissions

The permissions are required to check connections and close these if
necessary.

l <DatabaseName>_Config SQL login
l Member of the OneIMConfigRole_<DatabaseName> server role

One Identity Manager database:

l OneIMConfigRoleDB database role
l Create Procedure, Delete, Select, Create table, Update,
Checkpoint, Create View, Insert, Run, and Create function
permissions for the database

l Config database user
l Member of the OneIMConfigRoleDB database role
l The database user is connected with the <DatabaseName>_Config SQL
Server login.

Permissions for end users

The following principals are created with the permissions for end users during the
installation of the One Identity Manager database with the Configuration Wizard:

SQL Server:

l <DatabaseName>_User SQL login
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One Identity Manager database:

l OneIMUserRoleDB database role
l Insert, Update, Select, and Delete permissions for selected tables in
the database

l View Definition permissions for the database
l Run and References permissions for individual functions, procedures,
and types

l User database user
l Member of the OneIMUserRoleDB database role
l The database user is connected with the <DatabaseName>_User SQL
Server login.

Minimum system requirements for
administrative workstations

One Identity Manager administration and configuration tools are installed on an
administrative workstation in order to edit and display data.

To install on an administrative workstation, the following system requirements must
be met.

Processor 4 physical cores 2 GHz+

Memory 4 GB+ RAM

Hard drive storage 1 GB

Operating system Windows operating systems

Following versions are supported:

l Windows 11 (x64)
l Windows 10 (32-bit or 64-bit) at least version 1511
l Windows 8.1 (32-bit or 64-bit) with the current service
pack

Additional software l Microsoft .NET Framework version 4.8 or later
l Microsoft Edge WebView2

Supported browsers l Firefox (release channel)
l Chrome (release channel)
l Microsoft Edge (release channel)

Table 8: Minimum system requirements - administrative workstations
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Minimum system requirements for Job
servers

The One Identity Manager Service enables the distribution throughout the network of
information that is administrated in the One Identity Manager database. The One Identity
Manager Service performs data synchronization between the database and any connected
target systems and runs actions at the database and file level.

You install the One Identity Manager Service on a server. A server running the One Identity
Manager Service is subsequently called the Job server.

The following system prerequisites must be fulfilled to install the One Identity Manager
Service on a server.

Processor 8 physical cores 2.5 GHz+

Memory 16 GB RAM

Hard drive
storage

40 GB

Operating
system

Windows operating systems

The following versions are supported:

l Windows Server 2022
l Windows Server 2019
l Windows Server 2016
l Windows Server 2012 R2
l Windows Server 2012

Linux operating systems

l Linux operating system (64-bit), supported by the Mono project, or
Docker images provided by the Mono project.

Additional
software

Windows operating systems

l Microsoft .NET Framework version 4.8 or later

NOTE: When connecting the target system, refer to the target
system manufacturer's recommendations.

Linux operating systems

l Mono 5.14 or higher

NOTE: In newer versions of Mono, starting with version 6.10, set
the MONO_PATH environment variable explicitly to the current install
directory to ensure that all referenced assemblies can be loaded.

Table 9: Minimum system requirements - Job server
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Related topics

l Users for One Identity Manager on page 41

Minimum system requirements for the
web server

The following system prerequisites must be fulfilled to install web applications on a
web server.

Processor 4 physical cores 1.65 GHz+

Memory 4 GB RAM

Hard drive
storage

40 GB

Operating
system

Windows operating systems

The following versions are supported:

l Windows Server 2022
l Windows Server 2019
l Windows Server 2016
l Windows Server 2012 R2
l Windows Server 2012

Linux operating systems

l Linux operating system (64-bit), supported by the Mono project, or
Docker images provided by the Mono project. Note the operating
system manufacturer's minimum requirements for Apache HTTP
Server.

Additional
software

Windows operating systems

l Microsoft .NET Framework version 4.8 or later
l Microsoft Internet Information Services 10 or 8.5 or 8 or 7.5 or 7 with
ASP.NET 4.8 and the Role Services:

l Web Server > Common HTTP Features > Static Content
l Web Server > Common HTTP Features > Default Document
l Web Server > Application Development > ASP.NET
l Web Server > Application Development > .NET Extensibility

Table 10: System requirements - web server
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l Web Server > Application Development > ISAPI Extensions
l Web Server > Application Development > ISAPI Filters
l Web Server > Security > Basic Authentication
l Web Server > Security > Windows Authentication
l Web Server > Performance > Static Content Compression
l Web Server > Performance > Dynamic Content Compression

Linux operating systems

l NTP - Client
l Mono 5.14 or higher
l Apache HTTP Server 2.0 or 2.2 with the following modules:

l mod_mono
l rewrite
l ssl (optional)

Minimum system requirements for the
application server

The application server provides a connection pool for accessing the database and stores
business logic. The following system prerequisites must be fulfilled for installation of the
application server.

Processor 8 physical cores 2.5 GHz+

Memory 8 GB RAM

Hard drive
storage

40 GB

Operating
system

Windows operating systems

The following versions are supported:

l Windows Server 2022
l Windows Server 2019
l Windows Server 2016
l Windows Server 2012 R2
l Windows Server 2012

Table 11: System requirements - application server
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Linux operating systems

l Linux operating system (64-bit), supported by the Mono project, or
Docker images provided by the Mono project. Note the operating
system manufacturer's minimum requirements for Apache HTTP
Server.

Additional
software

Windows operating systems

l Microsoft .NET Framework version 4.8 or later
l Microsoft Internet Information Services 10 or 8.5 or 8 or 7.5 or 7 with
ASP.NET 4.8 and the Role Services:

l Web Server > Common HTTP Features > Static Content
l Web Server > Common HTTP Features > Default Document
l Web Server > Application Development > ASP.NET
l Web Server > Application Development > .NET Extensibility
l Web Server > Application Development > ISAPI Extensions
l Web Server > Application Development > ISAPI Filters
l Web Server > Security > Basic Authentication
l Web Server > Security > Windows Authentication
l Web Server > Performance > Static Content Compression
l Web Server > Performance > Dynamic Content Compression

Linux operating systems

l NTP Client
l Mono 5.14 or higher
l Apache HTTP Server 2.0 or 2.2 with the following modules:

l mod_mono
l rewrite
l ssl (optional)

NOTE: In order to use the application server's REST API, the HTTP request methods POST,
GET, PUT, and DELETE must be permitted by the web server (IIS/Apache).
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Users for One Identity Manager

User Permissions

User for
installing One
Identity
Manager

The installation user is needed for the initial installation of a One
Identity Manager database using the Configuration Wizard. For more
information, see Users with granular permission for the One Identity
Manager database on an SQL Server on page 25 and Permissions for
the One Identity Manager database in a managed instance in an Azure
SQL Database on page 32.

User for admin-
istrative tasks
in One Identity
Manager

The administrative user is used by components of One Identity
Manager that require authorizations at server level and database level,
for example, the Configuration Wizard, the DBQueue Processor, or the
One Identity Manager Service. For more information, see Users with
granular permission for the One Identity Manager database on an SQL
Server on page 25 and Permissions for the One Identity Manager
database in a managed instance in an Azure SQL Database on page 32.

User for config-
uration tasks in
One Identity
Manager

The configuration user can run configuration tasks within the One
Identity Manager, for example, creating customer-specific schema
extensions or working with the Designer. Configuration users need
permissions at the server and database levels. For more information,
see Users with granular permission for the One Identity Manager
database on an SQL Server on page 25 and Permissions for the One
Identity Manager database in a managed instance in an Azure SQL
Database on page 32.

End user for
One Identity
Manager

End users are only assigned permissions at database level in order, for
example, to complete tasks with the Manager or the Web Portal. For
more information, see Users with granular permission for the One
Identity Manager database on an SQL Server on page 25 and Permis-
sions for the One Identity Manager database in a managed instance in
an Azure SQL Database on page 32.

User for
Logging into
One Identity
Manager

One Identity Manager uses different authentication modules for logging
in to administration tools. Authentication modules identify the system
users to be used and load the user interface and database resource
editing permissions depending on their permissions groups.

For more information about One Identity Manager authentication
modules, see the One Identity Manager Authorization and Authentic-
ation Guide.

User account
for the One
Identity
Manager
Service

The user account for the One Identity Manager Service requires user
permissions to carry out operations at file level (adding and editing
directories and files).

The user account must belong to the Domain users group.

Table 12: Users for One Identity Manager
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User Permissions

The user account must have the Login as a service extended user
permissions.

The user account requires permissions for the internal web service.

NOTE: If the One Identity Manager Service runs under the network
service (NT Authority\NetworkService), you can grant permis-
sions for the internal web service with the following command line
call:

netsh http add urlacl url=http://<IP address>:<port number>/
user="NT AUTHORITY\NETWORKSERVICE"

The user account needs full access to the One Identity Manager Service
installation directory in order to automatically update One Identity
Manager.

In the default installation, One Identity Manager is installed under:

l %ProgramFiles(x86)%\One Identity (on 32-bit operating
systems)

l %ProgramFiles%\One Identity (on 64-bit operating systems)

NOTE: Other target system specific permissions may be required for
synchronizing One Identity Manager with each target system. These
permissions are explained in the corresponding guide.

For more information, see Setting up permissions for creating an HTTP
server on page 42.

Setting up permissions for creating an
HTTP server

The log files of the One Identity Manager Service can be displayed using an HTTP server
(http://<Servername>:<Portnumber>).

Users require permission to open an HTTP server. The administrator must grant URL
approval to the user to do this. This can be run with the following command line call:

netsh http add urlacl url=http://*:<port number>/ user=<domain>\<user name>

If the One Identity Manager Service has to run under the Network Service's user account
(NT Authority\NetworkService), explicit permissions for the internal web service must
be granted. This can be run with the following command line call:

netsh http add urlacl url=http://<IP address>:<port number>/ user="NT
AUTHORITY\NETWORKSERVICE"

You can check the result with the following command line call:

netsh http show urlacl
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Communications ports and firewall
configuration

One Identity Manager is made up of several components that can run in different network
segments. In addition, One Identity Manager requires access to various network services,
which can also be installed in different network segments. You must open various ports
depending on which components and services you want to install behind the firewall.

The following ports are required:

Default
port

Description

1433 Port for communicating with the One Identity Manager database.

1880 Port for the HTTP protocol of One Identity Manager Service.

2880 Port for access tests with the Synchronization Editor, such as in the target
system browser or for simulating synchronization.

Default port for the RemoteConnectPlugin.

80 Port for accessing web applications.

88 Kerberos authentication system (if Kerberos authentication is implemented).

135 Microsoft End Point Mapper (EPMAP) (also, DCE/RPC Locator Service).

137 NetBIOS Name Service.

139 NetBIOS Session Service.

Table 13: Communications port

Other ports for connecting to target systems are also required. These ports are listed in the
corresponding guides.
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Installing One Identity Manager

The following steps are required to install One Identity Manager:

1. Install One Identity Manager tools on the administrative workstation on which the
One Identity Manager database schema installation will be started.

2. Install and configure the One Identity Manager database with the Configuration
Wizard.

3. Set up the server, which handles the SQL processes.
l The server must be entered in the database as a Job server with the SQL
processing server server function.

l A One Identity Manager Service with direct access to the One Identity Manager
database must be installed and configured on the server.

NOTE: Multiple SQL processing servers can be set up to spread the load of
SQL processes.

4. Set up an update server for automatic software updating of other servers.
l The server must be entered in the database as a Job server with the server
function Update server.

l A One Identity Manager Service with direct access to the One Identity Manager
database must be installed and configured on the server.

5. Setting up and configuring the Database Agent Service

The Database Agent Service controls processing of DBQueue Processor tasks. The
Database Agent Service is deployed through the One Identity Manager Service
plugin. Alternatively, the Database Agent Service can be run from the
DatabaseAgentServiceCmd.exe command line program.

NOTE: You can proceed with setting up a SQL processing server and the update server
using the Configuration Wizard. You can also set up the Database Agent Service with the
Configuration Wizard.

You can also install the following:

l Additional workstations.
l Additional servers with the One Identity Manager Service.
l An application server.
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l An API Server with HTML web applications.
l The Web Designer Web Portal on a web server.
l The Password Reset Portal on a web server.

For more information about installing and configuring the Password Reset Portal, see
the One Identity Manager Web Application Configuration Guide.

l The Manager web application on a web server

You can install and update One Identity Manager using the following methods:

l Use the installation wizard to install the One Identity Manager components on
workstations for the first time.

l To install and update the One Identity Manager database, use the
Configuration Wizard.

l Use the installation wizards to install the One Identity Manager Service on servers for
the first time or remote with the Server Installer.

l Update an existing installation use the auto update software.
l Use the installation wizard to manually update individual workstations and servers.

NOTE: One Identity provides various Docker images for simple and standardized install-
ation and running of individual Docker components in One Identity Manager containers.

Detailed information about this topic

l One Identity Manager Docker images on page 45
l Before you start installing One Identity Manager on page 46
l Installing One Identity Manager components on page 47
l Installing and configuring a One Identity Manager database on page 50
l Installing and configuring the One Identity Manager Service on page 77
l Installing application servers on page 118
l Installing the Web Designer Web Portal on page 132
l Installing and updating the Manager web application on page 150
l Updating One Identity Manager on page 95

One Identity Manager Docker images

One Identity provides various Docker images for simple and standardized installation and
running of individual One Identity Manager components in Docker containers. One Identity
Manager Docker images, together with detailed information about the usage and
configuration of the individual images are available in the One Identity Docker repository.
For videos with additional information, see the One Identity Manager Containerization
video series at www.YouTube.com/OneIdentity. For more information about Docker, see
https://www.docker.com/.
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Docker image Description

oneidentity/oneim-
job

This image runs an instance of a One Identity Manager Service.
When started, it downloads the necessary files for a specific Job
server. This behavior can be controlled using encrypted values and
environment variables.

oneidentity/oneim-
appserver

This image runs an instance of the One Identity Manager applic-
ation server. When started, it downloads the necessary files from
the configured One Identity Manager database. This behavior can
be controlled using encrypted values and environment variables.

oneidentity/oneim-
web

This image runs an instance of the Web Designer Web Portal.
When started, it downloads the necessary files from the
configured One Identity Manager database. This behavior can be
controlled using encrypted values and environment variables.

oneidentity/oneim-
installer

This image contains a simple installation program that can be used
in derived images to create the file structure for One Identity
Manager applications.

oneidentity/oneim-
api

This image runs an instance of the API Server. When started, it
downloads the necessary files from the configured One Identity
Manager database. This behavior can be controlled using
encrypted values and environment variables.

Table 14: Available One Identity Manager Docker images

Before you start installing One
Identity Manager

Before you start installing One Identity Manager:

l Ensure that the workstations and servers meet the minimal hardware and software
requirements.

l End all program and service components otherwise installation cannot begin.

Detailed information about this topic

l Installation prerequisites on page 20
l Installing One Identity Manager on page 44
l Updating One Identity Manager on page 95
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Installing One Identity Manager
components

An installation wizard is available to help you through the installation of One Identity
Manager components on workstations and servers.

NOTE: Always start installing administration and configuration tools on an administrative
workstation if possible.

NOTE: On Linux operating systems, use of oneidentity/oneim-installer docker images is
recommended.

To install the One Identity Manager components

1. Launch autorun.exe from the root directory of the One Identity Manager
installation medium.

2. Switch to the Installation tab and select an edition.

3. Click Install.

This starts the installation wizard.

4. Select the language for the installation wizard on the start page and click Next.

5. Confirm the conditions of the license.

6. On the Installation settings page, enter the following information.
l Installation source: Select the directory containing the installation files.
l Installation directory: Select the directory in which you want to install the
files for One Identity Manager.

NOTE: To make further configuration settings, click on the arrow button next
to the input field. Here, you can specify whether you are installing on a 64-bit
or a 32-bit operating system.

For a standard installation, no further configuration settings are necessary.
l Select installation modules using the database: Set this option to load
the installation data using the existing One Identity Manager database.

NOTE: Leave this option empty to install the workstation on which you start
the One Identity Manager schema installation.

l Add further modules to the selected edition: Set this option to add
additional One Identity Manager modules to the selected edition.

7. Enter the database connection data on Connect to database.

NOTE: This page is only shown if you have set the Select installation modules
with existing database option.

l Select the connection in Select a database connection.

- OR -

One Identity Manager 9.0 Installation Guide

Installing One Identity Manager
47

https://hub.docker.com/r/oneidentity/oneim-installer/


l Click Add new connection, select the SQL Server system type, and enter
the connection data.

l Server: Database server.
l (Optional)Windows Authentication: Specifies whether the integrated
Windows authentication is used. This type of authentication is not
recommended. If you decide to use it anyway, ensure that your
environment supports Windows authentication.

l User: The user's SQL Server login name.
l Password: Password for the user's SQL Server login.
l Database: Select the database.

8. On theModule selection page, also select the modules to be installed.

NOTE: This page is only shown if you set the option Add more modules to the
selected Edition.

9. On the Assign machine roles page, define the machine roles.

NOTE: The machine roles appropriate for the One Identity Manager modules are
enabled. All machine subroles are selected when you select the machine role. You
can deselect individual packages.

10. On the Install WebView2 page you are prompted to install Microsoft Edge
WebView2. The user interface of some One Identity Manager components requires
Microsoft Edge WebView2 to display certain content.

NOTE: This page is only shown if you want to install One Identity Manager
components that are expecting WebView2 and WebView2 is not yet installed.

11. On the Change service properties page, you can change the name, display name
and the description for installing the One Identity Manager Service.

NOTE: This page is only shown if you have selected the Server | Job Server
machine role.

12. You can start different programs for further installation on the last page of the
install wizard.

l To install the One Identity Manager schema, start the Configuration Wizard and
follow the Configuration Wizard instructions.

NOTE: Perform this step only on the workstation on which you start the
installation of the One Identity Manager schema.

l To create the configuration of the One Identity Manager Service, start the Job
Service Configuration program.

NOTE: Run this step only on servers on which you have installed the One
Identity Manager Service.

13. Click Finish to close the installation wizard.

14. Close the autorun program.

One Identity Manager is installed for all user accounts on the workstation or server. In the
default installation, One Identity Manager is installed under:
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l %ProgramFiles(x86)%\One Identity (on 32-bit operating systems)
l %ProgramFiles%\One Identity (on 64-bit operating systems)

Related topics

l Before you start installing One Identity Manager on page 46
l Installation prerequisites on page 20
l One Identity Manager tools on page 13
l Installing One Identity Manager components on a Windows terminal server on
page 49

l Installing and configuring a One Identity Manager database on page 50
l Installing and configuring the One Identity Manager Service on page 77
l Machine roles and installation packages on page 185

Installing One Identity Manager
components on a Windows terminal server

To install One Identity Manager tools on a Windows terminal server, you need to ensure
that the Windows terminal server has been fully installed and configured. This includes
profile handling in particular as well as permissions for Windows terminal server use.

NOTE: Ensure that in an Active Directory Domain, the users themselves also have the
relevant permissions to use the Windows terminal server.

To install One Identity Manager components on a Windows terminal server:

1. Log in with a user account that has administrator permissions on the Windows
terminal server.

Logging in using a console connection is recommended. You can use the following
calling syntax:

Start: mstsc /Console /v:<server name>
mit: 
<server name>: terminal server name (no leading "\")

2. Open the command line console (CMD.exe) and switch the Windows terminal server
into software installation mode. You can do this with the following command line call:

CHANGE USER /INSTALL

3. Start the installation wizard and install the One Identity Manager components
as described.
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4. End the software installation mode on the Windows terminal server. You can do this
with the following command line call:

CHANGE USER /EXECUTE

After the installation is complete, anyone who is an authorized Windows terminal server
user can start the One Identity Manager tools and use them.

For more information about software installation on Windows terminal servers, refer to the
Windows operating system documentation you are using.

Related topics

l Installing One Identity Manager components on page 47

Installing and configuring a One
Identity Manager database

To set up the One Identity Manager database, use the Configuration Wizard. The
Configuration Wizard runs the following steps.

1. Installs the One Identity Manager schema in a database.

The Configuration Wizard can create a new database and install the One Identity
Manager schema. Alternatively, the One Identity Manager schema can be installed in
an existing database.

2. Creates the required SQL Server logins and database users permissions for the
administrative user, configuration user, and end user.

3. Creates administrative system users and permissions groups.

4. Encrypts the database.

5. Installs and configures a One Identity Manager Service with direct access to the
database for handling SQL processes and automatic server software updates.

6. Installs and configures the Database Agent Service.

The Database Agent Service controls processing of DBQueue Processor tasks. The
Database Agent Service is deployed through the One Identity Manager Service
plugin. Alternatively, the Database Agent Service can be run from the
DatabaseAgentServiceCmd.exe command line program.

NOTE: Additional steps are run in One Identity Manager depending on the Edition and
Configuration Wizard modules.

Additional steps are required to configure the One Identity Manager database following the
schema installation:

One Identity Manager 9.0 Installation Guide

Installing One Identity Manager
50



l Configure the database for a test, a development, or a live system.
l Other system settings may be required for putting individual functions into operation
in One Identity Manager.

Use configuration parameters to configure the behavior of the system's basic
settings. One Identity Manager provides default settings for different configuration
parameters. Check the configuration parameters and modify them as necessary to
suit your requirements.

Configuration parameters are defined in the One Identity Manager modules. Each
One Identity Manager module can also install configuration parameters. In the
Designer, you can find an overview of all configuration parameters in the Base data
> General > Configuration parameters category.

l In certain circumstances, it is necessary to store encrypted information in the One
Identity Manager database. If you did not encrypt the database when you installed
with the Configuration Wizard, use the Crypto Configuration program to encrypt.

l You can log changes to data and information from process handling in One Identity
Manager. All entries logged in One Identity Manager are initially saved in the One
Identity Manager database. The proportion of historical data to total volume of a One
Identity Manager database should not exceed 25 percent. Otherwise, performance
problems may arise. You must ensure that log entries are regularly removed from the
One Identity Manager database and archived.

For more information about process monitoring and process history, see the One
Identity Manager Configuration Guide. For more information about archiving data,
see the One Identity Manager Data Archiving Administration Guide.

Detailed information about this topic

l Tips for setting up a One Identity Manager database on page 52
l Installing and configuring a One Identity Manager database on page 53
l Configuring a One Identity Manager database for testing, development, or
production on page 60

l Encrypting database information on page 61
l One Identity Manager vendor notification on page 68
l Setting up the email notification system on page 70

Related topics

l Minimum system requirements for implementing SQL Servers as database
servers on page 21

l Requirements for a managed instance in Azure SQL Database on page 30
l Installing One Identity Manager components on page 47
l Users with granular permission for the One Identity Manager database on an SQL
Server on page 25
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l Permissions for the One Identity Manager database in a managed instance in an
Azure SQL Database on page 32

Tips for setting up a One Identity Manager
database

l The following prerequisites must be fulfilled on the workstation from which you want
to start the One Identity Manager database setup:

l Installation of the Configuration Wizard

Use the installation wizard to install the program. To do this, select the
Workstationmachine role and the Configuration installation package in the
installation wizard.

l Access to the installation sources

NOTE: If you copy the installation files to a repository, you must ensure that
the relative directory tree remains intact.

l To ensure that HTML applications are successfully compiled, you must
download packages from the NPM repository. Ensure that the workstation
you are compiling on, can establish a connection to the registry.n-
pmjs.org:443 website.

Alternatively, you can download packages from a proxy server and install
them manually.

l An installation user with permissions for installing a One Identity Manager database
must exist. If you want to use an administrative user to install a One Identity
Manager database, ensure that this user has the required permissions.

For more information, see Users with granular permission for the One Identity
Manager database on an SQL Server on page 25 and Permissions for the One Identity
Manager database in a managed instance in an Azure SQL Database on page 32.

l It is not recommended to select a user with Windows authentication for installing the
database. If you decide to use it anyway, ensure that your environment supports
Windows authentication. You must use the same user to update the database.

l If you want to install the One Identity Manager schema in an existing database,
ensure that the database has the required settings. For more information, see
Settings for the database server and the One Identity Manager database on a SQL
Server on page 22 and Database server settings and the One Identity Manager
database in a managed instance in an Azure SQL Database on page 30.

l For One Identity Manager databases on SQL Servers, it is recommended, on
performance grounds that you set the database to the Simple recovery model for the
duration of the schema installation.

l Always start Configuration Wizard on an administrative workstation.
l The program executes remote installation of One Identity Manager Service.
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l If you start the Configuration Wizard on a server on which you also want to configure
a One Identity Manager Service, simply skip the section for installing the service on
the local server in the Configuration Wizard. Install the One Identity Manager Service
with the installation wizard in this case. For more information, see Installing and
configuring the One Identity Manager Service on page 77.

l If you are working with an encrypted One Identity Manager database, see Tips for
working with an encrypted One Identity Manager database on page 66.

Installing and configuring a One Identity
Manager database

IMPORTANT: Always start the Configuration Wizard on an administrative workstation. If
you start the Configuration Wizard on a server on which you also want to configure a One
Identity Manager Service, simply skip the section for installing the service on the local
server in the Configuration Wizard.

To install a database in the Configuration Wizard

1. Start the Configuration Wizard.

2. On the Configuration Wizard's home page, select the Create and install database
option and click Next.

3. To install a new database, enter the following database connection data on the
Create administrative connection page.

l Server: Database server.
l (Optional)Windows Authentication: Specifies whether the integrated
Windows authentication is used. This type of authentication is not
recommended. If you decide to use it anyway, ensure that your environment
supports Windows authentication.

l User: SQL Server Login name of the installation user.
l Password: Password for the installation user.

- OR -

To use an existing empty database, on the Create administrative
connectionpage, select the Use an existing, empty database for installation
option and enter the database connection information.

l Server: Database server.
l (Optional)Windows Authentication: Specifies whether the integrated
Windows authentication is used. This type of authentication is not
recommended. If you decide to use it anyway, ensure that your environment
supports Windows authentication.

l User: SQL Server Login name of the installation user.
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l Password: Password for the installation user.
l Database: Name of the database.

TIP: To configure additional connection settings, enable the Advanced option.

4. If you are creating a new database, perform the following tasks on the Create
database page.

a. In the Database properties view, enter the following information about
the database.

Data Description

Database
name

Name of the database.

Data
directory

Directory in which the data file is created. You have the
following options:

l <default>: The database server’s default directory.
l <browse>: Select a directory using the file browser.
l <directory name>: Directory in which data files are
already installed.

Log directory Directory in which the transaction log file is created. You have
the following options:

l <default>: The database server’s default directory.
l <browse>: Select a directory using the file browser.
l <directory name>: Directory in which transaction log
files are already installed.

Memory
tables
directory

Directory for data file group and database file for memory-
optimized tables. You have the following options:

l <default>: The database server’s default directory.
l <browse>: Select a directory using the file browser.
l <Directory name>: Directory in which data files for
memory-optimized tables are already installed.

Initial size Initial size of the database files. You have the following
options:

l <Default>: Default entry for the database server.
l <custom>: User-defined entry.
l Different recommended sizes: Depending on the
number of employees being administrated.

Table 15: Database properties
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b. In the Installation source pane, select the directory with the
installation files.

- OR -

If you are using an existing database, on the Create database page, Installation
source view, select the directory containing the installation files.

5. On the Select configuration module page, select the configuration module .
l If you started the Configuration Wizard from the install wizard, the
configuration modules for the selected edition are already activated. In this
case, check over the module selection.

l Select the configuration module at this point if you started the Configuration
Wizard directly. Dependent configuration modules are selected automatically.

6. Error that prevent processing the database are displayed on the Database check
page. Correct the errors before you continue with the installation.

7. On the Create a new login for administrators page, decide which SQL server
login to use for administrative users. You have the following options:

l Create new SQL Server logins for the database: Select this option if you
want to work with granular permissions.

This sets up a new administrative login on the SQL Server.
l Enter the login name, password, and password confirmation for the new
SQL Server login.

Later on in the process, the Configuration Wizard sets up additional SQL Server
logins for the configuration user and the end user.

l Use an existing SQL Server login: Select this option if you have already
created an administrative SQL Server login and want to use this. Later on in the
process, the Configuration Wizard sets up additional SQL Server logins for the
configuration user and the end user.

a. Enter the login name, password, and password confirmation for the SQL
Server login.

b. Set the Permissions option so that the SQL Server login obtains
permissions for the database. If this option is not set, only the
permissions are tested.

l Use the current SQL Server login for the database: When you select this
option, no additional SQL Server logins are created for the database. In this
case, you cannot work with the granular permissions concept at SQL level. The
user you specified is used to connect to the database.

NOTE: If you want to switch to granular permissions at a later time, contact
Support. To access the Support Portal, go to https://sup-
port.oneidentity.com/identity-manager/.

8. The installation steps are shown on the Processing database page.
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Installation and configuration of the database are automatically carried out by the
Configuration Wizard. This procedure may take some time depending on the amount
of data and system performance. Once processing is complete, click Next.

TIP: Set Advanced to obtain detailed information about processing steps and the
migration log.

9. On the Create SQL server logins page, enter the login name, the password,
and password confirmation for the SQL Server logins for configuration users
and end users.

NOTE: The password must meet the Windows policy requirements for passwords.

10. On the System information page, enter the customer information and create
administrative system users for One Identity Manager.

a. In the Customer information view, enter the full name of the company.

b. In the System user view, configure the predefined administrative system
users and enter your own administrative system users.

l Enter a password and password confirmation for the predefined
system users.

l To create customer-specific system users, click the button and enter
the name, password, and password confirmation.

TIP: Use the <...> button next to the name of a system user to configure
additional settings for that system user. You can also adjust these settings in
the Designer at a later time.

c. (Optional) Create custom permissions groups.

The Configuration Wizard creates custom permissions groups, which you can
use to define permissions for any custom schema extensions you require.

l For non role-based login, the CCCViewPermissions and
CCCEditPermissions are created permission groups. Administrative
system users are automatically added to these permissions groups.

l For role-based login, the CCCViewRole and CCCEditRole permission
groups are created.

To create more permissions groups

i. Enable the Advanced option and in the Permissions groups view, click
the button.

ii. Enter the name of the permissions group. Label custom permission
groups with the prefix CCC.

iii. For role-based permissions groups, enable the Role-based option.

11. On the Enable database encryption page, select one of the following options:
l Skip database encryption: The database is not encrypted. You can encrypt
the database at later date using the Crypto Configuration program.

l Enable database encryption: The database is encrypted in the next step.
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1. In the Private key field, enter the name of the key file (default:
private.key).

2. Click New and, using the file browser, select the where you want to store
the key file.

3. Click Save.

This generates the key file (*.key). The file browser is closed. The path
and file name are displayed under Private key.

4. Confirm that you have saved the key file.

Take the Tips for working with an encrypted One Identity Manager
database on page 66 into account.

12. On the Service installation page, you can create a Job server for the server on
which the One Identity Manager database is installed.

NOTE: If you do not want to set up a Job server with the One Identity Manager
Service at this stage, select the Skip service installation option.

a. In the Installation data pane, enter the following data for installing the One
Identity Manager Service.

l Computer: Enter the name or IP address of the server that the service is
installed and started on.

l Service account: Enter the details of the user account that the One
Identity Manager Service is running under. Enter the user account, the
user account's password and password confirmation.

The service is installed using the user account with which you are logged in to
the administrative workstation. If you want to use another user account for
installing the service, you can enter it in the advanced options. You can also
change other One Identity Manager Service details in the advanced options,
such as the installation directory, name, display name, and the One Identity
Manager Service description.

b. In theMachine roles pane, select the machine role for the service. The Job
servermachine role is defined by default. You can add more machine roles.

c. (Optional) Enable the Advanced option and, in the Configuration pane,
check the configuration of the One Identity Manager Service.

NOTE: The initial service configuration is predefined already. If additional
changes need to be made to the configuration, you can do this later with the
Designer. For more information about configuring the One Identity Manager
Service, see the One Identity Manager Configuration Guide.

d. Click Next to start installing the service.

Installation of the service occurs automatically and may take some time.

NOTE: In a default installation, the service is entered in the server’s service
management with the name One Identity Manager Service.

13. The Processing database tasks page only appears if there are still tasks for the
DBQueue Processor queued in the DBQueue that are required for installing the
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database. Once processing is complete, click Next.

14. On the last page of the Configuration Wizard, click Finish.

Related topics

l Tips for setting up a One Identity Manager database on page 52
l Error messages when installing and updating the One Identity Manager
database on page 167

l Editing a One Identity Manager database during setup using the Configuration
Wizard on page 58

l Encrypting database information on page 61
l Tips for working with an encrypted One Identity Manager database on page 66

Editing a One Identity Manager database
during setup using the Configuration Wizard

Installation and configuration of the One Identity Manager database is automatically
carried out by the Configuration Wizard. The Configuration Wizard can create a new
database and install the One Identity Manager schema. Alternatively, the One Identity
Manager schema can be installed in an existing database.

The Configuration Wizard performs the following steps when processing the database:

l Creates the required SQL Server logins and database users with permissions for the
administrative user, configuration user and end user. For more information, see
Users with granular permission for the One Identity Manager database on an SQL
Server on page 25.

l Installs the One Identity Manager schema.

Before the schema installation can take place, the Configuration Wizard tests
the database. Error messages are displayed in a separate window. The errors
must be corrected manually. The schema installation cannot be started until
these are resolved.

All the tables, data types, or database procedures that are required are loaded into
the database through migration. The selected editions and configuration modules are
enabled. During migration, calculation tasks are queued in the database. These are
processed by the DBQueue Processor.

When a schema is installed with the Configuration Wizard, migration date and
migration revision are recorded in the database's transport history.

l Compiles the system.

Scripts, templates, and processes are declared in the database. The System user
authentication module with the viadmin system user is used for compilation.

l Uploads files for automatic software update.
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In order to distribute One Identity Manager files using the automatic software
updating mechanism, the files are loaded into the One Identity Manager database.

l Creates administrative system users and permissions groups.

A system user is required for authentication in One Identity Manager. One Identity
Manager provides various system users whose permissions are matched to the
various tasks. For more information about system users, permissions groups, and
granting permissions, see the One Identity Manager Authorization and
Authentication Guide.

The viadmin system user is the default system user in One Identity Manager. This
system user can be used to compile and initialize the One Identity Manager database
and for the first user login to the administration tools.

IMPORTANT: Do not use the viadmin system user in a live environment. Create
your own system user with the appropriate permissions.

Custom system users are created as administrative system users by the
Configuration Wizard. Administrative system users are automatically added to all
non role-based permissions groups, and are assigned all permissions of the system
user viadmin.

l Installs and configures a One Identity Manager Service with direct access to the
database for handling SQL processes and automatic server software updates.

The One Identity Manager Service handles defined processes. The service has to be
installed on the One Identity Manager network server to run the processes. The
server must be declared as a Job server in the One Identity Manager database.

During the initial schema installation with the Configuration Wizard, in the One
Identity Manager database a Job server is already created for the server on which the
One Identity Manager database is installed. This Job server receives the server
functions SQL processing server and Update server:

l The SQL processing server handles SQL processes.
l The update sever ensures that software is updated automatically on
other servers.

The SQL processing server and the update server require a direct connection to the
One Identity Manager database to handle processes. Use the Configuration Wizard to
install the One Identity Manager Service on a server for handling these processes.

The Configuration Wizard carries out the following steps.
l Installs the One Identity Manager Service components.
l Configuring the One Identity Manager Service
l Starts the One Identity Manager Service.

l Install and configure the Database Agent Service.

The Database Agent Service controls processing of DBQueue Processor tasks. The
Database Agent Service is deployed through the One Identity Manager Service
plugin. Alternatively, the Database Agent Service can be run from the
DatabaseAgentServiceCmd.exe command line program.
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NOTE: If the Database Agent Service is not working, a message is displayed in the
status bar in all the administration tools. To see this message, users must have at
least the configuration user access level.

Related topics

l Automatic updating of One Identity Manager on page 87
l Displaying the transport history and testing the One Identity Manager version
on page 165

Configuring a One Identity Manager
database for testing, development, or
production

You use the staging level of the One Identity Manager database to specify whether the
database is a test database, development database, or a live database. A number of
database settings are controlled by the staging level.

If you change the database's staging level, the following settings are configured.

Setting Development
environment

Test envir-
onment

Live environment

Color of the One
Identity Manager tools
status bar

None Green Yellow

Maximum DBQueue
Processor runtime

20 minutes 40 minutes 120 minutes

Maximum number of
slots for the DBQueue
Processor

5 7 Maximum number of slots
according to the hardware
configuration

Table 16: Default settings for development, test, and live environments

To modify a database staging level

1. Start the Launchpad and log in to the One Identity Manager database.

2. In the Installation overview pane, select the Database staging level and
click Run.

This starts the Designer.

3. In the Designer, select the Base Data > General > Databases category.

4. In the List Editor, select the database.

5. In the edit view, select the General tab.
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6. Change the value of the Staging level property to Test environment,
Development system, or Production system.

7. Confirm the security prompt with Yes.

8. Select the Database > Save to database and click Save.

The DBQueue Processor default configuration settings are configured for normal operation
and do not normally need to be modified.

If several databases are operating in a managed instance in the Azure SQL Database, you
can fix the number of slots. In the Designer, adjust the following configuration parameters.

l QBM | DBServerAgent | CountSlotAgents: Exact number of slots. If the
configuration parameter is set, the given number of slots are always set up. There is
no internal calculation of the number of slots based on the hardware configuration.
Changing the server's configuration has no effect. The value 15 is recommended.

NOTE: This configuration parameter is not recommended for implementing a
database on an SQL Server. For implementing a database on an SQL Server, it is
standard practice to use the hardware configuration to determine the slots.

The configuration settings are reduced for test environments and development
environments because several databases may be located on a server. If it is
necessary to change the settings for test environments or development environments
for reasons of performance, you must modify the following configuration parameter
settings in the Designer.

l QBM | DBQueue | CountSlotsMax: Maximum number of slots to be used.

Use this configuration parameter to reduce the number of slots if required. Values
lower than 5 are not permitted.

Exception: Enter a value of 0 for using the maximum number of slots available based
on the hardware configuration.

l QBM | DBQueue | KeepAlive: Maximum runtime of the central dispatcher. Tasks
on slots currently in use are still processed when the timeout expires. Then the slot
are stopped and the central dispatcher exits.

The lowest permitted value for runtime is 5 minutes; the maximum permitted value
is 720 minutes.

For more information about using the DBQueue Processor, see the One Identity Manager
Configuration Guide.

Encrypting database information

NOTE: It is recommended that you create a backup before encrypting the database
information in a database. Then you can restore the previous state if necessary.

In certain circumstances, it is necessary to store encrypted information in the One Identity
Manager database: If you did not encrypt the database when you installed with the
Configuration Wizard, use the Crypto Configuration program to encrypt. With this program
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an encryption file is created and the contents of the database columns that are affected are
converted.

To change the encryption method

l In the Designer, set the Common | EncryptionScheme configuration parameter
and select one of the options:

l RSA: RSA encryption with AES for large data (default).
l FIPSCompliantRSA: FIPS certified RSA with AES for large data. This method
is used if encryption must match the FIPS 104-2 standard. The local security
policy Use FIPS compliant algorithms for encryption, hashing, and
signingmust be enabled.

NOTE: If the Common | EncryptionScheme configuration parameter is not set, RSA
encryption is used as the method.

Detailed information about this topic

l Creating new database keys and encrypting database information on page 62
l Changing database keys and encrypting database information on page 63
l Reencrypting database information on page 64
l Decrypting database information on page 65
l Tips for working with an encrypted One Identity Manager database on page 66

Creating new database keys and encrypting
database information

NOTE: It is recommended that you create a backup before encrypting the database
information in a database. Then you can restore the previous state if necessary.

To create a new database key and encrypt the One Identity Manager database

1. Start the Launchpad and log in to the One Identity Manager database.

2. In the Installation overview pane, select the Encrypt the database and
click Run.

This starts the Crypto Configuration program.

3. Click Next on the home page.

4. On the New database connection page, enter the valid connection credentials for
the One Identity Manager database.

5. On the Select action page, select Create or change database key.

6. On the Private key page, select There was no encryption yet.

7. Create a new key on New private key.
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a. Click Create key.

b. Select the directory path for saving the file using the file browser and enter a
name for the key file.

c. Click Save.

The (*.key) key file is generated. The file browser is closed. The path and
filename are displayed under Private key.

d. Click Next.

This establishes which data is encrypted.

8. The date to be encrypted is displayed on the Convert database page.

a. Click Convert.

b. Confirm the following two security questions with Yes.

The data encryption is started. Conversion progress is displayed.

c. Click Next.

9. Click Finish on the last page to end the program.

Related topics

l Changing database keys and encrypting database information on page 63
l Reencrypting database information on page 64
l Decrypting database information on page 65
l Tips for working with an encrypted One Identity Manager database on page 66

Changing database keys and encrypting database
information

NOTE:

l To change a database key, you need the key file with the old database key. The key
is change and saved in a new key file.

l It is recommended that you create a backup before encrypting the database
information in a database. Then you can restore the previous state if necessary.

To change a database key and encrypt the One Identity Manager database

1. Start the Launchpad and log in to the One Identity Manager database.

2. In the Installation overview pane, select the Encrypt the database and
click Run.

This starts the Crypto Configuration program.

3. Click Next on the home page.
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4. On the New database connection page, enter the valid connection credentials for
the One Identity Manager database.

5. On the Select action page, select Create or change database key.

6. Load the existing key on Private key.

a. Select Encryption was enabled.

b. Click Load key.

c. Using the file browser, select the (*.key) file with the old database key.

d. Click Open.

The file browser is closed. The path and file name are shown.

e. Click Next.

7. Create a new key on New private key.

a. Click Create key.

b. Select the directory path for saving the file using the file browser and enter a
name for the key file.

c. Click Save.

The (*.key) key file is generated. The file browser is closed. The path and
filename are displayed under Private key.

d. Click Next.

This establishes which data is encrypted.

8. The date to be encrypted is displayed on the Convert database page.

a. Click Convert.

b. Confirm the following two security questions with Yes.

The data encryption is started. Conversion progress is displayed.

c. Click Next.

9. Click Finish on the last page to end the program.

Related topics

l Creating new database keys and encrypting database information on page 62
l Reencrypting database information on page 64
l Decrypting database information on page 65
l Tips for working with an encrypted One Identity Manager database on page 66

Reencrypting database information

Use this method if the database already has encryption but you want to encrypt
more columns.
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NOTE: It is recommended that you create a backup before encrypting the database
information in a database. Then you can restore the previous state if necessary.

To repeat One Identity Manager database encryption using an existing
database key

1. Start the Launchpad and log in to the One Identity Manager database.

2. In the Installation overview pane, select the Encrypt the database and
click Run.

This starts the Crypto Configuration program.

3. Click Next on the home page.

4. On the New database connection page, enter the valid connection credentials for
the One Identity Manager database.

5. On the Select action page, select Encrypt using existing key.

This establishes which data is encrypted.

6. The date to be encrypted is displayed on the Convert database page.

a. Click Convert.

b. Confirm the following two security questions with Yes.

The data encryption is started. Conversion progress is displayed.

c. Click Next.

7. Click Finish on the last page to end the program.

Related topics

l Creating new database keys and encrypting database information on page 62
l Changing database keys and encrypting database information on page 63
l Decrypting database information on page 65
l Tips for working with an encrypted One Identity Manager database on page 66

Decrypting database information

NOTE:

l You need the file with the database key for this.
l It is recommended that you create a backup before encrypting the database
information in a database. Then you can restore the previous state if necessary.
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To decrypt the One Identity Manager database

1. Start the Launchpad and log in to the One Identity Manager database.

2. In the Installation overview pane, select the Encrypt the database and
click Run.

This starts the Crypto Configuration program.

3. Click Next on the home page.

4. On the New database connection page, enter the valid connection credentials for
the One Identity Manager database.

5. On the Select action page, select Decrypt data.

This establishes which data is encrypted.

6. The date to be encrypted is displayed on the Convert database page.

a. Click Convert.

b. Confirm the following two security questions with Yes.

c. Using the file browser, select the (*.key) file with the database key.

d. Click Open.

The file browser is closed. The data decryption is started. Conversion progress
is displayed.

e. Click Next.

7. Click Finish on the last page to end the program.

Related topics

l Creating new database keys and encrypting database information on page 62
l Changing database keys and encrypting database information on page 63
l Reencrypting database information on page 64
l Tips for working with an encrypted One Identity Manager database on page 66

Tips for working with an encrypted One Identity
Manager database

If you encrypt a One Identity Manager database, you must declare the database key to the
One Identity Manager Service.

CAUTION: If the One Identity Manager Service finds a private key in the
installation directory on startup, it places the key in the Windows internal
key container of its service account and deletes the file from the hard
drive. So save the private key at another location in addition to the service
install directory.

IMPORTANT:
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l The file with the private key must exist in the server's installation directory on all
servers with an active One Identity Manager Service.

l If you change the One Identity Manager Service user account, you must save the
key file in the service’s install directory again.

To declare the database key

1. Declare the following information in the One Identity Manager Service configuration
file. Use the Job Server Editor in the Designer or the Job Service Configuration
program to edit the configuration file. For more information, see the One Identity
Manager Configuration Guide.

Configuration
module

Parameters Meaning

JobServiceDestination Encryption method
(EncryptionScheme)

Encryption method used

JobServiceDestination File with private
key (PrivateKey)

Enter the file with the encryption
information. The default file is
private.key.

JobServiceDestination Private key identi-
fier (PrivateKeyId)

Identifier of the private key.

Use this parameter if you work with
several private keys, for example, if
One Identity Manager Service data
must be exchanged between two
encrypted One Identity Manager
databases.

If no ID is specified, a search is
performed for the private.key file.

File with the private
key.

Private key identifier and path to
private key file.

The ID is expected in the JobSer-
viceDestination in the Private key
identifier parameter
(PrivateKeyId) The default key has
the ID Default.

Table 17: Configuring the One Identity Manager Service for encryption

2. Save the key file created in the service’s install directory.

3. Open the service management and restart the One Identity Manager Service.

Detailed information about this topic

l Encrypting database information on page 61
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One Identity Manager vendor
notification

Give us the opportunity to keep you up-to-date. The interfaces to other systems are being
developed continually. Enable vendor notifications to receive news about important
program updates for your system.

If vendor notification is enabled, One Identity Manager generates a list of system settings
once a month and sends it to One Identity. This list does not contain any personal data. The
list will be reviewed by our customer support team, who will look for material changes in a
proactive effort to identify potential issues before they materialize on your system. The lists
may be used by our R&D staff for analysis, diagnosis, and replication for testing purposes.
We will keep and refer to this information for as long as your company remains on support
for this product.

NOTE: You can check the latest system information at any time in the Help >
Info menu.

Detailed information about this topic

l Enabling vendor notification on page 68
l Checking vendor notification on page 69
l Disabling vendor notification on page 69

Enabling vendor notification

NOTE: You can only configure vendor notification in Launchpad on a One Identity
Manager database with the Live environment staging level.

Prerequisite for vendor notification

l A Job server is configured as SMTP host for sending mail in One Identity Manager.
l The configuration parameters for email notification are configured.

To enable a vendor notification

1. Start the Launchpad and log in to the One Identity Manager database.

2. In the Installation overview pane, select the Configure vendor notification
entry and click Run.

This starts the Designer and opens the Configuration Parameter Editor.

3. Enable the Common | MailNotification | VendorNotification configuration
parameter and enter the email address of your business contact.
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The email address is used as the return address for notifying vendors.

4. Select the Database > Save to database and click Save.

Detailed information about this topic

l Checking vendor notification on page 69
l Disabling vendor notification on page 69
l Setting up the email notification system on page 70

Checking vendor notification

NOTE: You can configure vendor notification in the Launchpad only for a One Identity
Manager database with the Live environment staging level.

To check whether vendor notification is enabled

l Start the Launchpad and log in to the One Identity Manager database.

In the Installation view, you can see whether the function is enabled in the
Configure vendor notification entry.

Detailed information about this topic

l Enabling vendor notification on page 68
l Disabling vendor notification on page 69

Disabling vendor notification

NOTE: You can configure vendor notification in the Launchpad only for a One Identity
Manager database with the Live environment staging level.

To disable a vendor notification

1. Start the Launchpad and log in to the One Identity Manager database.

2. In the Installation overview pane, select the Configure vendor notification
entry and click Run.

This starts the Designer and opens the Configuration Parameter Editor.

3. Disable the Common | MailNotification | VendorNotification configuration
parameter.

4. Select the Database > Save to database and click Save.
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Related topics

l Enabling vendor notification on page 68
l Checking vendor notification on page 69

Setting up the email notification system

One Identity Manager sends email notifications about various actions taken within the
system. Thus, various notifications are sent to requester and approver within the request
process. In the same way, notifications about attestation cases are sent or reports
delivered by email. Notifications are sent when an actions is successfully or unsuccessfully
run during process handling.

You can implement custom notifications in addition to predefined notification processes.

To use the notification system

1. In the Launchpad, in the Configuration section, select Configure email
connection.

2. Click Run.

3. On the home page of the Mail Configuration Wizard, click Next.

4. On the Create connection to the SMTP server page, configure the SMTP server
connection to use for sending emails.

l To test the user account data, click Test connection.

l SMTP Server: SMTP server for sending email notifications. If a server is not
given, localhost is used.

l User name: User account name for authentication on an SMTP server.
l Domain: User account domain for authentication on the SMTP server.
l Password and Password repeat: User account password for authentication
on the SMTP server.

l Port: Port of the SMTP service on the SMTP server. Default: 25
l Transport encryption: Encryption method for sending email notifications. If
none of the following options are given, the port is used to define the behavior
(port 25: no encryption, port 465: with SSL/TLS encryption).

Permitted values are:
l Auto: Identifies the encryption method automatically.
l SSL: Encrypts the entire session with SSL/TLS.
l STARTTLS: Uses the STARTTLS mail server extension. Switches TLS
encryption after the greeting and loading the server capabilities. The
connection fails if the server does not support the STARTTLS extension.
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l STARTTLSWhenAvailable: Uses the STARTTLS mail server extension if
available. Switches on TLS encryption after the greeting and loading the
server capabilities, however, only if it supports the STARTTLS extension.

l None: No security for the transport layer. All data is sent as plain text.
l Accept self-signed certificates: Specifies whether self-signed certificates
for TLS connections are accepted.

l Allow server name mismatch in certificates: Specifies whether server
names that do not match are permitted by certificates for TLS connections.

5. On the Define SMTP Job servers page, select at least one Job server to take on the
SMTP server functionality.

6. On the Email settings page, you can define the default email address of a sender
and a recipient as well as the layout of the email.

l Recipient address: Default email address of the recipient of the notifications.
l Sender address: Sender's default email address for sending automatically
generated notifications.

Syntax:

sender@example.com

Example:

NoReply@company.com

You can enter the sender's display name in addition to the email address. In
this case, ensure that the email address is enclosed in chevrons (<>).

Example:

One Identity <NoReply@company.com>

l Language: Default language used to send email notifications if a language
cannot be determined for a recipient.

l Language: Default language for sending email notifications.
l Font: Default font for email notifications.
l Font size: Default font size for email notifications.
l Signature: Signature under the salutation.
l Company: Company name.
l Link: Link to the company's website.
l Link display: Display text for the link to the company's website.

7. On the Data security page, you can configure the data security settings.

l Certificate thumbprint: SHA1 thumbprint of the certificate to use for the
signature. This can be in the computer's or the user's certificate store.

NOTE: Ensure that the private key in the certificate is marked as exportable.
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If you want to use a digital signature, enable Certificate thumbprint and
specify the thumbprint.

l Encryption: Specifies whether emails are encrypted. If you enable this
function, additional settings are shown.

l Domain controller: Domain controller of the requested domain to use.
l Domain: Distinguished name of the domain to request.
l User account:User account for querying Active Directory.
l Password and Password repeat: Password of the user account.

8. On the Email notifications about requests page, make any changes to the
general settings for email notifications about requests. In addition, define whether
the Approval by mail feature can be used for requests. If you enable this feature,
the settings you need are shown.

l Sender address: Sender's default email address for sending automatically
generated notifications.

Syntax:

sender@example.com

Example:

NoReply@company.com

You can enter the sender's display name in addition to the email address. In
this case, ensure that the email address is enclosed in chevrons (<>).

Example:

One Identity <NoReply@company.com>

l Daily notifications about pending approvals: Specifies whether
approvers only receive emails once a day if there are requests awaiting their
approval decisions.

If this option is not set, approvers immediately receive an email once a
request is available for approval. Set this option to reduce the number of
email notifications. This will mean that you cannot use the Approval by
mail feature.

TIP: To use a template other than the default one for this, change the value
in the QER | ITShop | MailTemplateIdents | RequestAp-
proverByCollection configuration parameter in the Designer.

l IT Shop approval by mail: Specifies whether the Approval by mail feature
can also be used for approving requests. If you enable the feature, adjust the
required settings. Then you cannot use the Daily notifications about
pending approvals feature.

l User name: Name of the user account for authenticating the mailbox used for
approval by mail.

l Domain: Domain of the user account for authenticating the mailbox used for
approval by mail.
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l Password and Password repeat: Password of the user account for
authenticating the mailbox used for approval by mail.

l Web service URL:
l Mailbox: Microsoft Exchange mailbox to which approvals by mail are sent.
l Delete behavior: Specifies the way emails are deleted from the inbox.
l Application ID: Exchange Online application ID for authentication with
OAuth 2.0. If the value is not set, the Basic or the NTML authentication
method is used.

9. On the Email notifications about attestation page, make any changes to the
general settings for email notifications about attestations. In addition, define whether
the Approval by mail feature can be used for attestations. If you enable this
feature, the settings you need are shown.

l Sender address: Sender's default email address for sending automatically
generated notifications.

Syntax:

sender@example.com

Example:

NoReply@company.com

You can enter the sender's display name in addition to the email address. In
this case, ensure that the email address is enclosed in chevrons (<>).

Example:

One Identity <NoReply@company.com>

l Daily notifications about pending approvals: Specifies whether attestors
only receive emails once a day if there are attestation cases awaiting their
approval decisions.

If this option is not set, attestors immediately receive an email once an
attestation case is available for approval. Set this option to reduce the number
of email notifications. Then you cannot use the Approval by mail feature.

TIP: To use a template other than the default one for this, change the value
in the QER | Attestation | MailTemplateIdents | RequestAp-
proverByCollection configuration parameter in the Designer.

l Attestation by mail: Specifies whether the Approval by mail feature can be
used. If you enable the feature, adjust the required settings. Then you cannot
use the Daily notifications about pending approvals feature.

l User name: Name of the user account for authenticating the mailbox used for
approval by mail.

l Domain: Domain of the user account for authenticating the mailbox used for
approval by mail.

l Password and Password repeat: Password of the user account for
authenticating the mailbox used for approval by mail.
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l Web service URL:
l Mailbox: Microsoft Exchange mailbox to which approvals by mail are sent.
l Delete behavior: Specifies the way emails are deleted from the inbox.
l Application ID: Exchange Online application ID for authentication with
OAuth 2.0. If the value is not set, the Basic or the NTML authentication
method is used.

10. On the Report subscriptions page, you can change the default settings for report
subscriptions.

l Sender address: Sender's default email address for sending automatically
generated notifications about report subscriptions. Replace the default address
with a valid email address.

Syntax:

sender@example.com

Example:

NoReply@company.com

You can enter the sender's display name in addition to the email address. In
this case, ensure that the email address is enclosed in chevrons (<>).

Example:

One Identity <NoReply@company.com>

l Default report template: Default report that is used as a template for
creating simple list reports.

l Store subscription: Specifies whether subscribed reports are saved in a
repository. If you enable the feature, adjust the required settings.

l Report storage share: Path to the repository for subscribed reports. Syntax:
\\<Server>\<Share>

l Storage life time (days) Maximum retention period (in days) that a report is
available in the storage share. After this period, reports are deleted.

11. On the Email notifications about actions in the target system page, you can
enter an email address for notifying about actions in the target system. This might be
error or success messages about changes in the target system.

l <Target system type>: Specifies whether email notifications are sent with
error or success messages about changes in target systems of this type. If you
enable the feature, enter the email address to send notifications to.

12. On the last page of the Mail Configuration Wizard, click Finish.

In addition, other configuration parameters could be required for different notification
processes. Enable these in the Designer. Some configuration parameters are only available
if the module is installed.
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Configuration parameter Meaning

Common | InternationalEMail Specifies whether international domain names and
unicode characters are supported in email addresses.

IMPORTANT: The mail server must also support this
function. If necessary, you must override the script VID_
IsSMTPAddress

Common | MailNotification |
Encrypt | Encryp-
tionCertificateScript

This configuration parameter contains the script that
supplies a list of encrypted certificates (default: QBM_
GetCertificates).

Common | MailNotification |
NotifyAboutWaitingJobs

Specifies whether a message should be sent if the process
steps have a particular status in the Job queue.

Common | MailNotification |
SMTPUseDefaultCredentials

Specifies which credentials are used for authentication on
the SMTP server.

If this parameter is set, the One Identity Manager Service
login credentials are used for authentication on the SMTP
server.

If the configuration parameter is not set, the login data
defined in the Common | MailNotification | SMTPDo-
main and Common | MailNotification | SMTPAc-
count or Common | MailNotification |
SMTPPassword configuration parameters is used.
(Default)

Common | MailNotification |
VendorNotification

Email address of your company's contact person. The
email address is used as the return address for notifying
vendors.

If the configuration parameter is set, One Identity
Manager generates a list of system settings once a month
and sends the list to One Identity. This list does not
contain any personal data. You can check the latest
system information at any time by selecting Help > Info
in the menu.

The list will be reviewed by our customer support team,
who will look for material changes in a proactive effort to
identify potential issues before they materialize on your
system. The lists may be used by our R&D staff for
analysis, diagnosis, and replication for testing purposes.
We will keep and refer to this information for as long as
your company remains on support for this product.

TargetSystem | ADS |
MemberShipRestriction |
MailNotification

Default email address for sending warning emails.

Table 18: Additional configuration parameters for mail notification
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Related topics

l Setting up Job servers on page 78
l Message: Enter email address in configuration parameter on page 170
l Configuration parameters for the email notification system on page 187
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5

Installing and configuring the One
Identity Manager Service

The One Identity Manager Service handles defined processes. The service has to be
installed on the One Identity Manager network server to run the processes. The server
must be declared as a Job server in the One Identity Manager database.

Setting up a Job server requires the following steps:

l Create an entry for the Job server in the One Identity Manager database.
l Specify the machine roles and server functions for the Job server.

Installation packages to be installed on the Job server are found, depending on the
selected machine roles. The server function defines the functionality of a server in
One Identity Manager. One Identity Manager processes are handled with respect to
the server function.

l Install the One Identity Manager Service.
l Configure the One Identity Manager Service.
l Start the One Identity Manager Service.

For more information about using the One Identity Manager Service, see the One Identity
Manager Configuration Guide.

NOTE: On Linux operating systems, use of oneidentity/oneim-job docker images is
recommended.

Related topics

l One Identity Manager Docker images on page 45
l Setting up Job servers on page 78
l Remote installation of the One Identity Manager Service with the Server
Installer on page 79

l Displaying the One Identity Manager Service log file on page 81
l Changing the user account or start type of the One Identity Manager Service
on page 83

l The One Identity Manager Service in a cluster on page 83
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l Updating One Identity Manager on page 95
l Machine roles and installation packages on page 185

Setting up Job servers

Each Job server within the network must have a unique queue identifier. The process steps
are requested by the Job queue using exactly this queue name:

l A Job server must be known in the One Identity Manager database for each queue.
l Enter this queue name in the One Identity Manager Service configuration file.

There are several methods for setting up a Job server:

l For the initial schema installation with the Configuration Wizard, you already set up a
Job server with the SQL processing server and Update server server functions.
Use the Configuration Wizard to configure the service and install the service remotely
on a server.

l To configure further Job servers, use the Server Installer program.

Using the Server Installer, you create the Job server with its machine roles and
server functions in the database. Use the Server Installer to configure the service and
install the service remotely on a server.

l You can create Job servers in the Designer.

Use the Designer, to create a Job server with the machine roles and server functions,
configure the service on the server and install the service remotely. For more
information, see One Identity Manager Configuration Guide.

l If a remote installation is not possible, you can install and configure the service
locally on a server.

l Install the service components on the server using the installation wizard.
l Configure the service using the Job Service Configuration program. For more
information about configuring the One Identity Manager Service, see the One
Identity Manager Configuration Guide.

l If the Common | Jobservice | AutoCreateServerFromQueues
configuration parameter is enabled, in response to queries from the One
Identity Manager Service for unknown queues, new Job servers are created in
the database. Information about machine roles and server functions is
transferred to the database.

NOTE: If you subsequently change server functions for a Job server in the database, for
example using the Designer, the system checks whether the required components are
installed on the server, and updates the server if necessary. To enable this, automatic
software updates must be active.
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Related topics

l Installing and configuring a One Identity Manager database on page 53
l Remote installation of the One Identity Manager Service with the Server
Installer on page 79

l Installing One Identity Manager components on page 47
l Implementing the automatic software update on page 92

Remote installation of the One
Identity Manager Service with the
Server Installer

IMPORTANT: If you are working with an encrypted One Identity Manager database, see
Tips for working with an encrypted One Identity Manager database on page 66.

Use the One Identity Manager Service to install the Server Installer. The program runs the
following steps:

l Sets up a Job server.
l Specifies machine roles and server function for the Job server.
l Remotely installs One Identity Manager Service components corresponding to the
machine roles.

l Configures the One Identity Manager Service.
l Starts the One Identity Manager Service.

NOTE: The program performs a remote installation of the One Identity Manager Service.
Local installation of the service is not possible with this program.

To remotely install the One Identity Manager Service, you must have an administrative
workstation on which the One Identity Manager components are installed.

NOTE: To generate processes for the Job server, you need the provider, connection
parameters, and the authentication data. By default, this information is determined from
the database connection data. If the Job server runs through an application server, you
must configure extra connection data in the Designer. For more information about setting
up Job servers, see the One Identity Manager Configuration Guide.

To remotely install and configure One Identity Manager Service on a server

1. Start the Server Installer program on your administrative workstation.

2. On the Database connection page, enter the valid connection credentials for the
One Identity Manager database.

3. On the Server properties page, specify the server on which you want to install the
One Identity Manager Service.
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a. Select a Job server from the Servermenu.

- OR -

To create a new Job server, click Add.

b. Enter the following data for the Job server.
l Server: Name of the Job server.
l Queue: Name of the queue to handle the process steps. Each Job server
within the network must have a unique queue identifier. The process
steps are requested by the Job queue using this exact queue name. The
queue identifier is entered in the One Identity Manager Service
configuration file.

l Full server name: Full server name in accordance with DNS syntax.

Syntax:

<Name of servers>.<Fully qualified domain name>

NOTE: You can use the Extended option to make changes to other
properties for the Job server. You can also edit the properties later with
the Designer.

4. On theMachine roles page specify which roles the Job server is to have in One
Identity Manager. Installation packages to be installed on the Job server are found
depending on the selected machine role.

5. On the Server functions page, specify the function of the server in the One Identity
Manager environment. One Identity Manager processes are handled with respect to
the server function.

The server's functions depend on which machine roles you have selected. You can
limit the server's functionality further here.

6. On the Service Settings page, enter the connection data and check the One
Identity Manager Service configuration.

NOTE: The initial service configuration is predefined. If further changes need to be
made to the configuration, you can do this later with the Designer. For more
information about configuring the service, see the One Identity Manager Config-
uration Guide.

l For a direct connection to the database:

1. Select Process collection > sqlprovider.

2. Click the Connection parameter entry, then click the Edit button.

3. Enter the connection data for the One Identity Manager database.
l For a connection to the application server:

1. Select Process collection, click the Insert button and select
AppServerJobProvider.

2. Click the Connection parameter entry, then click the Edit button.

3. Enter the connection data for the application server.
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4. Click the Authentication data entry and click the Edit button.

5. Select the authentication module. Depending on the authentication
module, other data may be required, such as user and password. For
more information about One Identity Manager authentication modules,
see the One Identity Manager Authorization and Authentication Guide.

7. To configure remote installations, click Next.

8. On the Select installation source page, select the directory with the install files.
Change the directory if necessary.

9. On the Service access page, enter the service's installation data.
l Computer: Enter the name or IP address of the server that the service is
installed and started on.

l Service account: Enter the details of the user account that the One Identity
Manager Service is running under. Enter the user account, the user account's
password and password confirmation.

The service is installed using the user account with which you are logged in to the
administrative workstation. If you want to use another user account for installing
the service, you can enter it in the advanced options. You can also change the
One Identity Manager Service details, such as the installation directory, name,
display name, and the One Identity Manager Service description, using the
advanced options.

10. Click Next to start installing the service.

Installation of the service occurs automatically and may take some time.

11. Click Finish on the last page of the Server Installer.

NOTE: In a default installation, the service is entered in the server’s service
management with the name One Identity Manager Service.

Related topics

l Minimum system requirements for Job servers on page 37
l Users for One Identity Manager on page 41
l Changing the user account or start type of the One Identity Manager Service
on page 83

l Machine roles and installation packages on page 185

Displaying the One Identity Manager
Service log file

The One Identity Manager Service log file can be displayed in a browser.

You call up the log file with the appropriate URL:

http://<server name>:<port number>
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The default value is port 1880.

Different credentials are expected depending on how the authentication method is
configured for displaying the log file.

To open the One Identity Manager Service log file in the Job Queue Info

1. Start the Job Queue Info program.

2. In the Server state view, select the Job server and select the Open in browser
context menu item.

The One Identity Manager Service HTTP server for the Job server is queried and the
various One Identity Manager Service services are displayed.

3. To display the contents of the log file, select Log File in the navigation view.

Figure 3: The One Identity Manager Service log file

The messages to be displayed on the web page can be filtered interactively. There is a
menu on the website for this. Only text contained in the log file can be displayed in this
case. For example, if the message type isWarning, messages with the Infomessage type
cannot also be displayed if the relevant filter is selected.

The log output is color-coded to make it easier to identify.

Color Meaning

Green Processing successful

Yellow Warnings occurred during processing

Red Fatal errors occurred during processing

Table 19: Log file color code

NOTE: If you want to retain the color information to send by email, you need to save the
complete web page.

For more information about configuring how the One Identity Manager Service log file is
displayed, see the One Identity Manager User Guide for One Identity Manager Tools
User Interface.
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Changing the user account or start type
of the One Identity Manager Service

NOTE:

l In a default installation, the service is entered in the server’s service management
with the name One Identity Manager Service.

l If you change the One Identity Manager Service's user account, you must save the
service's configuration file in the service’s install directory again.

l If you are working with an encrypted One Identity Manager database, see Tips for
working with an encrypted One Identity Manager database on page 66.

To customize login data and the way the service is started

1. Open the service management of the server and select the One Identity Manager
Service in the list of services.

2. Open service properties with the Properties context menu item.

3. On the General tab, change the start type if necessary.

The Automatic start type is recommended.

4. Change the user account under which the service runs on the Login tab.

5. Click Apply.

6. Close the service's properties with OK.

7. Start the service from the context menu item Start.

If the One Identity Manager Service cannot be started, a corresponding message is
written to the server event log.

Related topics

l Minimum system requirements for Job servers on page 37
l Users for One Identity Manager on page 41

The One Identity Manager Service in a
cluster

The idea of a cluster solution is to make the system highly available. The goal is to limit
system failure to only a few seconds if a hardware or software component fails. This can be
achieved with the installation of a Windows cluster solution (only possible with Enterprise
servers). The following diagram shows such a solution.
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Figure 4: Example of a cluster solution

This cluster is made up of two physical computers Server A and Server B that use the same
disk array and have their own individual system hard drive. Every server has a Windows
operating system. Both servers are installed identically so that in the case of failure one
server can take over from the other.

All redundant system components are managed by the cluster manager. From an external
point of view, the cluster is addressed as a single, virtual server Server C. The service or
user that is accessing the service is automatically connected to the physical server that is
currently carrying out the work in the cluster.

If one of the servers fails, then the redundant server in the cluster automatically takes
over. The virtual server remains the contact partner; only the physical server that is
running, changes.

Detailed information about this topic

l Registering the One Identity Manager Service in a cluster on page 84
l Installing and configuring the One Identity Manager Service in a cluster on page 85

Registering the One Identity Manager
Service in a cluster

Once registered, the One Identity Manager Service is governed by cluster handling for site
resilience and load balancing. The service is installed on a virtual server that simulates the

One Identity Manager 9.0 Installation Guide

Installing and configuring the One Identity Manager Service
84



cluster. All computer-related operations and service data operate, transparently, with the
virtual server and not the real computer (cluster nodes). This also applies to clients that
contact the service through the server name, for example RPC (ORPC, DCOM), TCP/IP
(Winsock, Named Pipes), or HTTP.

Because the service is in the context of the virtual server, note the following facts:

l The service-specific settings for the node on which the virtual server is located are
replicated to all other nodes. Therefore, the service always has the same
configuration irrelevant of the node on which it is actually started.

l The service is always started only on the current node of the virtual server (the
virtual server's current node). The service is stopped on all other nodes.

l The service is booted and shutdown with the virtual server. If the cluster is not
enabled, the service is stopped on all nodes.

l Services on nodes are brought automatically into the required state (Manual or
Stopped) before they are registered by the program.

Related topics

l The One Identity Manager Service in a cluster on page 83
l Installing and configuring the One Identity Manager Service in a cluster on page 85

Installing and configuring the One Identity
Manager Service in a cluster

The installation of server components from the One Identity Manager installation medium
needs to be done on all the physical nodes of the cluster.

NOTE: In the configuration of the JobServiceDestination, the Queue parameter must
contain the name of the virtual server.

After saving the configuration, the configuration file in the One Identity Manager Service
installation directory needs to be copied to all the physical nodes. You must not change the
name of the configuration file.

NOTE: One Identity Manager Service configuration is not part of a cluster resource. Thus,
each node keeps its own configuration. For this reason, you must ensure that the
configuration files on the physical nodes are consistent. If this is not the case, correct
functionality cannot be guaranteed after changing cluster nodes.

Setting up a cluster resource for the One Identity Manager Service

In the Cluster Administrator program, set up a new cluster resource for the One Identity
Manager Service and make this available online. For information about this procedure,
refer to Microsoft Technet under http://technet.microsoft.com/en-us/library/cc787285
(WS.10).aspx. Note the following when creating the cluster resource:
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l Select the Generic Service resource type.
l Select the following One Identity Manager Service dependencies.

l Cluster IP address
l Cluster name
l Quorum; for example, disc: D

l Do not enter additional registration keys.

NOTE: After setting up the One Identity Manager Service in a cluster system it is
advisable to simulate a failover so that possible problems with the cluster do not arise
during live operations.

Storing the One Identity Manager Service log file on a shared volume

l In the Cluster Administrator program, set up a new cluster resource for the and make
this available online. Note the following when creating the cluster resource:

l Select the File Share resource type.
l Select at least the following dependency:

One Identity One Identity Manager Service
l In the configuration file of the One Identity Manager Service, adapt the directory
information in the Log file (OutPutFile) parameter of the log writer.

l Copy the configuration file to all the physical cluster nodes in the One Identity
Manager Service install directory after you have changed it.

Related topics

l The One Identity Manager Service in a cluster on page 83
l Registering the One Identity Manager Service in a cluster on page 84
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6

Automatic updating of One Identity
Manager

Local installation and updating of software in particular can prove to be problematic due to
the distributed structure of servers and workstations. To help guarantee an acceptable
workload for network administrators, a One Identity Manager automatic update method
has been developed for One Identity Manager. Apart from updating the usual One Identity
Manager installation files, new custom files can be simply added to the procedure and are,
therefore, distributed to workstations and servers in the One Identity Manager network
using the automatic software updating mechanism.

Detailed information about this topic

l Basics for automatic software update on page 87
l Implementing the automatic software update on page 92
l Disabling automatic software update on page 93

Basics for automatic software update

All files in a One Identity Manager installation are saved with their name and binary code in
QBMFileRevision in the One Identity Manager database. The file size and hash values of
each file are stored to identify them. Additionally, each file's affiliation to machine roles and
installation packages is entered in the QBMFileHasDeployTarget table.

The necessary files are loaded into the One Identity Manager database and updated when a
hotfix, a service pack or a full version update is run.

In the database, a semaphore software revision is maintained. When a file is added,
changed, or deleted in the database, the semaphore value is recalculated by the DBQueue
Processor. In every One Identity Manager installation directory there is a
Softwarerevision.viv file. This file is assigned the Read only and Not visible permissions
in the file system, and therefore is not normally displayed by the operating system.

The Softwarerevision.viv contains the following information:
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l The installation revision number

The revision status is determined from the value of the Softwarerevision
semaphore in the database.

l The start time of the last modification

As of One Identity Manager version 8.0, the Update.zip file is stored in the QBMFileRevision
table. The file plays a central role in automatic updating. The zip archive contains all the
files that are required on the clients or server for updating the product. The zip archive is
not part of the One Identity Manager installation data but is recreated after the database
has been updated by the Configuration Wizard and also the Software Loader.

The zip archive contains the following files:

l Update.exe

l VI.Base.dll

l NLog.dll

l Newtonsoft.Json.dll

l InstallManager.Msi.dll

l InstallManager.Core.dll

The zip archive is extended with all files from the installation data that correspond to the
*.Update.dll name filter. This makes it possible for different modules to contribute more
functionality to the automatic update.

In addition, the installation directory of all One Identity Manager installations contains the
InstallState.config file. This file contains information about the installed machine roles,
installation packages and files.

Whether or not a software update is required, depends on the comparison of semaphore
values from the database and the .softwarerevision.viv file. If semaphore values vary,
machine roles for the computer or server are determined based on the
InstallState.config. Each file belonging to a machine role is check to see if the file is
known to the database.

If the file exists in the data, make the following checks:

l Has the file size changed?

In this case, the file is added to the list of files to be updated.
l Has the hash value changed?

In this case, the file is added to the list of files to be updated.

New files that have been loaded into the One Identity Manager database through a
hotfix, a service pack, or a version update are also added to the list. All the files in the
list are updated.

All actions are logged in the file update.log. After the update has finished, the current
semaphore value is copied from the database to the file softwarerevision.viv.
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Related topics

l Automatic updating of the One Identity Manager tools on page 89
l Automatic updating of the One Identity Manager Service on page 90
l Automatic updating of web applications on page 91
l Implementing the automatic software update on page 92
l Disabling automatic software update on page 93

Automatic updating of the One Identity
Manager tools

When a program starts up, VI.DB.dll establishes a connection to the database and carries
out the semaphore test. If the softwarerevision.viv file is not found, a new file is added.

If the One Identity Manager installation directory does not have write access, an error
message is displayed and the software update continues.

The update program (Updater.exe) requires an administrator to log in if user account
control is active, assuming that the current user does not have administration
permissions for the installation directory (for example %ProgramFiles%). If installation
takes place in a directory without user account control, the query does not apply. Then
the update process begins.

The application then loads the Update.zip file from the database or from the application
server, which is unpacked in a temporary directory.

In the first step, the Update.exe informs the main application whether it can run an update
or not. Depending on the configuration, the user may still be able to cancel the automatic
update at this point.

To prevent further applications from starting during the update, a file called Update.lock is
created in the installation directory. The trigger program and the update program
(Update.exe) write their process ID in the file. The Update.lock file is deleted from the
installation directory once updating has been successfully completed. The program is then
restarted. To ensure that automatic updating is restarted when an application is restarted
after quitting unexpectedly, Update.lock files older than two hours are ignored. If none of
the processes whose IDs are saved in the Update.lock file exist on the workstation when
the application is restarted, the Update.lock file is also ignored and the update is restarted.

Before actually updating, the preparation steps that prepare the installation for the update
are called from the *.Update.dlls. A preparation step might be renaming a machine role,
for example.

For the actual update, the Update.exe searches for all the necessary files and saves them in
a temporary directory. Communication with the system is established through the client
application to be updated because only it has the required permissions for contacting the
database or the application server. Once all the required files have been transferred, the
Update.exe takes control and starts the data exchange. At this point the user is prompted to
quit all running applications that may interfere with the update process. At the same time,
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administrator permissions requirements are authorized by user account control, if they are
necessary.

In this update procedure, not only are the files exchanged but other migration steps from
the *.Update.dlls are also run. The functionality in these migration steps is not restricted.
Typical examples are customizations in the registry database or configuration files and
removal of obsolete program data on the computers. These migration steps are run after
the files have been exchanged.

If all the update steps have been carried out successfully, the Update.exe creates a new
SoftwareRevision.viv and restarts the client application. The Update.exe then ends and
removes the temporary working directory itself. This software update is thus complete.

The semaphore test is carried out by VI.DB.dll on a cyclical basis during normal
operations. If a file is identified for update, the update process is started automatically.

Related topics

l User intervention in automatic updating of One Identity Manager tools on page 90

User intervention in automatic updating of
One Identity Manager tools

When the automatic One Identity Manager tool update is detected on a workstation, the
user is prompted to close all open programs. Updating starts after the user has closed all
the programs.

Whether or not the users of One Identity Manager tools can decide when their own
workstations are updated, is controlled by the Common | AutoUpdate |
AllowOutOfTimeApps configuration parameter. This means:

l Users have no way of intervening in the update if the configuration parameter is not
set. The update is run immediately.

l If the configuration parameter is set, the logged-in user is prompted with a message.
Users can decide whether the One Identity Manager tools update takes place on their
workstation straight away or at a later time.

NOTE: If users do not want to update immediately, they can continue working. The
update begins the next time the program is started.

Automatic updating of the One Identity
Manager Service

Automatic software update is the default method for updating the One Identity Manager
Service on servers. However, the update method takes into account that it may be
necessary to exclude certain servers from being updated automatically and to update
them manually.
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For every query of process steps, the One Identity Manager Service returns the current
status of the software revision semaphore. If this value differs from the value in the
database, the Job server is labeled as "updating" in the database and no more normal
process steps are sent to it.

The Job server is updated depending on the procedure set in the Common | Autoupdate
| ServiceUpdateType configuration parameter.

First, the start time of the last change is determined from the SoftwareRevision.viv file. A
list is compiled of all files with additional information specifying whether each file is new or
not. This list is evaluated on the Job server to be updated and another list is compiled
specifying which files will be updated.

To do this, the service obtains an AutoUpdate process from the server. which loads the
Update.zip file and the update process begins.

If updating with the new process cannot be completed because, for example, there is no
direct connection to the database or an application server, the files are transfer by process
steps in the Job queue (fallback). In this case, any existing update steps from the module
library might not be run.

One Identity Manager Service is restarted if any one of the files has changed on the Job
server. After the update is completed, the Job server label is reset in the database.

Automatic updating of web applications

In principle, web applications support automatic software updates. However, a few web
applications may require extra configuration to take part in automatic software updating.

The following permissions are required for automatic updating:

l The user account for updating requires write permissions for the application
directory.

l The user account for updating requires the local security policy Log on as a
batch job.

l The user account running the application pool requires the Replace a process level
token and Adjust memory quotas for a process local security policies.

Updating the web application requires restarting the application. The web application is
restarted automatically by the web server when it has been idle for a defined length of
time. This may take some time or be hindered by continuous user requests. Some web
application offer you the option to restart manually.

NOTE: To update the Web Portal automatically, use a browser to connect to the
http://<servername>/<application>/monitor runtime monitor and start the update of
the web application.

If the web application update is identified, new files are copied from the database to a
temporary directory on the server.

The application then loads the Update.zip file from the database or from the application
server, which is unpacked in a temporary directory.
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The Update.exe starts, waits until the web application process has shutdown, and copies
the files from the temporary directory to the web application's directory.

Related topics

l Updating application servers on page 122
l Configuring the Web Designer Web Portal automatic update on page 143
l Manager web application update on page 154

Implementing the automatic software
update

The following permissions are required for automatic software updating:

l It is recommended that you apply full access permissions to the One Identity
Manager installation directory for automatic updating of One Identity Manager tools.

l The service's user account needs full access to the One Identity Manager Service
installation directory in order to automatically update One Identity Manager.

To implement automatic software updating

1. Ensure that an update server is set up. This server ensures that the other servers are
updated automatically.

l The server must be entered in the database as a Job server with the server
function Update server.

l A One Identity Manager Service with direct access to the database must be
installed and configured on the server.

2. In the Designer, check the Common | Autoupdate configuration parameter.
l If the configuration parameter is set (default), One Identity Manager files that
do not have the current revision status, are updated automatically.

l If this configuration parameter is not set, no automatic update is performed.

3. Use the Common | AutoUpdate | AllowOutOfTimeApps configuration parameter
to define whether the users of the One Identity Manager tools can decide when the
update of their workstation takes place.

l If this configuration parameter is set, users of One Identity Manager tools are
prompted to decide whether they want to update now or later.

l If this configuration parameter is not set, the One Identity Manager tools are
updated immediately.

4. In the Common | Autoupdate | ServiceUpdateType configuration parameter,
determine which procedure is used to update the One Identity Manager Service.
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Method Meaning

Queue A process is queued in the Job queue that distributes the files.

DB The files are reloaded directly from the database. Implement this
procedure if all Job servers have a direct connection to the database.

Auto All root servers are filled directly from the database. A process is set up
in the Job queue for all leaf servers. For this process, the root servers
must have a direct database connection.

Table 20: Methods under to the configuration parameter Common |
Autoupdate | ServiceUpdateType

5. Web applications may require some individual configuration settings. Check the
configuration settings.

Related topics

l Basics for automatic software update on page 87
l Disabling automatic software update on page 93

Disabling automatic software update

NOTE: If the Common | Autoupdate configuration parameter is deactivated, no
automatic update is performed across the system.

Under certain circumstances, it is necessary to exclude individual workstations, server, or
web applications.

Disabling workstation automatic update

To disable automatic update locally on a workstation, set the HKEY_CURRENT_
USER\Software\One Identity\One Identity Manager\Global\Settings\AutoUpdateEnabled
registry key to false.

This disables automatic updating completely on this workstation.

Disabling a Job server automatic update

Configure the Job server automatic update in the Job server entry.

To exclude individual Job servers from updating automatically

1. In the Designer, select the Base Data > Installation > Job server category.

2. Select the Job server to be edited in the Job server overview.

3. On the Properties tab, enable the No automatic software update option.

4. Select the Database > Save to database and click Save.
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Disabling the Web Designer Web Portal automatic update

You can disable Web Designer Web Portal updates in the database.

To disable the automatic Web Designer Web Portal update

1. In the Designer, select the Base data > Security settings > Web server
configurations category.

2. In the list view, select the entry for the Web Designer Web Portal.

3. On the Properties tabs, change the value of the Auto update level to inactive.

4. Select the Database > Save to database and click Save.

Disabling automatic application server update

Configure automatic updating in the application server's web.config file. For more
information, see Updating application servers on page 122.

One Identity Manager 9.0 Installation Guide

Automatic updating of One Identity Manager
94



7

Updating One Identity Manager

Updating One Identity Manager tools includes updating the One Identity Manager database
and the existing installations on One Identity Manager network workstations and servers.

Database updates are necessary when hotfixes and service packs or complete version
updates are available for One Identity Manager.

l Hotfix

A hotfix contains corrections to the default configuration of the current main version
but no extension of functionality. A hotfix can supply patches for issues solved in
synchronization projects.

l Service pack

A service pack contains minimal extensions of functionality and all the modifications
since the last main version that were already included in the hotfixes. A service pack
can supply patches with new functions for synchronization projects.

l Version change

A version change means that significant extensions of functionality have been made
and involves a complete re-installation. A version change can supply milestones for
updating synchronization projects. Milestones group together all patches for solved
issues and patches required for new features of the previous version.

Detailed information about this topic

l The update process for releasing a new One Identity Manager version on page 96
l Automatic updating of One Identity Manager on page 87
l Updating One Identity Manager components with the installation wizard on page 99
l Updating the One Identity Manager database on page 101
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The update process for releasing a new
One Identity Manager version

NOTE: Read the release notes for possible differing or additional steps for updating One
Identity Manager.

To update the One Identity Manager to a new version

1. In the Designer, carry out all consistency checks in the Database section.

a. in the Designer, start the Consistency Editor with the Database > Check
data consistencymenu item.

b. In the Test options dialog, click the icon .

c. Enable all tests in the Database view and click OK.

d. Start testing with the Consistency check > Runmenu item.

All the database tests must be successful. Correct the errors. Some consistency
checks offer repair methods for correcting errors.

2. Update the administrative workstation on which the One Identity Manager database
schema update will start.

a. Run the autorun.exe program from the root directory on the One Identity
Manager installation medium.

b. Change to the Installation tab. Select the edition that you installed.

c. Click Install.

This starts the installation wizard.

d. Follow the installation instructions.

IMPORTANT: On the Installation Settings page, select the directory for
your current installation as the installation directory. Otherwise the compon-
ents are not updated and a new installation is created in the second
directory instead.

3. End the One Identity Manager Service on the update server.

4. Create a back up of the One Identity Manager database.

5. Check whether the database's compatibility level is set the 150 and change it
if necessary.

6. Run a schema update of the One Identity Manager database.
l Start the Configuration Wizard on the administrative workstation.

Select a user who has at least administrative permissions for the One Identity
Manager database to update the One Identity Manager schema with the
Configuration Wizard.
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l Use the same user that you used to initially install the schema.
l If you created an administrative user during schema installation,
use that one.

l If you selected a user with Windows authentication to install the schema,
you must use the same one for updating.

NOTE: If you want to switch to the granular permissions concept when you
upgrade from version 8.0.x to 9.0, you will also require an installation user in
accordance with Users with granular permission for the One Identity Manager
database on an SQL Server on page 25.

After updating One Identity Manager, change the connection parameters.
This affect the connection credentials for the database (DialogDatabase), for
example, the One Identity Manager Service, the application server,
administration, and configuration tools, web applications and web services,
and the connection credentials in synchronization projects.

If you want to switch to granular permissions when you update from 8.1.x,
contact support. To access the Support Portal, go to
https://support.oneidentity.com/identity-manager/.

7. Update the One Identity Manager Service on the update server.

a. Run the program autorun.exe from the root directory on the One Identity
Manager installation medium.

b. Change to the Installation tab. Select the edition that you installed.

c. Click Install.

This starts the installation wizard.

d. Follow the installation instructions.

IMPORTANT: On the Installation Settings page, select the directory for
your current installation as the installation directory. Otherwise the compon-
ents are not updated and a new installation is created in the second
directory instead.

8. Check the One Identity Manager Service‘s login information. Specify the service
account to use.

9. Start the One Identity Manager Service on the update server.

10. Update other installations on workstations and servers.

You can use the automatic software update method for updating existing
installations.

NOTE: In some cases it may be necessary to update the additional workstations
and Job servers manually. This may be required, for example, if there are a
significant number of new changes with a One Identity Manager version update
that do not allow the use of automatic update.

To update synchronization projects to a new version

Any required changes to system connectors or the synchronization engine are made
available when you update One Identity Manager. These changes must be applied to
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existing synchronization projects to prevent target system synchronizations that are
already set up, from failing. Patches are available for this.

NOTE: Some patches are applied automatically. A process that migrates all existing
synchronization project is queued in the Job queue to do this. To run the process, the One
Identity Manager Service must be started on the database server and on all the synchron-
ization servers.

l Check whether the DPR_Migrate_Shell process has been started successfully.

If a patch could not be applied, for example because the target system was not
available, you can apply the patch manually later.

For more information about applying patches, see the One Identity Manager Target System
Synchronization Reference Guide.

To update an application server to a new version

l The application server starts updating automatically after the One Identity Manager
database schema update.

l To start the update manually, open the status page for the application in the browser
and click Update immediately in the logged in user’s menu.

To update the Web Designer Web Portal to a new version

NOTE: Ensure that the application server is updated before you update the Web Portal.

l To update the Web Designer Web Portal automatically, use a browser to connect to
the runtime monitor http://<server name>/<application>/monitor and start the
update of the web application.

l To manually update the Web Designer Web Portal, uninstall the existing Web
Designer Web Portal installation and reinstall the Web Designer Web Portal.

To update an API Server to a new version

l After updating the One Identity Manager database schema, restart the API Server.
The API Server is updated automatically.

To update the Operations Support Web Portal to a new version

l (As from version 8.1.x) After updating the API Server, the Operations Support Web
Portal is also current.

l (As from version 8.0.x)

1. Uninstall the Operations Support Web Portal.

2. Install an API Server. For more instructions, see the One Identity Manager
Installation Guide.

To update the Manager web application to a new version

1. Uninstall the Manager web application.

2. Reinstall the Manager web application.
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3. The Manager default user requires write permissions to the Internet Information
Services web application installation directory so that Manager web applications can
be updated automatically. Check that the correct permissions are allocated.

Detailed information about this topic

l Automatic updating of One Identity Manager on page 87
l Updating One Identity Manager components with the installation wizard on page 99
l Updating the One Identity Manager database on page 101
l Installing and updating an application server on page 117
l Installing the API Server on page 126
l Installing, configuring, and maintaining the Web Designer Web Portal on page 132
l Installing and updating the Manager web application on page 150

Updating One Identity Manager
components with the installation wizard

NOTE: You can use the automatic software update method for updating worksta-
tions and servers. For more information, see Automatic updating of One Identity
Manager on page 87.

In some cases it may be necessary to update the workstations and servers manually using
the installation wizard. This may be required, for example, if there are a significant number
of new changes with a One Identity Manager version update that do not allow the use of
automatic update.

NOTE: If you change versions or add more modules to an existing One Identity Manager
installation, use the installation wizard to update the workstation that the One Identity
Manager database schema installation starts on.

To update a workstation using the installation wizard

1. Run the program autorun.exe from the root directory on the One Identity Manager
installation medium.

2. Change to the Installation tab. Select the edition that you installed.

NOTE: To update a One Identity Manager Active Directory Edition, switch to the
Other Products tab and select the One Identity Manager Active Directory
Edition entry.

3. Click Install.

This starts the installation wizard.

4. Select the language for the installation wizard on the start page and click Next.

5. Confirm the conditions of the license.
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6. On the Installation settings page, enter the following information.
l Installation source: Select the directory containing the installation files.
l Installation directory: Select your current installation directory. Otherwise,
the components are not updated and a new installation is created in the second
directory instead.

NOTE: To make additional changes to the configuration settings, click on the
arrow button next to the input field. Here, you can specify whether you are
installing on a 64-bit or a 32-bit operating system.

For a default installation, no further configuration settings are necessary.
l Select installation modules using the database: Set this option to load
the installation data using the existing One Identity Manager database.

NOTE: Leave this option empty to install the workstation on which you start
the One Identity Manager schema installation.

l Add further modules to the selected edition: Set this option to add
additional One Identity Manager modules to the selected edition.

7. Enter the database connection data on Connect to database.

NOTE: This page is only shown if you have set the Select installation modules
with existing database option.

l Select the connection in Select a database connection.

- OR -
l Click Add new connection, select the SQL Server system type, and enter
the connection data.

l Server: Database server.
l (Optional)Windows Authentication: Specifies whether the integrated
Windows authentication is used. This type of authentication is not
recommended. If you decide to use it anyway, ensure that your
environment supports Windows authentication.

l User: The user's SQL Server login name.
l Password: Password for the user's SQL Server login.
l Database: Select the database.

8. On theModule selection page, also select the modules to be installed.

NOTE: This page is only shown if you set the option Add more modules to the
selected Edition.

9. On the Assign machine roles page, define the machine roles.

NOTE: The machine roles appropriate for the One Identity Manager modules are
enabled. All machine subroles are selected when you select the machine role. You
can deselect individual packages.

10. On the Install WebView2 page you are prompted to install Microsoft Edge
WebView2. The user interface of some One Identity Manager components requires
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Microsoft Edge WebView2 to display certain content.

NOTE: This page is only shown if you want to install One Identity Manager
components that are expecting WebView2 and WebView2 is not yet installed.

11. You can start different programs for further installation on the last page of the
install wizard.

l To install the One Identity Manager schema, start the Configuration Wizard and
follow the Configuration Wizard instructions.

NOTE: Perform this step only on the workstation on which you start the
installation of the One Identity Manager schema.

l To create the configuration of the One Identity Manager Service, start the Job
Service Configuration program.

NOTE: Run this step only on servers on which you have installed the One
Identity Manager Service.

12. Click Finish to close the installation wizard.

13. Close the autorun program.

To update the One Identity Manager Service using the installation wizard

1. Open the service management of the server and close the One Identity
Manager Service.

2. Update the One Identity Manager components with the installation wizard.

IMPORTANT: On the Installation Settings page, select the directory for your
current installation as the installation directory. Otherwise, the components are not
updated and a new installation is created in the second directory instead.

3. Check the login information of the One Identity Manager Service. Specify the service
account to use.

4. Start the One Identity Manager Service in service management.

Updating the One Identity Manager
database

Automatic version control is integrated into One Identity Manager, ensuring that One
Identity Manager components are always consistent with each other and with the
database. If program extensions that change the structure are implemented - for example,
table extensions - the database needs to be updated.

You need to update the database if hotfixes and service packs are available for the version
of One Identity Manager you are currently running or for complete version updates. In
addition, customer-specific changes must be transferred from a development database into
the test database and into the production system database.
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IMPORTANT: Test changes in a test system before you load a transport package into a
live system.

You can customize the One Identity Manager schema by loading so-called transport
packages. One Identity Manager recognizes the following types of transport packages that
can be copied to the database depending on requirements.

Transport
package type

Description Tool used

Migration
package

Migration packages are provided by for the initial
database schema installation, for service pack and
complete version updates. A migration package
contains all the necessary tables, data types, database
procedures, and the default One Identity Manager
configuration.

Configuration
Wizard

Hotfix package Hotfix packages are provided to load individual correc-
tions to the default configuration such as templates,
scripts, processes, or files into the database. Multiple
hotfix packages are combined into one cumulative
hotfix package.

NOTE: If a hotfix package only contains changed
files, load these files into the database using the
Software Loader file.

Database
Transporter

Software
Loader

Custom config-
uration
package

A custom configuration package is used to exchange
customer specific changes between the development,
test, and productive system database. This transport
package is created by the customer and loaded into the
database.

Database
Transporter

Table 21: Transport package

NOTE: If other configuration customizations are to be transferred to a One Identity
Manager database in addition to a hotfix package, you can create a cumulative transport
package to do this and, by using the Database Transporter, import the transport package
into the target database.

Related topics

l Updating the One Identity Manager database with the Configuration Wizard on
page 104

l Installing a hotfix in the One Identity Manager database on page 109
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Advice on updating the One Identity
Manager database

l Test changes in a test system before you load a migration package in a production
system. Use a copy of the production database for testing.

l Before you update the One Identity Manager schema, ensure that the administrative
system user, who is going to compile the database, has a password. Otherwise the
schema update cannot be completed successfully.

l Use the Configuration Wizard to update the One Identity Manager database if you
have received a service pack or complete version update. The Configuration
Wizard carries out the update of the schema and transfers the current status to
the version history.

l For One Identity Manager databases on SQL Servers, it is recommended, on
performance grounds, that you set the database to the Simple recovery model for
the duration of the schema update.

l Start Configuration Wizard on an administrative workstation.

Select a user who has at least administrative permissions for the One Identity
Manager database to update the One Identity Manager schema with the
Configuration Wizard.

l Use the same user that you used to initially install the schema.
l If you created an administrative user during schema installation, use that one.
l If you selected a user with Windows authentication to install the schema, you
must use the same one for updating.

NOTE: If you want to switch to the granular permissions concept when you upgrade
from version 8.0.x to version 9.0, you will also require an installation user in accord-
ance with Users with granular permission for the One Identity Manager database on
an SQL Server on page 25.

After updating One Identity Manager, change the connection parameters. This
affect the connection credentials for the database (DialogDatabase), for example,
the One Identity Manager Service, the application server, administration tools and
configuration tools, web applications and web services, and the connection
credentials in synchronization projects.

If you want to switch to granular permissions when you update from 8.1.x, contact
support. To access the Support Portal, go to
https://support.oneidentity.com/identity-manager/.

l For the period of the update, the database is set to single user mode. Close all
existing connections to the database before starting the schema update.

l After the update has completed, the database switches automatically to multi-user
mode. If this is not possible, you receive a message in which you can manually switch
to multi-user mode.
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l You may experience problems activating single-user mode when using
database mirroring.

l During the update, calculation tasks are queued in the database. These are
processed by the DBQueue Processor. Processing calculation tasks may take some
time depending on the amount of data and system performance.

This is particularly the case if you save large amounts of historical data in the One
Identity Manager database, such as change data or data from process handling.

Therefore, ensure that you have configured an appropriate procedure for archiving
the data before you update the database. For more information about archiving data,
see the One Identity Manager Data Archiving Administration Guide.

l To ensure that HTML applications are successfully compiled, you must download
packages from the NPM repository. Ensure that the workstation you are compiling on,
can establish a connection to the registry.npmjs.org:443 website.

Alternatively, you can download packages from a proxy server and install
them manually.

Detailed information about this topic

l Updating the One Identity Manager database with the Configuration Wizard on
page 104

l Editing the One Identity Manager database while updating with the Configuration
Wizard on page 107

l Users with granular permission for the One Identity Manager database on an SQL
Server on page 25

Updating the One Identity Manager
database with the Configuration Wizard

IMPORTANT: Test your changes in a test system before you load a migration package in a
productive system. Use a copy of the production database for testing.

NOTE: Always start the Configuration Wizard on an administrative workstation!

To update a database

1. Start the Configuration Wizard.

2. On the Configuration Wizard home page, select the Update database option and
click Next.

3. On the Select database page, select the database and installation directory.

a. Select the database connection in the Select a database connection pane.
Select a user who at least has administrative permissions for the One Identity
Manager database.
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b. In the Installation source pane, select the directory with the
installation files.

4. Configuration modules and version information are shown on the Product
description page.

a. Select the module you want to update.

b. Confirm that you have an up-to-date backup of database.

c. Confirm that the database consistency checks were run.

d. Set Add other modules to select other modules.

5. On the Select configuration modules page, select the additional modules and
confirm the security prompt.

NOTE: This page is only shown if you set Add more modules.

If you add more modules, your custom administrative users obtain the permissions
for this module.

6. On the Database check page, errors are displayed that prevent the database from
being processed. Correct the errors before you continue updating.

7. On the Initiating the update page, you will go through the different phases in
preparation for database update.

NOTE: This page is only displayed when updating a database that has at least One
Identity Manager version 8.2.

This step-by-step preparation is intended to ensure that users are informed about the
upcoming update and that processes can be shut down in a targeted manner.

Alternatively, you can start the database update immediately. This skips the
preparation phases.

l Running through preparation phases (default)

a. Wait until the Configuration Wizard has completed each phase of
the database update preparations. The information about the phases
is displayed.

b. Click Next.
l Starting the database update immediately

a. Click the Click <here> to start the update immediately link.

b. Click Next.

8. Other users with existing connections to the database are displayed on the Active
sessions page.

l Disconnect the connections on order to start database processing.

9. On the Create a new login for administrators page, decide which SQL server
login to use for administrative users.

NOTE: This page is only shown when updating a One Identity Manager database
from version 8.0.x to version 9.0.
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If you want to switch to granular permissions when you update from version 8.1.x
at a later date, contact support. To access the Support Portal, go to https://sup-
port.oneidentity.com/identity-manager/.

You have the following options:
l Create new SQL Server logins for the database: Select this option if you
want to work with granular permissions.

This sets up a new administrative login on the SQL Server.
l Enter the login name, password, and password confirmation for the new
SQL Server login.

Later on in the process, the Configuration Wizard sets up additional SQL Server
logins for the configuration user and the end user.

l Use the current SQL Server login for the database: If you select this
option, no other SQL server logins are created for the database. In this case,
you cannot work with granular permissions concepts at SQL level.

The user you specified is used to connect to the database.

10. On the System administrator connection page, enter the login credentials for the
database login with system administrator permissions.

NOTE: This page is only shown if you are working with granular permissions and
you have to make changes to the administration user's permissions.

11. The installation steps are shown on the Processing database page. Installation
and configuration of the database are automatically carried out by the
Configuration Wizard.

TIP: Set Advanced to obtain detailed information about processing steps and the
migration log.

a. During the update process, you must log in as an administrative user.

i. Enter a user name and password for the administrative system user.

ii. Click Connect.

b. Once processing is complete, click Next.

12. On the Create SQL server logins page, enter the login name, the password,
and password confirmation for the SQL Server logins for configuration users
and end users.

NOTE: The password must meet the Windows policy requirements for passwords.

NOTE: This page is only shown when upgrading a One Identity Manager database
from version 8.0 to version 9.0 if you have opted for granular permissions on the
Create a new login for administrators page.

13. On the System Information page, configure administrative system users for the
One Identity Manager. Enter a password and password confirmation.

NOTE: This page is only shown if the upgrade creates new administrative
system users.
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14. You can configure the vendor notification on the page, Configure vendor
notification.

NOTE: This page is only shown of you have not yet enabled vendor notifications.

If vendor notification is enabled, One Identity Manager generates a list of system
settings once a month and sends it to One Identity. This list does not contain any
personal data. The list will be reviewed by our customer support team, who will look
for material changes in a proactive effort to identify potential issues before they
materialize on your system. The lists may be used by our R&D staff for analysis,
diagnosis, and replication for testing purposes. We will keep and refer to this
information for as long as your company remains on support for this product.

a. To use the function, set Enable vendor notification and enter your
company's contact email address in Email address for contact.

The email address is used as the sender address for notifying vendors.

b. Set Disable vendor notification if you do not want to use this functionality.

15. The Processing database tasks page is only shown if there are still DBQueue
Processor tasks queued in the DBQueue that are prerequisite for installing the
database. Once processing is complete, click Next.

16. On the last page of the Configuration Wizard, click Finish.

Related topics

l Advice on updating the One Identity Manager database on page 103
l Editing the One Identity Manager database while updating with the Configuration
Wizard on page 107

l One Identity Manager vendor notification on page 68
l Users with granular permission for the One Identity Manager database on an SQL
Server on page 25

l Permissions for the One Identity Manager database in a managed instance in an
Azure SQL Database on page 32

l Error messages when installing and updating the One Identity Manager
database on page 167

Editing the One Identity Manager database
while updating with the Configuration
Wizard

The One Identity Manager database is updated automatically by the Configuration Wizard.
This procedure may take some time depending on the amount of data and system
performance.

The Configuration Wizard performs the following steps:
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1. Prepare the update.

NOTE: This step is performed only when updating a database that has at least One
Identity Manager version 8.2.

This runs through the various phases for preparing the database update. This step-
by-step preparation is intended to ensure that users are informed about the
upcoming update and that processes can be terminated in a targeted manner.
Alternatively, you can start the database update immediately. This skips the
preparation phases.

These are the phases:
l Normal operation mode: The database is in normal operating mode. The
update process has not yet been initiated.

l Updating information: All database users are informed about the upcoming
update. The system does accept anymore processes. The preparation phase is
displayed in the program's status bar.

l Preparing update: New users cannot log in to the database anymore. All
running processes will still be completed. If this is taking a long time, check the
Job queue and the DB queue for processes. The preparation phase is displayed
in the program's status bar.

l Running update: The database is ready for updating. The update can start. The
preparation phase is displayed in the program's status bar.

2. Updating the One Identity Manager schema.

Before the schema update, the Configuration Wizard checks the database. Error
messages are displayed in a separate window. The errors must be corrected
manually. The schema update cannot be started until these are resolved.

All the tables, data types, and database procedures that are required are loaded into
the database by the schema update. When a migration package is imported into a
One Identity Manager database, the following operations are carried out:

Operations Description

Paste If the object is not found in the target database, a new object is
created with the key values.

Refresh If the object is found in the target database, the object is updated.

Delete Objects that are no longer needed are deleted.

Table 22: Operations on importing a migration package

During a schema update, calculation tasks are queued in the database. These are
processed by the DBQueue Processor.

During a schema update with the Configuration Wizard, the migration date and the
migration status are recorded in the transport history of the database.

3. Compiling the system.
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Scripts, templates, and processes are declared in the database. The System user
authentication module with the specified system user is used for compilation.

4. Uploading files for automatic software update.

In order to distribute One Identity Manager files using the automatic software
updating mechanism, the files are loaded into the One Identity Manager database.

5. Migrating synchronization projects.

A process that migrates all existing synchronization project is queued in the
Job queue. This updates the One Identity Manager schema and applies
automatic patches.

6. Finalizing the update.

Processes queued by the schema update are in the final stage of processing. Finally,
the database is switched back to normal operating mode.

Related topics

l Automatic updating of One Identity Manager on page 87
l Displaying the transport history and testing the One Identity Manager version
on page 165

l Error messages when installing and updating the One Identity Manager
database on page 167

Installing a hotfix in the One Identity
Manager database

IMPORTANT: Test changes in a test system before you install a hotfix in a
productive system.

Hotfix packages contain:

l Transport packages that contain changes to the default configuration, such as
templates, scripts, or processes in the One Identity Manager database

l Modified files, such as *.exe, *.dll or *.vif

If you receive a transport package using a hotfix package, use the Database Transporter
program to update the One Identity Manager database.

If a hotfix contains a modified file, copy the file to the install directory of the test computer
for testing. To distribute the files to all workstations and servers using the automatic
software automation, use the program Software Loader to import the files into the One
Identity Manager database.

NOTE: If other configuration customizations are to be transferred to a One Identity
Manager database in addition to a hotfix package, you can create a cumulative transport
package to do this and, by using the Database Transporter, import the transport package
into the target database.
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Detailed information about this topic

l Displaying the contents of a transport package with the Database Transporter
on page 110

l Importing transport packages with the Database Transporter on page 111
l Importing files with the Software Loader on page 113
l Displaying the transport history and testing the One Identity Manager version
on page 165

Displaying the contents of a transport package
with the Database Transporter

You can display the contents of a transport package with the Database Transporter before
you import.

NOTE: Always start the Database Transporter on an administrative workstation.

To display the contents of a transport package

1. Start the Launchpad and log in to the One Identity Manager database.

2. In the Change & Extend view, select the Transport custom modifications entry
and click Start.

This starts the Database Transporter program.

3. Select Show transport file.

4. Select the transport package file browser and click Open.

5. Click Next on the Select transport file page.

6. The contents of the transport file are displayed on the Show transport file page.
l To display the sequence in which the objects are imported

1. Click + to select an entry in the transport file and select Sort in import
order from the context menu.

2. Click OK and enter the connection credentials for the database. This step
is only required when you established the first in the order.

The order in which the entry's objects are imported into the
database is found.

3. Repeat this step for all other entries for which you want to determine the
import order.

l To display the objects required for an import in the target environment, select
the entry for the .xml file and select Show required objects from the
context menu.

Objects that are dependent on another object that is not part of the transport
package are highlighted.

7. To end the program, click Finish on the last page.
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TIP: You can start the import of the transport package from display mode. On the Show
transport file page, click the name of the transport package and use the Import
context menu.

Related topics

l Importing transport packages with the Database Transporter on page 111

Importing transport packages with the Database
Transporter

NOTE:

l Test the changes in a test environment before you load a transport package in a
production system. Use a copy of the production database for testing.

l To import transport packages with Database Transporter, the user requires the
Allows transport packages to be imported into the database program
function (Transport_Import).

l Start Database Transporter on an administrative workstation.
l The database is set to single-user mode for the duration of the import. Close all
existing connections to the database before starting the import.

l When you import a transport package with schema extensions, the database
is set to maintenance mode. Objects cannot be processed in the database
during this time.

l When you import a transport package with the Database Transporter, the import
date and description, the database version, and the transport package name are
recorded in the transport history of the target database.

To import a transport package

1. Start the Launchpad and log in to the One Identity Manager database.

2. In the Change & Extend view, select the Transport custom modifications entry
and click Start.

This starts the Database Transporter program.

3. Select Import transport file on the home page.

4. On the Select the database connection page, check the One Identity Manager
database connection data and change it if necessary.

5. Select the transport package file browser and click Open.

6. Specify your import options on Select transport file.
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Setting Description

Create a log
file for the
data import

Enable this option to create a log file for the import. The log file is
saved in the output directory of the transport file.

Import
objects
singly and
ignore
errors

Enable this option to import options individually. Errors, which might
occur during importing are ignored and displayed when importing is
complete. If you do not enable this option, the import procedure is
canceled when errors occur.

Ignore
default data
differences

Enable this option to ignore changes to default data during the
import. If you do not enable this option, the import procedure is
canceled if changes to default data are included.

Table 23: Import options

7. Import steps and import progress are displayed on the Importing transport data
page. The import procedure can take some time. Calculation tasks are queued for the
DBQueue Processor on termination.

NOTE: During import, if the expected value does not match with the actual value in
the database, theMerge conflict dialog opens. For each conflict, you must decide
which value is committed to the database.

l If you want to keep database value, enable Current database value.
l If you want the value from the transport package to overwrite the database
value, enable Transport value.

8. If changes have been made to the system configuration, for example, processes, or
scripts imported, you have to compile the database after the tasks have been
processed. Compilation is started automatically once importing is complete.

9. To end the program, click Finish on the last page.

NOTE: Use the button to save any errors that occur whilst importing.

Related topics

l Displaying the contents of a transport package with the Database Transporter
on page 110

l Displaying the transport history and testing the One Identity Manager version
on page 165
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Importing files with the Software Loader

NOTE:

l Start Software Loader on an administrative workstation.
l When selecting the base directory, ensure that a directory hierarchy is not created
unintentionally.

l For web applications, select the installation directory of the web application to
ensure that the required subdirectories, for example the bin directory, are
detected correctly.

l For more information about how to import customer-defined files using the
Software Loader, see the One Identity Manager Operational Guide.

To import files into a One Identity Manager database

1. Start the Launchpad and log in to the One Identity Manager database.

2. In the Change & Extend view, select the Import files for software update entry
and click Start.

This starts the Software Loader program.

3. Select Import into database on the home page.

4. On the Connect to database page, check the One Identity Manager database
connection data and change if necessary.

5. Specify the file to be imported on Select files.

a. Select the base directory where the files can be found.

The status and file size of all the files in the selected directory are displayed in
the file list.

State Meaning

Version
unknown

The file belongs to the known files but has not yet been loaded
into the database. There is no version information in the
database.

Unknown
file

The file is new. The file is in the list of known files but has not
been loaded in the database yet. There is no version information
in the database.

Version OK The file version matches the version in the database.

Version
modified

The file version has changed with respect to the version in the
database.

Table 24: Meaning of the status

b. Select the files you want to load into the One Identity Manager database.
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TIP:
l Click a column in the table header to order the display by the
selected column.

l Press Shift + select or Ctrl + select to select more than one file.
l To quickly select all files with Changed version as their status, select
Open all directories and Open all modified files in the context
menu. Files in subdirectories are only selected if the higher-level
directories have already been opened.

6. On the Select change label page, assign a change label to make it easier to
exchange files between various databases, such as the test database, development
database and productive database.

a. Select Assign files to following change label.

b. Use the button next to the option to select the change label.

7. The files are loaded straight from the One Identity Manager database.

8. Specify other file settings on Assign machine roles.

a. Assign a computer role to the files.

b. (Optional) For more file settings, click ... next to the file names.

Setting Description

Source
directory

Path to the installation source directory.

Create
backup

A copy must be made of the file during the automatic
software update.

No update The file is not updated by the automatic software update.

Table 25: Other file settings

9. To end the program, click Finish on the last page.

Related topics

l Automatic updating of One Identity Manager on page 87
l Machine roles and installation packages on page 185
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Installing additional modules for a
existing One Identity Manager

installation

To add more One Identity Manager modules to an existing One Identity Manager
installation, perform the following steps:

1. Install the One Identity Manager components included in the module on workstations
and servers.

Update the workstation to be used to start the One Identity Manager database
schema installation with the installation wizard. All other workstations and servers
obtain the new components through automatic software udpates. Use the installation
wizard to manually update individual workstations and servers.

2. Install the module in the One Identity Manager database.

IMPORTANT: This updates the database with an additional module. After installing
the extra module, all the other database module are processed.

If support sent you hotfixes for this version, then these hotfixes must also be
reinstalled.

To install components of a module on the workstation

1. Run the program autorun.exe from the root directory on the One Identity Manager
installation medium.

2. Switch to the Installation section. Select the edition that you installed.

3. Click Install.

This starts the installation wizard.

4. Follow the installation instructions. In the process, note the following:

a. On the Installation settings page, enter the following information:
l Installation source: Select the directory containing the installation
files.
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l Installation directory: Select your current installation directory.
Otherwise, the components are not updated and a new installation is
created in the second directory instead.

l Add further modules to the selected edition: Enable the option.

b. On theModule selection page, select the additional module to install.

c. If you update the workstation that is going to start the One Identity Manager
database schema, you can start the Configuration Wizard on the last page of
the installation wizard.

To install the module extensions in the One Identity Manager database

1. Start the Configuration Wizard on the administrative workstation.

2. On the Configuration Wizard home page, select the Update database option and
click Next.

3. Follow the installation instructions. In the process, note the following:

a. Configuration modules and version information are shown on the Product
description page.

i. Set the Add more modules option.

ii. Confirm that you have an up-to-date backup of database.

iii. Confirm that the database consistency checks were run.

b. On the Select configuration modules page, select the additional module.

Related topics

l Updating One Identity Manager components with the installation wizard
l Advice on updating the One Identity Manager database on page 103
l Updating the One Identity Manager database with the Configuration Wizard
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Installing and updating an
application server

The application server provides a connection pool for accessing the database. Clients send
their queries to the application server, which processes the objects, for example, by
determining values using templates and sending the results back to the clients. The data
from the application is sent to the database when an object is saved.

Before installation ensure that the minimal hardware and software prerequisites are
fulfilled on the server.

NOTE: On Linux operating systems, use of oneidentity/oneim-appserver docker images is
recommended.

Detailed information about this topic

l Minimum system requirements for the application server on page 39
l Tips for installing an application server on page 117
l Installing application servers on page 118
l Displaying application servers' status on page 122
l Updating the search index on application servers on page 124
l Updating application servers on page 122
l Uninstalling application servers on page 124

Tips for installing an application server

l If you want to run the One Identity Manager Service or the Designer through an
application server, the application server requires sufficient permissions for a
configuration user. Use the SQL Server login to connect to the One Identity Manager
database and to authenticate against the One Identity Manager database when you
install the application server.
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l To limit permissions for end users, you can make other application servers available
that use the SQL Server login for end users.

l To use the Web Portal or full text search in the Manager, you need an application
server with a search service installed on it.

l Start the application server installation locally on the server.
l Use the QBM | AppServer | SessionTimeout configuration parameter to add the
timeout in hours, after which inactive application server sessions are closed. The
default value is 24 hours. In the Designer, edit the configuration parameter.

Installing application servers

IMPORTANT: Start the application server installation locally on the server.

NOTE: On Linux operating systems, use of oneidentity/oneim-appserver docker images is
recommended.

To install an application server

1. Launch autorun.exe from the root directory of the One Identity Manager
installation medium.

2. On the start page of the installation wizard:

a. Change to the Installation tab.

b. In theWeb-based components pane, click Install.

This starts the Web Installer.

3. Select Install application server on the Web Installer and click Next.

4. On the Database connection page, do the following:
l To use an existing connection to the One Identity Manager database, select it in
the Select a database connectionmenu.

- OR -
l To create a new connection to the One Identity Manager database, click Add
new connection and enter a new connection .

5. Select the authentication method and, under Authentication method, enter the
login data for the database.

6. Configure the following settings on the Select setup target page.

Setting Description

Application
name

Name used as application name, as in the title bar of the browser,
for example.

Table 26: Settings for the installation target
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Setting Description

Target in IIS Internet Information Services web page on which to install the
application.

Enforce SSL Specifies whether secure or insecure websites are available to
install. If the option is set, only sites secured by SSL can be used
for installing. This setting is the default value. If this option is not
set, insecure websites can be used for installing.

URL The application's Uniform Resource Locator (URL).

Install
dedicated applic-
ation pool

Specifies whether an application pool is installed for each applic-
ation. This allows applications to be set up independently of one
another. If this option is set, each application is installed in its
own application pool.

Application pool The application pool to use. This can only be entered if the
Install dedicated application pool option is not set.

If you use the DefaultAppPool default value, the application
pool has the following syntax:

<application name>_POOL

Identity Permissions for running an application pool. You can use a default
identity or a custom user account.

If you use the ApplicationPoolIdentity default value, the user
account has the following syntax:

IIS APPPOOL\<application name>_POOL

You can authorize another user by clicking ... next to the box,
enabling the Custom account option and entering the user and
password.

Web authen-
tication

Type of authentication against the web application. You have the
following options:

l Windows authentication (single sign-on)

The user is authenticated against the Internet Information
Services using their Windows user account and the web
application logs in the employee assigned to the user
account as role-based. If single sign-on is not possible, the
user is diverted to a login page. You can only select this
authentication method if Windows authentication is
installed.

l Anonymous

Login is possible without Windows authentication. The user
is authenticated against the Internet Information Services
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Setting Description

and the web application anonymously, and the web
application is directed to a login page.

Database
authentication

NOTE: You can only see this section if you have selected a SQL
database connection on the Database connection page.

Type of authentication against the One Identity Manager
database. You have the following options:

l Windows authentication

The web application is authenticated against the One
Identity Manager database with the same Windows user
account that your application pool uses. Login is possible
with a user-defined user account or a default identity for
the application pool.

l SQL authentication

Authentication is completed with a SQL Server login and
password. The SQL Server login from the database
connection is used. Use the [...] button to enter a different
SQL login, for example, if the application is run with a
access level for end users. This access data is saved in the
web application configuration as computer specific
encrypted.

7. On the Assign machine roles page, define the machine roles.

This enables the machine roles for the application server. The machine roles Search
Service and Search Indexing Service are required for indexing the full text
search. These machine roles are always used together.

NOTE: If you want to use a Web Portal, you will need to use an application server
with a search service installed.

8. On the Set session token certificate page, select the certificate for creating and
checking session tokens.

NOTE: The certificate must have a key length of at least 1024 bits.
l To use an existing certificate, enter the following information.

1. Session token certificate: Select the Use existing certificate entry.

2. Select certificate: Select the certificate.
l To create a new certificate, enter the following information.

1. Session token certificate: Select the Create new certificate entry.

2. Certificate issuer: Enter the issuer of the certificate.

3. Key length: Specify the key length for the certificate.

The certificate is entered in the application server's certificate management.

One Identity Manager 9.0 Installation Guide

Installing and updating an application server
120



l To create a new certificate file, enter the following information.

1. Session token certificate: Select the Generate new certificate
file entry.

2. Certificate issuer: Enter the issuer of the certificate.

3. Key length: Specify the key length for the certificate.

4. Certificate file: Enter the directory path and name of the certificate file.

The certificate file is stored in the specified directory of the web application.

9. Specify the user account for automatic updating on the Set update credentials
page. The user account is used to add or replace files in the application directory.

l Use IIS credentials for update: Set this option to use the user account
under which the application pool is run for the updates.

l Use other credentials for updates: To use a different user account, set this
option. Specify the domain, the user name, and the user password.

10. (Optional) The One Identity Manager History Database is used to provide archived
data for analyzing in reports and the TimeTrace. If you access the One Identity
Manager History Database is through an application server, on the Edit History
Database connections page, enter the One Identity Manager History Database ID
and the connection parameters.

NOTE: You can enter the One Identity Manager History Database‘s connection
parameters at a later date. Use the configuration file (web.config) to do this.

For more information about connecting to the One Identity Manager History
Database through an application server and the required configuration, see the One
Identity Manager Operational Guide.

11. Installation progress is displayed on the Setup is running page. After installation is
complete, click Next.

12. Click Finish on the last page to end the program.

13. Close the autorun program.

NOTE: The Web Installer generates both the web application and the configuration file
(web.config). The Web Installer uses default values for the configuration settings. You
can keep these values but it is recommended you check the settings. You will find the
configuration file (web.config) in the web application directory in the Internet
Information Services.

Related topics

l Minimum system requirements for the application server on page 39
l Tips for installing an application server on page 117
l Displaying application servers' status on page 122
l Updating application servers on page 122
l Users with granular permission for the One Identity Manager database on an SQL
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Server on page 25
l Machine roles and installation packages on page 185

Displaying application servers' status

You can access the application server from a browser.

Use the appropriate URL for this:

http://<server name>/<application name>

https://<server>/<application name>

TIP: You can open the web server's status display in the Job Queue Info. In the Job
Queue Info, select View > Server state in the menu and, on theWeb servers tab,
open the web server status display from the Open in browser context menu.

You will see different status information. Status information for the application server is
displayed as performance indicators. Users with the Enables log display in the
application server program function (AppServer_Logs) can see the log.

In addition, API documentation is available here. To access the REST API on the application
server, the user required the Enables access to the REST API on the application
server (AppServer_API). For more information about the REST API, see the One Identity
Manager REST API Reference Guide

Updating application servers

NOTE:

l We recommend that you perform the automatic update only in specific
maintenance windows, in which the application cannot be accessed by users and
the application can be manually restarted with no risk.

l The following permissions are required for automatic updating:
l The user account for updating requires write permissions for the
application directory.

l The user account for updating requires the local security policy Log on as
a batch job.

l The user account running the application pool requires the Replace a
process level token and Adjust memory quotas for a process local
security policies.

To run an update, first load the files to be updated into the One Identity Manager database.
The necessary files are loaded into the One Identity Manager database and updated when a
hotfix, a service pack, or a full version update is run.
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The test depends on the selected mode for automatic update. New files are loaded from the
database as they are identified. The files cannot be updated while the application is
running. The update waits until the application is restarted.

The application is restarted automatically by the web server when it has been idle for a
defined length of time. However, this may take some time or be hindered by continuous
user requests.

Configure automatic updating in the application server's web.config file. In the
<autoupdate> section, you can control the behavior of the update.

Attribute Description

off Specifies whether automatic update is disabled (True) or not (False).

mode Mode for automatic update. Permitted values are:

l timer: Scheduled checking (default). At application start up, a
check for updated files in the database is carried out and
afterward, at schedule intervals (attribute checkinterval).

l manual: Manual checking. You start the check from the
application server's status page. Regular checking if updated files
in the database does not take place.

checkinterval Time period for search for update in timermode. Default: 5minutes

inactivitytime Time period without user activity so that the update can be started.
Default: 10 seconds.

Table 27: Attribute for automatically updating the configuration

Example:

<autoupdate>

<!-- <add key="off" value="true" /> -->

<add key="mode" value="timer" /> <!-- Valid options: timer, manual -->

<add key="checkinterval" value="00:05:00"/>

<add key="inactivitytime" value="00:00:10"/>

</autoupdate>

To start the update manually

1. Open the status page for the application server in the browser.

2. In the menu for the currently logged on user, click Update immediately.
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Related topics

l Displaying application servers' status on page 122
l Automatic updating of One Identity Manager on page 87

Updating the search index on
application servers

The searched index is updated when changes are made to a table with indexed columns, to
referenced tables or translations.

Use the Common | Indexing | BatchSize configuration parameter to define the
maximum number of objects that can be indexed in a single indexing run. The default
value is 50000.

The Common | Indexing | Interval configuration parameter contains the interval
between two indexing runs. The default value is 120 seconds. Once this time interval has
elapsed, a new indexing run is started.

You can also update the search index manually.

To manually update the search index on the application server:

1. Open the status page for the application server in the browser.

2. In the menu for the currently logged-in user, click Update Index.

3. Choose whether you want to update all indexes, or only some indexes.

Related topics

l Displaying application servers' status on page 122
l Log message for search index creation on page 173

Uninstalling application servers

To uninstall a web application

1. Launch autorun.exe from the root directory of the One Identity Manager
installation medium.

2. On the start page of the installation wizard:

a. Change to the Installation tab.

b. In theWeb-based components pane, click Install.

This starts the Web Installer.
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3. On the Web Installer start page, click Uninstall a web application and click Next.

4. On the Uninstall a web application page, double-click the application that you
want to remove.

The icon is displayed in front of the application.

5. Click Next.

6. On the Database connection page, select the database connection and
authentication method and enter the corresponding login data.

7. Click Next.

8. Confirm the security prompt with Yes.

9. The uninstall progress is displayed on the Setup is running page.

10. Once installation is complete, click Next.

11. On theWizard complete page, click Finish.

12. Close the autorun program.
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Installing the API Server

The API Server hosts the API that you defined. Angular web applications can also be
delivered over the API Server.

You can install the API Server with help from the Web Installer or the ImxClient command
line program (the install-apiserver command). Read through the following sections for
instructions on how to install the API Server on a Web Installer using the Windows Server
and set it up with the default configuration. For more information about installing using the
ImxClient command line program, see the One Identity Manager API Development Guide.

Detailed information about this topic

l Minimum system requirements for the web server on page 38
l Installing the API Server on page 126
l Uninstalling API Server on page 130

Installing the API Server

IMPORTANT: Start the API Server installation locally on the server.

NOTE: Before installation, ensure that the minimum hardware and software require-
ments are fulfilled on the server.

NOTE: On Linux operating systems, use of oneidentity/oneim-api docker images is
recommended.

TIP: You can install the API Server using the ImxClient command line program (install-
apiserver command). For more information, see the One Identity Manager API Devel-
opment Guide.

To install the API Server

1. Launch autorun.exe from the root directory of the One Identity Manager
installation medium.

2. On the installation wizard's home page, perform the following actions:
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a. Click Installation.

b. In theWeb-based components pane, click Install.

This starts the Web Installer.

3. On the Web Installer start page, click Install API Server.

4. Click Next.

5. On the Database connection page, do the following:

TIP: One Identity recommend establishing a connection over an application server.
l To use an existing connection to the One Identity Manager database, select it in
the Select a database connectionmenu.

l To create a new connection to the One Identity Manager database, click Add
new connection and enter a new connection .

6. Select the authentication method and enter the login data for the database under
Authentication method.

7. Click Next.

8. On the Installation source page, do the following:
l To retrieve the installation data from the database, activate the
Database option.

l to retrieve the installation data from the installation media (for example, from
the hard drive), activate the File system option and enter the path.

9. Click Continue.

10. Configure the following settings on the Select setup target page.

Setting Description

Application name Enter the name to use in the browser as the application name.

Target in IIS Select the website on the Internet Information Services where
the application is installed.

Enforce SSL Select the check box if the API Server website can only be
opened over an encrypted connection.

URL Enter the application's URL.

Install dedicated
application pool

Select the check box to install each application in its own applic-
ation pool. This allows applications to be set up independently
of one another. If this option is set, each application is installed
in its own application pool.

Application pool Select the application pool to use. This can only be entered if
the option Install dedicated application pool is not set.

If you use the default value DefaultAppPool, the application

Table 28: Settings for the installation target
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Setting Description

pool has the following syntax:

<application name>_POOL

Identity Specify the permissions for implementing the application pool.
You can use a default identity or a custom user account.

If you use the ApplicationPoolIdentity default value, the
user account has the following syntax:

IIS APPPOOL\<application name>_POOL

You can authorize another user by clicking ... next to the box,
enabling the option Custom account and entering the user
and password.

Web authen-
tication

Specify which type of authentication to use against the web
application. You have the following options:

l Windows authentication (single sign-on)

The user is authenticated against the Internet
Information Services using their Windows user account.
The web application logs in the employee assigned to the
user account as role-based. If single sign-on is not
possible, the user is diverted to a login page. You can
only select this authentication method is Windows
authentication is installed.

l Anonymous

Login is possible without Windows authentication. The
user is authenticated against the Internet Information
Services and the web application anonymously. The web
application is rerouted to a login page.

Database authen-
tication

NOTE: You can only see this pane if you have selected a SQL
database connection on the Database connection page.

Specify which type of authentication to use against the One
Identity Manager database. You have the following options:

l Windows authentication

The web application is authenticated against the One
Identity Manager database with the same Windows user
account that your application pool uses. Login is possible
with a user-defined user account or a default identity for
the application pool.

l SQL authentication

Login is only possible through a user-defined user
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Setting Description

account. Authentication is done using user name and
password. This access data is saved in the web
application configuration as computer specific encrypted.

11. Click Next.

If you have selected a direct database connection in step 4, the Select application
server page appears.

12. (Optional) Configure the following settings on the Select application server page.

NOTE: If you would like to use the full text search, then you must specify an
application server. You can enter the application server in the configuration file at
a later date.

a. Click Select application server.

b. In the dialog, in the URL field, enter the web address of the application server.

c. Click OK.

13. Click Continue.

14. On the Set session token certificate page, select the certificate for creating and
checking session tokens.

NOTE: The certificate must have a key length of at least 1024 bits.
l To use an existing certificate, set the following:

1. Session token certificate: Select the Use existing certificate entry.

2. Select certificate: Select the certificate.
l To create a new certificate, set the following:

1. Session token certificate: Select the Create new certificate entry.

2. Certificate issuer: Enter the issuer of the certificate.

3. Key length: Specify the key length for the certificate.

The certificate is entered in the API Server's certificate management.
l To create a new certificate file, set the following:

1. Session token certificate: Select the Generate new certificate
file entry.

2. Certificate issuer: Enter the issuer of the certificate.

3. Key length: Select the key length for the certificate.

4. Certificate file: Enter the directory path and name of the certificate file.

The certificate file is stored in the specified directory of the web application.

15. Click Next.

16. On the Assign machine roles page, define the machine roles.
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The SCIM Providermachine role is required for the SCIM plugin in the API Server.
For more information about the SCIM plugin, see the One Identity Manager
Configuration Guide.

17. Click Next.

18. Specify the user account for automatic updating on the Set update credentials
page by activating one of the following options:

NOTE: The user account is used to add or replace files in the application directory.
l Use IIS credentials for update: Set this option to use the user account used
by the application pool to run updates.

l Use other credentials for updates: To use a different user account, set this
option. Specify the domain, the user name, and the user password.

19. Click Next.

20. On the Application token page, enter the application token for the API Server into
the input field.

TIP: To use a new token and therefore replace the existing token in the database,
activate the option Replace the application token in the database. When
doing so, note that the current token will become invalid and every location that
uses it must be updated with the new token.

NOTE: Handle the application token like a password. Once the application is saved
in the database, it cannot be displayed in text form again. Make a note of the applic-
ation token if necessary.

21. Click Next.

The Setup is running page opens and shows the progress of each installation step.

22. Once installation is complete, click Next.

23. On theWizard complete page, click Finish.

24. Close the autorun program.

Related topics

l Uninstalling API Server on page 130

Uninstalling API Server

To uninstall a web application

1. Launch autorun.exe from the root directory of the One Identity Manager
installation medium.

2. On the start page of the installation wizard:
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a. Change to the Installation tab.

b. In theWeb-based components pane, click Install.

This starts the Web Installer.

3. On the Web Installer start page, click Uninstall a web application and click Next.

4. On the Uninstall a web application page, double-click the application that you
want to remove.

The icon is displayed in front of the application.

5. Click Next.

6. On the Database connection page, select the database connection and
authentication method and enter the corresponding login data.

7. Click Next.

8. Confirm the security prompt with Yes.

9. The uninstall progress is displayed on the Setup is running page.

10. Once installation is complete, click Next.

11. On theWizard complete page, click Finish.

12. Close the autorun program.

Related topics

l Installing the API Server on page 126
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Installing, configuring, and
maintaining the Web Designer Web

Portal

You can use the Web Installer to install, configure, and update the Web Designer Web
Portal. The following describes the steps necessary for installing the Web Designer Web
Portal on a Windows server and for getting the standard version up and running. The
configuration settings are explained using their corresponding, possible values.

Detailed information about this topic

l Installing the Web Designer Web Portal on page 132
l Updating the Web Designer Web Portal on page 137
l Uninstalling the Web Designer Web Portal on page 138
l Configuring the Web Designer Web Portal on page 139
l Maintenance of the Web Designer Web Portal on page 146

Installing the Web Designer Web Portal

The following describes how to the install the Web Designer Web Portal. Please note the
following information:

NOTE:

l Before installation ensure that the minimum hardware and software prerequisites
are fulfilled on the server.

l Prepare an application server on which the search service for the Web Designer
Web Portal is installed.

l Start the Web Designer Web Portal installation locally on the server.
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l If you install the Web Designer Web Portal with HTTPS, the transfer method for
cookies is configured to use HTTPS in the Web Installer.

l If you change the SSL settings for the Web Designer Web Portal at a later time, you
must manually update the value in the Web Portal's web.config configuration file.

l Default values are used for the configuration settings during installation. You can
keep these values. Check the settings using the Web Designer Configuration Editor.

To make a modification
l Example: Enter the value <httpCookies requireSSL="true"> in the

web.config under element <system.web>.

NOTE: On Linux operating systems, use of oneidentity/oneim-web docker images is
recommended.

To install the Web Designer Web Portal

1. Launch autorun.exe from the root directory of the One Identity Manager
installation medium.

2. On the start page of the installation wizard:

a. Change to the Installation tab.

b. In theWeb-based components pane, click Install.

This starts the Web Installer.

3. On the start page of the Web Installer, click Install Web Portal and click Next.

4. On the Database connection page, do the following:
l to use an existing connection to the One Identity Manager database, select it in
the Select a database connectionmenu.

- OR -
l to create a new connection to the One Identity Manager database, click Add
new connection and enter a new connection. For more information, see
Configuring database connections on page 140.

5. Select the authentication method and enter the login data for the database under
Authentication method.

6. Click Continue.

7. Configure the following settings on the Select setup target page.

Setting Description

Application
name

Name used as application name, as in the title bar of the browser,
for example.

Target in IIS Internet Information Services web page on which to install the

Table 29: Settings for the installation target
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Setting Description

application.

Enforce SSL Specifies whether secure or insecure websites are available to
install. If the option is set, only sites secured by SSL can be used
for installing. This setting is the default value. If this option is not
set, insecure websites can be used for installing.

URL The application's Uniform Resource Locator (URL).

Install
dedicated applic-
ation pool

Specifies whether an application pool is installed for each applic-
ation. This allows applications to be set up independently of one
another. If this option is set, each application is installed in its
own application pool.

Application pool The application pool to use. This can only be entered if the
Install dedicated application pool option is not set.

If you use the DefaultAppPool default value, the application
pool has the following syntax:

<application name>_POOL

Identity Permissions for running an application pool. You can use a default
identity or a custom user account.

If you use the ApplicationPoolIdentity default value, the user
account has the following syntax:

IIS APPPOOL\<application name>_POOL

You can authorize another user by clicking ... next to the box,
enabling the Custom account option and entering the user and
password.

Web authen-
tication

Type of authentication against the web application. You have the
following options:

l Windows authentication (single sign-on)

The user is authenticated against the Internet Information
Services using their Windows user account and the web
application logs in the employee assigned to the user
account as role-based. If single sign-on is not possible, the
user is diverted to a login page. You can only select this
authentication method if Windows authentication is
installed.

l Anonymous

Login is possible without Windows authentication. The user
is authenticated against the Internet Information Services
and the web application anonymously, and the web
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Setting Description

application is directed to a login page.

Database
authentication

NOTE: You can only see this section if you have selected a SQL
database connection on the Database connection page.

Type of authentication against the One Identity Manager
database. You have the following options:

l Windows authentication

The web application is authenticated against the One
Identity Manager database with the same Windows user
account that your application pool uses. Login is possible
with a user-defined user account or a default identity for
the application pool.

l SQL authentication

Authentication is completed with a SQL Server login and
password. The SQL Server login from the database
connection is used. Use the [...] button to enter a different
SQL login, for example, if the application is run with a
access level for end users. This access data is saved in the
web application configuration as computer specific
encrypted.

8. Click Continue.

If you have selected a direct database connection in step 4, the page Select
application server appears. Application server data is required if you want to
use full text search. You can enter the application server in the configuration file
at a later date.

9. (Optional) Configure the following settings on the Select application server page.

NOTE: If you would like to use the full text search in the Web Designer Web Portal,
then you must specify an application server. You can enter the application server in
the configuration file at a later date.

NOTE: If you are using Windows authentication and the application server is
located on a different host to that of the Web Designer Web Portal, or if the applic-
ation server uses a different user account for the application pool to that used by
the Web Portal, then some further Active Directory settings must be configured
(like a Kerberos delegation).

a. Click Select application server.

b. In the dialog, in the URL field, enter the application server's address that is
running the search service for full-text search.

c. Click OK.

10. On the Select application server page, click Next.
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11. On the Installation source page, perform one of the following actions in the
Installation source area:

l to retrieve the installation data from the database, activate the Load from
database option.

- OR -
l to retrieve the installation data from the installation media (e.g. from the hard
drive), activate the Load from local folder option and enter the path.

12. In theWeb project list, select the desired web project and enter the authentication
data if required:

NOTE: If no further authentication settings are required, the message No authen-
tication data required is displayed.

a. Click .

b. In the Authentication data dialog, click a red project.

c. Under Authentication method, specify the method and login data you would
like to use.

d. Repeat these steps for all other red projects.

e. Click OK.

13. Specify the user account for automatic updating on the Set update credentials
page by activating one of the following options:

NOTE: The user account is used to add or replace files in the application directory.
l Use IIS credentials for update: Set this option to use the user account used
by the application pool to run updates.

l Use other credentials for updates: To use a different user account, set this
option. Specify the domain, the user name, and the user password.

14. Click Continue.

15. On the Application token page, enter the application token for the Web project.

TIP: To use a new token and therefore replace the existing token in the database,
activate the option Replace the application token in the database. When
doing so, note that the current token will become invalid and every location that
uses it must be updated with the new token.

NOTE: Handle the application token like as password. Once the application is saved
in the database, it cannot be displayed in text form again. Make a note of the applic-
ation token if necessary.

16. Click Continue.

The Setup is running page opens and shows the progress of each installation step.
The Web Installer generates the web application and the corresponding configuration
files for each folder.

17. Installation progress is displayed on the Setup is running page. The Web Installer
generates the web application and the corresponding configuration files for each
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folder.

18. Once installation is complete, click Next.

19. On the Validate installation page, test the start of the web application. The base
URL is displayed for mail distribution. If you wish to use a different URL, select this
from the Change to field.

20. Click Continue.

21. On theWizard complete page, click Finish.

22. Close the autorun program.

Related topics

l Minimum system requirements for the web server on page 38
l Installing application servers on page 118
l Configuring the Web Designer Web Portal on page 139
l Authentication data for the web application on page 140

Updating the Web Designer Web Portal

NOTE:

l We recommend that you perform the automatic update only in specific
maintenance windows, in which the application cannot be accessed by users and
the application can be manually restarted with no risk.

l The following permissions are required for automatic updating:
l The user account for updating requires write permissions for the
application directory.

l The user account for updating requires the local security policy Log on as
a batch job.

l The user account running the application pool requires the Replace a
process level token and Adjust memory quotas for a process local
security policies.

The configuration settings for the automatic update of the web application are made in the
configuration file web.config. You can do this using the Web Designer Configuration Editor.

To update the web application automatically

1. Open the Runtime Monitor in the browser.

2. On the Status tab, select either the Update now or the Update when all user
sessions are closed options.
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To update a web application manually

l Uninstall the existing Web Designer Web Portal and re-install the Web
Designer Web Portal.

Note that each write access to the web application's bin folder causes the web application
to restart. This means that all active sessions in the application are closed and all unsaved
data is lost. For this reason, you should only perform manual updates of the web
application if no active session is running.

Related topics

l Configuring the Web Designer Web Portal automatic update on page 143
l Automatic updating of web applications on page 91
l Installing the Web Designer Web Portal on page 132
l Displaying the runtime monitor on page 146
l Maintenance mode on page 147

Uninstalling the Web Designer Web
Portal

To uninstall a web application

1. Launch autorun.exe from the root directory of the One Identity Manager
installation medium.

2. On the start page of the installation wizard:

a. Change to the Installation tab.

b. In theWeb-based components pane, click Install.

This starts the Web Installer.

3. On the Web Installer start page, click Uninstall a web application and click Next.

4. On the Uninstall a web application page, double-click the application that you
want to remove.

The icon is displayed in front of the application.

5. Click Next.

6. On the Database connection page, select the database connection and
authentication method and enter the corresponding login data.

7. Click Next.

8. Confirm the security prompt with Yes.

9. The uninstall progress is displayed on the Setup is running page.
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10. Once installation is complete, click Next.

11. On theWizard complete page, click Finish.

12. Close the autorun program.

Configuring the Web Designer Web
Portal

Web Designer Web Portal configuration covers a number of settings. The configuration is
saved in the web.config, NLog.config, and monitor.config web application configuration
files, which are found in the base directory of the web application, and in the table
QBMWebApplication of the One Identity Manager database.

Use the Web Designer Configuration Editor (WebDesigner.ConfigFileEditor.exe) to edit the
web.config configuration file.

Connection strings and login data are automatically encrypted in the configuration files
noted above with the default Microsoft ASP.NET cryptography.

To configure a web application

1. Start the WebDesigner.ConfigFileEditor.exe program from the installation directory
of the web application.

2. Select theweb.config configuration file in the Open configuration file view and
click Open.

3. Select the required authentication procedure and log on.

Make the configuration settings in the individual areas of the Web Designer
Configuration Editor.

Detailed information about this topic

l Configuring database connections on page 140
l Authentication data for the web application on page 140
l Logging for the web application on page 142
l Configuring the Web Designer Web Portal automatic update on page 143
l Advanced web settings on page 144
l Storing the cache directories on page 144
l Configuring debugger services on page 145
l Configuring the search service on page 145
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Configuring database connections

The current connection settings for the Web Designer Web Portal can be viewed in the Web
Designer Configuration Editor in the Database connection view. You can customize the
settings as required.

To select a new database connection

1. Open the Web Designer Configuration Editor.

2. In the Database connection view, click the Enter new connection link.

3. Select the system type and enter the connection data:
l For the SQL Server system type, enter the following information.

l Server: Database server.
l (Optional)Windows Authentication: Specifies whether the integrated
Windows authentication is used. This type of authentication is not
recommended. If you decide to use it anyway, ensure that your
environment supports Windows authentication.

l User: The user's SQL Server login name.
l Password: Password for the user's SQL Server login.
l Database: Select the database.

l For the Application server system type, enter the URL.

NOTE: In the Options menu, select either Test connection or Advanced options
as required.

Related topics

l Logging in to the One Identity Manager database on page 157

Authentication data for the web application

The authentication data for the web project and subprojects is configured in the Web
Designer Configuration Editor in the Web project section. For more information
about authentication modules, see the One Identity Manager Authorization and
Authentication Guide.

Setting Description

Web project Name of the web project.

Authentication
module

Authentication module for logging on to the web project.

Table 30: Authentication data for the web project
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Setting Description

NOTE: Some authentication modules support single sign-on. In
such cases, a corresponding message is shown beneath selection.

Perform single
sign-on, if an error
occurs, using the
following module.

If the module selected under Authentication module supports
single sign-on, you have the option to specify an alternative authen-
tication method here. This authentication method is used as a fall-
back if single sign-on fails for any reason.

Debugging Activate this option if you want to use a debugging environment.

OAuth If you use the OAuth 2.0 / OpenID Connect or OAuth 2.0 /
OpenID Connect (role-based) authentication modules, make
your configuration settings here.

OAuth 2.0 /
OpenID Connect
configuration

Select the OAuth 2.0 / OpenID Connect configuration that you want
to adjust.

Client ID for OAuth
authentication

ID of the application on the identity provider.

Example: urn:OneIdentityManager/Web

Issuer information
for the OAuth certi-
ficate

This is used to find the certificate in the certificate store. Either the
thumb nail or the issuer of the certificate is required.

For example: O=[company name], OU=[organizational unit], CN=
[server IP]

OAuth Resource Uniform Resource Name (URN) of the resource to be queried. Only
required if the identity provider requires this value.

Thumbprint for the
OAuth certificate

Thumbprint of the certificate used to verify the security token. Either
the thumb nail or the issuer of the certificate is required.

Endpoint Uniform Resource Locator (URL) of the certificate end point on the
authorization server.

For example: https://certificateServer/certificate.crt

Authentication
data for subpro-
jects

Authentication data for subprojects.

To enter or change authentication data for a sub project

1. Open the Web Designer Configuration Editor.

2. In theWeb project pane, next to the Authentication for sub projects is
missingmessage, click .

3. In the edit view, click on the project marked in red.

4. In the Authentication method pane, select the required authentication procedure
and enter the required login information.

5. Click OK.
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Logging for the web application

The settings for logging the web application are configured in the Web Designer
Configuration Editor in the Log view. This view is divided into:

l General
l Application log
l Event log
l Database log

Setting Description

Application Name of the web application.

Company
name

Name of the company that uses the web application.

Product title Software manufacturer’s product name

Log
directory

Directory in which the log files of the web application are saved. The web
server process must have write access to this folder.

Table 31: General settings for logging

Setting logging

Severity
code

Severity level of the log.

Archive
every

Maximum runtime of a log file before it is renamed. When a log file has
reached its maximum age, the file is renamed and a new log file is started.

Archive
numbering

Specifies whether the archive files of the application log are numbered in
ascending or descending order.

Table 32: Application log settings

Setting Description

Severity code Severity level of the log.

Table 33: Event log settings

Setting Description

Severity
code

Severity level of the log.

Archive Maximum runtime of a log file before it is renamed. When a log file has

Table 34: Database log settings
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Setting Description

every reached its maximum age, the file is renamed and a new log file is started.

Archive
numbering

Specifies whether the archive files of the database log are numbered in
ascending or descending order.

Severity
Level

Description

Off No information is logged.

Trace Logs highly detailed information. This setting should only be used for
analysis purposes. The log file quickly becomes large and cumbersome.

Debug Logs debug steps. This setting should only be used for testing.

Info Logs all information.

Warning Logs all warnings.

Errors Logs all error messages.

Fatal Logs all critical error messages.

Table 35: Permitted severities

Configuring the Web Designer Web Portal
automatic update

NOTE: The following permissions are required for automatic updating:

l The user account for updating requires write permissions for the application
directory.

l The user account for updating requires the local security policy Log on as
a batch job.

l The user account running the application pool requires the Replace a process
level token and Adjust memory quotas for a process local security policies.

The automatic update is configured in the Web Designer Configuration Editor in the
Automatic update pane.

To configure the automatic update of the web application

1. Open the Web Designer Configuration Editor.

2. In the Automatic updates pane, set the Enable automatic updates option.

3. Define the user account for the automatic update. The user account is used to add or
replace files in the application directory.
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l Use IIS credentials for update: Set this option to use the user account
under which the application pool is run for the updates.

l Use other credentials for updates: To use a different user account, set this
option. Specify the domain, the user name, and the user password.

Related topics

l Automatic updating of One Identity Manager on page 87
l Automatic updating of web applications on page 91
l Updating the Web Designer Web Portal on page 137

Advanced web settings

In theWeb settings pane of the Web Designer Configuration Editor, you configure the
following web settings.

Setting Description

HTML headers HTTP header lines that the server outputs for every HTTP query.

After logging
off

Page that is displayed after the user has logged off.

Close session
after idle time
(minutes)

Period of inactivity after which the session is closed.

NOTE: Enter the value 0 if you want the session to remain open despite
being idle.

Compress
HTTP transfer

Specifies whether the HTTP transfer takes place in compressed form.

Create
Windows
performance
indicators

When you install a web application, performance counters are registered,
which provide information about the state of the application. For more
information, see the Using the performance indicators for monitoring on
page 148.

Table 36: Web setting

Storing the cache directories

The storage of the cache directories is configured in the Web Designer Configuration Editor
in the Cache pane.
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Setting Description

Cache
directory

Full path to the directory used for temporary saving of frequently used
application contents.

Assembly
cache

Full path to the directory for caching assembler files.

Table 37: Settings for cache directories

Configuring debugger services

For functions of the web application that support the debugging mode, a Windows
Communication Foundation (WCF) connection must be established. The permitted port
range for the WCF connection is configured in the Web Designer Configuration Editor in the
Debugger Service pane.

To restrict the port range of the WCF connection

1. Open the Web Designer Configuration Editor.

2. In the Debugger service pane, enable the Limit port range option and define the
limits for the port using the connection.

Configuring the search service

Prerequisite for using the Web Designer Web Portal is an application server installed with
the search service.

l If you run the Web Designer Web Portal directly over an application server installed
with the search service, you can use the full text search immediately.

l If you are using the Web Designer Web Portal with an application server that does not
have an installed search service, or with a direct database connection, you will need
to enter an application server with an installed search service in the configuration of
the web application.

The application server is usually entered during the Web Designer Web Portal
installation. For subsequent changes, use the Web Designer Configuration Editor.

To enter an application server at a later date

1. Open the Web Designer Configuration Editor.

2. In the Search service pane, click Select application server.

3. Enter the application server's web address in the URL.

4. Test the connection by selecting Test connection from the Optionsmenu.
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5. Edit other optional settings by selecting Advanced settings from the Options
menu.

6. To accept the settings, click OK.

Certain important columns are already indexed for full text search in the default
installation. You configure more columns for full text searching if you require.

For more information about configuring columns for the full text search, see the One
Identity Manager Configuration Guide. For more information about using the full text
search in the Web Designer Web Portal, see the One Identity Manager Web Designer Web
Portal User Guide.

Related topics

l Installing and updating an application server on page 117
l Installing the Web Designer Web Portal on page 132

Maintenance of the Web Designer Web
Portal

The following is a list of the maintenance options available for a web application, together
with descriptions.

Detailed information about this topic

l Displaying the runtime monitor on page 146
l Log files and exceptions on page 147
l Maintenance mode on page 147
l Using the performance indicators for monitoring on page 148

Displaying the runtime monitor

The Web Designer Web Portal includes a runtime monitor for monitoring. The runtime
monitor is accessed over a browser front-end.

Use the appropriate URL for this:

http://<servername>/<application>/monitor

Related topics

l Access permissions for the runtime monitor on page 147
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Access permissions for the runtime monitor

Access to the runtime monitor is configured in the configuration file (monitor.config) of the
web application. The default settings enables only members of the
BUILTIN\Administrators group to access the runtime monitor.

<?xml version="1.0"?>

<!-- Permission to use WebDesigner runtime monitor -->

<authorization>

<allow roles="BUILTIN\Administrators" />

<deny users="*" />

</authorization>

For more information about changing this setting, see the ASP.NET documentation.

Log files and exceptions

The log files are displayed in the Runtime Monitor.

l All log files generated by the web application are displayed on the Log files tab.

You can filter these file and search by strings. The log files exist in physical form in
the log directory defined by the configuration in the configuration file of the web
application, usually ./Logs).

l The Exceptions tab display log messages that contain exception errors. These
messages are sorted by exception error and in descending order of frequency. The
top exception error in the list is the error that occurs most frequently.

NOTE: The Web Installer writes important events to the log file of the application. You can
view this log file in the Windows event display.

Related topics

l Logging for the web application on page 142
l Displaying the runtime monitor on page 146

Maintenance mode

To carry out maintenance work, switch the web application to maintenance mode. You use
maintenance mode, for example, to enable an update at a particular time.

No new sessions are permitted in maintenance mode. Current sessions are not affected.
While maintenance work is being performed, users who view the web application are
displayed the contents of the Maintenance.html file, which is located in the installation
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directory of the web application. You can edit this file to display details of the maintenance
work for the user.

To switch the web application to maintenance mode

1. Open the Runtime Monitor in the browser.

2. On the Status tab, click Start maintenance mode.

To end maintenance mode

1. Open the Runtime Monitor in the browser.

2. On the Status tab, click End maintenance mode.

Maintenance mode can also be activated by creating the file App_Data\Maintenance.mode in
the installation directory of the web application, and deactivated by deleting this file.

Related topics

l Displaying the runtime monitor on page 146

Using the performance indicators for
monitoring

When you install a web application, performance counters are registered, which provide
information about the state of the application.

Performance indicators can be installed later.

NOTE: Prerequisites for this are that the web application is installed on a Windows Server
and has sufficient permissions to offer performance indicators. It may be necessary to
add the application pool user account to the local group Performance monitoring user
for this. Apart from this, the web application must be running in order to select the
performance indicators.

To post-install performance indicators

1. Open the Web Designer Configuration Editor.

2. ClickWeb settings and Create Windows performance counters.

After this is successfully completed, an installation prompt is displayed.

3. Confirm the prompt with OK.

To view performance counters

1. Log in to the server on which the web application is installed.

2. Start performance monitoring of Windows.

3. In the dialog on the left-hand side, select Performance monitoring.
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4. In the performance monitoring view, click .

5. In the Add Counters dialog, under Available Counters, select the One Identity
Manager Web Portal and add to the entry.

This displays performance indicators for the web application. The following indicators
are available.

Performance indicator Description

AJAX calls Number of HTTP queries processed asynchronously.

Objects Number of active database objects.

Exceptions Number of exception errors that have occurred.

Forms Number of active forms.

HTML requests Number of HTML page requests.

PID Number of process IDs.

Contexts Number of active module objects.

Sessions Number of active sessions.

Sessions total Total number of sessions since the application started.

Table 38: Performance indicators

6. Enter any new performance indicators you wish and select the web application under
Instances of selected object:.

TIP: Only running web applications are displayed for selection. If you install a new
web application, it may take a few minutes before the list of available web applic-
ations including the new one is available.
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Installing and updating the Manager
web application

Manager functionality can be provided by web applications. Before installation ensure that
the minimal hardware and software prerequisites are fulfilled on the server.

Detailed information about this topic

l Minimum system requirements for the web server on page 38
l Installing the Manager web application on page 150
l Manager web application update on page 154
l Uninstalling Manager web applications on page 154
l Advanced configuration of the Manager web application on page 175

Installing the Manager web application

One Identity Manager requires each web application to be defined in one language. If you
wish to publish an application in two languages, you must install two separate applications.
Web Installer installs one application per language by default.

You can define a language pool for these applications if several application are running at
once. If a user calls up a web application from the language pool, they are automatically
diverted to the web application that matches their language. It is, therefore, not important
to declare all the web application URLs in the language pool.

This mechanism also allows you to achieve simple load balancing.

IMPORTANT: Start the Manager web application installation on the server.

To install the Manager web application

1. Launch autorun.exe from the root directory of the One Identity Manager
installation medium.

2. On the start page of the installation wizard:
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a. Change to the Installation tab.

b. In theWeb-based components pane, click Install.

Starts the Web Installer.

3. On the start page of the Web Installer, select Install Manager web application
and click Next.

4. On the Database connection page, do the following:

TIP: It is recommended to establish a connection through the application server.
l To use an existing connection to the One Identity Manager database, select it in
the Select a database connectionmenu.

- OR -
l To create a new connection to the One Identity Manager database, click Add
new connection and enter a new connection .

5. Select the authentication method and, under Authentication method, enter the
login data for the database.

6. Configure the following settings on the Select setup target page.

Setting Description

Application
name

Name used as application name, as in the title bar of the browser,
for example.

Target in IIS Internet Information Services web page on which to install the
application.

Enforce SSL Specifies whether secure or insecure websites are available to
install. If the option is set, only sites secured by SSL can be used
for installing. This setting is the default value. If this option is not
set, insecure websites can be used for installing.

URL The application's Uniform Resource Locator (URL).

Install
dedicated applic-
ation pool

Specifies whether an application pool is installed for each applic-
ation. This allows applications to be set up independently of one
another. If this option is set, each application is installed in its
own application pool.

Application pool The application pool to use. This can only be entered if the
Install dedicated application pool option is not set.

If you use the DefaultAppPool default value, the application
pool has the following syntax:

<application name>_POOL

Identity Permissions for running an application pool. You can use a default

Table 39: Settings for the installation target
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Setting Description

identity or a custom user account.

If you use the ApplicationPoolIdentity default value, the user
account has the following syntax:

IIS APPPOOL\<application name>_POOL

You can authorize another user by clicking ... next to the box,
enabling the Custom account option and entering the user and
password.

Web authen-
tication

Type of authentication against the web application. You have the
following options:

l Windows authentication (single sign-on)

The user is authenticated against the Internet Information
Services using their Windows user account and the web
application logs in the employee assigned to the user
account as role-based. If single sign-on is not possible, the
user is diverted to a login page. You can only select this
authentication method if Windows authentication is
installed.

l Anonymous

Login is possible without Windows authentication. The user
is authenticated against the Internet Information Services
and the web application anonymously, and the web
application is directed to a login page.

Database
authentication

NOTE: You can only see this section if you have selected a SQL
database connection on the Database connection page.

Type of authentication against the One Identity Manager
database. You have the following options:

l Windows authentication

The web application is authenticated against the One
Identity Manager database with the same Windows user
account that your application pool uses. Login is possible
with a user-defined user account or a default identity for
the application pool.

l SQL authentication

Authentication is completed with a SQL Server login and
password. The SQL Server login from the database
connection is used. Use the [...] button to enter a different
SQL login, for example, if the application is run with a
access level for end users. This access data is saved in the
web application configuration as computer specific
encrypted.
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7. Specify other application specific settings on the Configuration page.

a. Select the language of the application from the Languagemenu. The language
influences how dates and numbers displayed amongst other things.

b. The web application requires access permissions to itself. If you selected the
Windows authentication (single sign-on) authentication type as web
authentication, enter the domain, user account, and password for the user. For
anonymous web authentication, no further entries are required.

8. Specify the user account for automatic updating on the Set update credentials
page. The user account is used to add or replace files in the application directory.

l Use IIS credentials for update: Set this option to use the user account
under which the application pool is run for the updates.

l Use other credentials for updates: To use a different user account, set this
option. Specify the domain, the user name, and the user password.

9. Installation progress is displayed on the Setup is running page. Once installation is
complete, click Next.

10. Click Finish on the last page to end the program.

NOTE: The Web Installer generates both the web application and the configuration file
(web.config). The Web Installer uses default values for the configuration settings. You
can keep these values. It is recommended you check the settings with the help of the
Manager Web Configuration Editor. You will find the configuration file (web.config) in the
web application directory in the Internet Information Services.

Related topics

l Manager web application update on page 154
l Advanced configuration of the Manager web application on page 175

Displaying the Manager web application

The Manager web application is accessed over a browser.

Use the appropriate URL for this:

http://<server name>/<application name>

https://<server>/<application name>
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Manager web application update

NOTE:

l We recommend that you perform the automatic update only in specific
maintenance windows, in which the application cannot be accessed by users and
the application can be manually restarted with no risk.

l The following permissions are required for automatic updating:
l The user account for updating requires write permissions for the
application directory.

l The user account for updating requires the Log on as a batch job local
security policy.

l The user account running the application pool requires the Replace a
process level token and Adjust memory quotas for a process local
security policies.

The application update happens automatically if the Auto update plugin is enabled for the
web application.

To run an update, first load the files to be updated into the One Identity Manager database.
The necessary files are loaded into the One Identity Manager database and updated when a
hotfix, a service pack, or a full version update is run.

The Automatic update plugin performs a check when the application is started, and every
approx. 5 minutes thereafter. New files are loaded from the database as they are
identified. The plugin cannot update the files while the application is running. The update
waits until the application is restarted.

The application is restarted automatically by the web server when it has been idle
for a defined length of time. This may take some time or be hindered by continuous
user requests.

Related topics

l Automatic updating of One Identity Manager on page 87
l Advanced configuration of the Manager web application on page 175

Uninstalling Manager web applications

To uninstall a web application

1. Launch autorun.exe from the root directory of the One Identity Manager
installation medium.

2. On the start page of the installation wizard:
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a. Change to the Installation tab.

b. In theWeb-based components pane, click Install.

This starts the Web Installer.

3. On the Web Installer start page, click Uninstall a web application and click Next.

4. On the Uninstall a web application page, double-click the application that you
want to remove.

The icon is displayed in front of the application.

5. Click Next.

6. On the Database connection page, select the database connection and
authentication method and enter the corresponding login data.

7. Click Next.

8. Confirm the security prompt with Yes.

9. The uninstall progress is displayed on the Setup is running page.

10. Once installation is complete, click Next.

11. On theWizard complete page, click Finish.

12. Close the autorun program.
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13

Logging in to One Identity
Manager tools

When you start one of the One Identity Manager tools, a default connection dialog opens.

Figure 5: Default connection dialog

When you log in, you need to be aware of the difference between a database user and a
user of individual One Identity Manager tools (system user). Several system users can
work with one database user.

Login takes place in two steps:

l Selecting the database connection to log in to the database
l Selecting the authentication procedure and finding the system user for logging in.
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Permitted system user IDs are determined by the authentication module you select.
One Identity Manager provides various authentication modules for this purpose.

The One Identity Manager tools can only be started if the user has the relevant program
function permissions. Some administration tools expect a specific access level for the
selected SQL Server login.

For more information about the One Identity Manager authentication modules and program
functions, see the One Identity Manager Authorization and Authentication Guide.

NOTE: When you start the program, it tries to restore the last used connection. This may
lead to a delay resulting in an error if you frequently swap between connections to other
database servers.

To prevent the previous connection restoring, create the following registry key:

HKEY_CURRENT_USER\Software\One Identity\One Identity Manager\Global\Settings\
[RestoreLastConnection]="false"

Detailed information about this topic

l Logging in to the One Identity Manager database on page 157
l Logging in to the One Identity Manager tools using a system ID on page 159
l Enabling additional authentication modules on page 161
l Enabling other login languages on page 162
l Checking authentication on page 163
l Password expiry on page 162

Logging in to the One Identity
Manager database

To select an existing connection

l Select the connection under Select a database connection in the connection
dialog.

NOTE:

l Newly created connections are not shown in the connection dialog until the
program has been restarted.

l Connections that do not use the expected access level for SQL Server logins are not
shown in the connection dialog.

l The access level for an existing connection is shown in the menu item's tooltip.

For more information about minimum access levels for One Identity Manager tools,
see the One Identity Manager Authorization and Authentication Guide.
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To create a new connection to the One Identity Manager database

1. Under Select a database connection, click Add new connection and select the
SQL Server system type.

2. Click Next.

3. Enter the connection data for the database server.
l Server: Database server.
l (Optional)Windows Authentication: Specifies whether the integrated
Windows authentication is used. This type of authentication is not
recommended. If you decide to use it anyway, ensure that your environment
supports Windows authentication.

l User: The user's SQL Server login name.
l Password: Password for the user's SQL Server login.
l Database: Select the database.

4. Select Test connection in the Optionsmenu.

This attempts to connect the database with the given connection data. You are
prompted to confirm a message about the test.

NOTE: Using Options > Advanced options item, you can make additional
changes to the connection configuration.

5. Click Finished.

To set up a new connection to the application server

1. Under Select a database connection, click Add new connection and select the
Application server system type.

2. Click Next.

3. Enter the address (URL) for the application server.

4. If you access an application server secured through SSL/TLS, configure additional
settings for the certificate:

l If the certificate's server name matches the application server's URL and, if the
server certificate can be successfully validated, the server name displayed in
green next the URL. By clicking the server name next to the URL, you can get
information about the certificate. You can select a certificate required for
logging in, under Pin server certificate.

l If the certificate's server name does not match the application server's URL or,
if the server certificate cannot be successfully verified, the server name is
displayed in red next the URL. You decide whether to trust the certificate.

l If a client certificate is expected according to the SSL settings, select the
certificate under Select client certificate and specify how the certificate is to
be verified. You have the following options: Find by subject name, Find by
issuer name and Find by thumbprint.
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l If you want to use a self-signed certificate, enable the Accept self-signed
certificate option.

5. Select Test connection in the Optionsmenu.

This attempts to connect the database with the given connection data. You are
prompted to confirm a message about the test.

NOTE: Using Options > Advanced options item, you can make additional
changes to the connection configuration.

6. Click Finished.

To delete a connection

1. Select the connection under Select a database connection.

2. Press DEL.

3. Confirm the security prompt with Yes.

The database connection is no longer displayed in the connection dialog.

To delete an SQL Server from the server list

1. Under Select a database connection, click Add new connection and select the
SQL Server system type.

2. Click Next.

3. Open the Servermenu and mark the server you want to delete.

4. Press the Del key.

5. Confirm the security prompt with Yes.

This removes the SQL Server from the list.

Related topics

l Logging in to the One Identity Manager tools using a system ID on page 159

Logging in to the One Identity Manager
tools using a system ID

Following the database login, the user must log in to the program as a system user.
Permitted system user IDs are determined by the authentication module you select.

NOTE:

l After the initial schema installation, only the System user and
ComponentAuthenticator authentication modules and the role-based
authentication modules are enabled in One Identity Manager.
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l The One Identity Manager tools can only be started if the user has the relevant
program function permissions.

l Use non role-based authentication modules to log in to the Designer. Role-based
authentication modules for logging in to the Designer are not supported.

To log in to One Identity Manager tools with a system user identifier

1. Select the authentication module under Authentication method in the
connection dialog.

This displays a list of all available authentication modules.

2. Enter the login data for the system user ID.

The login data required depends on which authentication module you select.

3. Click Connect.

The connection data is saved and made available for the next login.

Figure 6: Login window

For more information about the One Identity Manager authentication modules and program
functions, see the One Identity Manager Authorization and Authentication Guide.

Related topics

l Logging in to the One Identity Manager database on page 157
l Enabling additional authentication modules on page 161
l Error messages logging in to One Identity Manager tools on page 166
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Enabling additional authentication
modules

For more information about One Identity Manager authentication modules, see the One
Identity Manager Authorization and Authentication Guide.

To enable an authentication module

1. In the Designer, select the Base data > Security settings > Authentication
modules category.

2. In the List Editor, select the authentication module.

3. In the Properties view, set the Activated property to True.

4. Select the Database > Save to database and click Save.

Language settings in One Identity
Manager

The default One Identity Manager installation is supplied in the English - United States
[en-US] and German - Germany [de-DE] language. You can add other languages to the
user interface and display text if required. In this instance, you must translate the text
before One Identity Manager goes live. There is a Language Editor in the Designer to help
you do this. A special control is provided in the One Identity Manager tools that aids multi-
language input.

One Identity Manager default language

Maintenance of default data takes place in the default language. The default language for
an installation of One Identity Manager is English - United States [en-US]. The default
language is valid across the system. It is not recommended to change the default language
during working hours.

In the ideal case, the One Identity Manager language matches the user’s administration
tool login language. If these two settings are different, then the default language is
used if no captions are found in the requested login language for a set of language-
dependent data.

User login language

The language used in the user interface is the same as the language used when logging in
to the administration tools. When you log in for the first time, the system language is used
for displaying the user interface. Users can change their login language in the program
settings in all administration tools. This sets the language globally for all the user’s tools.
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Therefore, the user does not have to set the login language in every tool separately.
Changes to the login language take effect after the tool is restarted.

Any language for which the Select in front-end option is activated can be used as a
login language.

Related topics

l Enabling other login languages on page 162

Enabling other login languages

Any language for which the Select in front-end option is activated can be used as a
login language.

To enable an additional login language

1. In the Designer, select the Base data > Localization > Languages category.

2. In the List Editor, select the language.

3. In the Properties view, set the Select in front-end property to True.

4. Save the changes.

5. Select the Database > Save to database and click Save.

Related topics

l Language settings in One Identity Manager on page 161

Password expiry

There are different ways to inform users that their password is going to expire:

l Users are alerted about their password expiring when they log in to One Identity
Manager and can change their password if necessary.

l For employee-based authentication modules, the system sends reminder
notifications in relation to expiring passwords as of seven days in advance of the
password expiry date.

l You can adjust the time in days in the Common | Authentication |
DialogUserPasswordReminder configuration parameter. Edit the
configuration parameter in the Designer.

l The notifications are triggered in accordance with the Reminder system user
password expires schedule and use the Employee - system user
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password expiresmail template. You can adjust the schedule and mail
template in the Designer if required.

TIP: To prevent passwords expiring for service account, for example, you can set
Password never expires (DialogUser.PasswordNeverExpires) in the Designer for the
affected system users.

Checking authentication

When a user logs in, a validity check is run. Use the settings to configure additional options.

l The system runs additional validity checks to prevent users from working with
established connections, if they were deactivated after they logged in. The check
takes place with next action on the connection after a fixed interval of 20 minutes.

You can adjust the interval in the Common | Authentication | CheckInterval
configuration parameter. In the Designer, edit the configuration parameter.

l The number of session that a user can open within a short time is limited to 10
session a minute.

If this number is exceeded, the user is sent an error message.

You have logged in too often in the last minute. Please wait a moment before
you log in again.

This check is done for each front-end if the login is local. If the login is on the
application server, it is checked for each application server.

You can modify the number of sessions in the Common | Authentication |
SessionsPerUserAndMinute configuration parameter. In the Designer, edit the
configuration parameter.

l Use the QBM | AppServer | SessionTimeout configuration parameter to add the
timeout in hours, after which inactive application server sessions are closed. The
default value is 24 hours. In the Designer, edit the configuration parameter.

Connection pool for separate sessions
for reading and writing on different
database servers

To be able to use separate session for reading and writing to different databases servers,
you need to adjust the connection data of the Data Source property.

The Data Source property can contain a pipe (|) delimited server list. The first server
specified is the primary server used for write access. All other servers are read-only copies
with read access only. The prerequisite for this is that the database name and the
credentials on the secondary servers are identical to the primary server.
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NOTE: In the connection dialog you can reach the property through the Options >
Advanced options setting.

The internal physical read sessions are distributed randomly over the read-only copies and
the primary server. With one primary server and two secondary servers, the primary server
receives approximately 1/3 of the connections for read operations.

NOTE: The connection pool does not open a new connection for each operation. If no new
parallel requests come, all requests run over the same connection and therefore on the
same server.

The procedure relies on replication taking place between the servers and the data always
being up to date in the copies as well.

Related topics

l Logging in to the One Identity Manager database on page 157

One Identity Manager 9.0 Installation Guide

Logging in to One Identity Manager tools
164



Appendix A

Appendix:Troubleshooting

For more information, see the One Identity Manager Process Monitoring and
Troubleshooting Guide.

Displaying the transport history and
testing the One Identity Manager
version

During a schema installation or schema update using the Configuration Wizard, the
migration date and migration version are recorded in the database transport history.

When you import a transport package with the Database Transporter, the import date and
description, the database version, and the transport package name are recorded in the
transport history of the target database.

To display transport history

l Start the Designer and select the Help > Transport historymenu item.

To obtain an overview of the system configuration

l Start the Designer or the Manager and select the Help > Infomenu item.

The System information tab provides an overview of your current system
administration and the installed modules with their versions.

IMPORTANT: You will need to provide this information if you contact the
Support Team.

NOTE: If you have enabled vendor notification, this report is sent once a month to
One Identity.

Related topics

l One Identity Manager vendor notification on page 68
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Error messages logging in to One
Identity Manager tools

Problem

When logging in to a One Identity Manager tool, the following error message appears:

[810284] Failed to authenticate user.

[810015] Login for user {0} failed.

[810017] Wrong user name or password.

Possible cause

l The specified user is not supported by the selected authentication module.
l The specified password is incorrect.
l The user account used for the login is locked.
l The employee used to log in is temporarily or permanently deactivated.
l The employee used for log in is classified as a security threat.

Possible solutions

l Check your login credentials.
l Check if the employee being used to log in is locked. In the Manager, use the
following menu items in the Employees category.

l Inactive employees: This displays temporarily and permanently deactivated
employees.

l Security incidents: This displays the employees who are classified as
security threats.

l Locked employees: This displays employees that have exceeded the
maximum number of failed logins and have been locked out.

l Check if the system user used to log in is locked. Locked system users are
displayed in the Designer in the Permissions > System users > Locked
system users category.

For more information about deactivated employees, see the One Identity Manager Identity
Management Base Module Administration Guide.

You can reset the passwords of employees and system users who have been blocked in
Password Reset Portal. This unlocks the employees and system users again. For more
information, see the One Identity Manager Web Designer Web Portal User Guide and the
One Identity Manager Web Application Configuration Guide.

Problem

When logging in to a One Identity Manager tool, the following error message appears:
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[810374] You are not allowed to run this application.

Cause

The One Identity Manager tools can only be started if the user has the relevant program
function permissions. You are logging in with a system user ID that does not have the
required permissions to start the program.

Possible solutions

l Use a system user ID that has permissions to use the required program function to
start the program.

l Provide the system user with the required program function.
l In the Designer, search in the Permissions > Program functions category
for the permissions group that has the required program functionality.

l For non role-based login: Add the system user to the permissions group in the
Designer under Permissions > System users.

l For role-based logins: Ensure that the user is assigned to the application role
that contains the program function.

For more information about the One Identity Manager authentication modules, permissions
groups and application roles, as well as program functions, see the One Identity Manager
Authorization and Authentication Guide

Error messages when installing and
updating the One Identity Manager
database

Before the installation or update of the One Identity Manager database starts, the
Configuration Wizard checks the settings of the database server and the database required
for the installation and operation of the One Identity Manager database. For more
information, see Settings for the database server and the One Identity Manager database
on a SQL Server on page 22.

Some of these settings are corrected by the Configuration Wizard. If the correction is not
possible, a corresponding message is issued in Configuration Wizard. In this case, correct
the errors manually.

Message Solution

The database collation setting Set the Sort order (collation) database property to the

Table 40: Messages in the Configuration Wizard before starting the installation
or update of a database
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Message Solution

is not valid. SQL_Latin1_
General_CP1_CI_AS is
required.

value SQL_Latin1_General_CP1_CI_AS.

The migration cannot be
carried out because a
replication is currently
running.

For more information, see Database errors migrating a
database to SQL Server AlwaysOn availability groups on
page 169.

The value in
DialogDatabase.DataOrigin is
invalid. Start by running a
database compilation.

Use the Database Compiler to regenerate a database ID
and to compile the database. All parts of the database
need to be recompiled. Make sure that all the code
snippets and all processes are marked.

The database has no data-file
group for in-memory OLTP.

Use the repair method to create a data-file group.

The database has not defined
a file in the data-file group for
in-memory OLTP.

Use the repair method to create a database file. The file is
created in the directory of the data file (*.mdf).

The SQL Server has not
activated in-memory OLTP.

Set the Is XTP Supported database server property
value to True.

The Arithmetic Abort enabled
database property is not
enabled.

Set the Arithmetic Abort enabled database property
value to True.

The Quoted Identifiers
Enabled database property is
not activated.

Set the Quoted Identifiers Enabled database property
value to True.

You cannot run a migration if
the recovery model is not
Simple.

Set the Recovery model database property value to
Simple.

The transaction mode cannot
be set because other users
are active.

End the connections of other users to the database.

The Job queue and/or the
DBQueue is not empty. Refer
to the documentation for
additional information and
suggested solutions for this
test.

Ensure that the Job queue processes and task in the
DBQueue have been processed before starting the
update. Use the Job Queue Info program to monitor
process handling. For more information, see the One
Identity Manager Process Monitoring and Troubleshooting
Guide.

The Configuration Wizard has the option to ignore this
message. Only use this option in test or development
environments. By updating the database, modifications
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Message Solution

may be made that result in not being able to handle the
processes anymore.

The viadmin system user
must have a valid password
that is not empty.

Make sure that the system user has a valid password.

The database has the status
'Initialmigration'. Therefore
the Configuration Wizard
cannot be run.

The initial schema installation of the database was not
completely finished. This may have different reason. For
example, the database or failover cluster could not be
reached during the schema installation.

Create a new database and rerun the initial schema
installation. For more information, see Installing and
configuring a One Identity Manager database on page 50.

The SQL Server login
specified in
QBMDBPrincipal.LoginName
does not exist.

Use the repair method to create the SQL Server login.

Database errors migrating a database
to SQL Server AlwaysOn availability
groups

Possible problems

l The data does not start updating. The Configuration Wizard shows the message:

The migration cannot be carried out because a replication is currently
running.

l The following error occurs during a One Identity Manager schema update:

Database error 1468: The operation cannot be performed on database "<database
name>" because it is involved in a database mirroring session or an
availability group. Some operations are not allowed on a database that is
participating in a database mirroring session or in an availability group.
ALTER DATABASE statement failed.

Cause

The database is part of an AlwaysOn availability group.
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Solution

1. Remove the database from the AlwaysOn availability group.

2. Update the One Identity Manager schema.

3. Put the database back into the AlwaysOn availability group.

Message: Enter email address in
configuration parameter

In a process for sending emails, the value of the SenderAddress or Address parameter is
<Enter email address in configuration parameter "...">. Check process parameters in
Job Queue Info.

The message is also sent to the One Identity Manager Service log file if extended error
reporting in debug mode is configured for the One Identity Manager Service.

Probable issue

One Identity Manager sends email notifications about various actions taken within the
system. One Identity Manager email notification system is not completely configured.

Solution

Check the configuration parameters for the email notification system. To do this, use the
email configuration wizard.

To start the email configuration wizard in the Launchpad.

1. In the Launchpad, in the Configuration section, select Configure email
connection.

2. Click Run.

To start the email configuration wizard in the Designer.

1. In the Designer, in the Base data > General > Configuration parameters
category, select the Common | MailNotification configuration parameter.

2. In theConfiguration Parameter Editor, click ... next to the Value field.

Detailed information about this topic

l Setting up the email notification system on page 70
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Removing unnecessary modules from
the One Identity Manager database

You can remove modules from the One Identity Manager database that you no longer
require in your system.

IMPORTANT:

l By removing a module, you lose all the data that goes with it. So it is
important to make a backup of the One Identity Manager database before
removing any modules.

l In certain circumstances, dependencies to other modules may be deleted by
removing a module. Therefore, update the One Identity Manager schema after
removing a module.

l Other tests may be necessary after removing a module. Remove the module in
your test environment first and test the One Identity Manager functionality
thoroughly. Make sure to also check any custom adaptations that may use
functions in the modules that have been removed.

To remove a module

1. Terminate all web applications using the Internet Information Services (IIS)
Manager.

2. Close all One Identity Manager tools except for Job Queue Info.

3. Wait until all processes have stopped. You can do this using the Job Queue Info.

4. Stop all One Identity Manager Services through the services manager.

5. Stop all application servers using the IIS Manager.

6. Wait until all DBQueue Processor tasks have completed. You can do this using the Job
Queue Info.

7. Close Job Queue Info.

8. Start a suitable program for running SQL queries.

IMPORTANT:
l Select a user that you use for migrating the database to run the SQL queries.
l Run the following steps separately using a suitable program for running
SQL queries.

Test the output of the query after each step. The output provides additional
tips for removing a module.

a. Activate single-user mode for the One Identity Manager database.

exec dbo.QBM_PSingleUserRequest @@spid

b. Stop the DBQueue Processor components.

exec QBM_PWatchDogPrepare 1
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go

exec QBM_PDBQueuePrepare 1

go

c. Delete all triggers in the database.

exec QBM_PTriggerDrop '%', @force = 1

d. Delete all constraints in the database.

exec QBM_PConstraintFKDrop '%','%','%'

e. Delete the module you no longer need.

exec QBM_PModuleRemove '<3-char module abbreviation>'

Example:

declare @ModulesToRemove varchar(100) = 'SAP' + char(7)

+ 'SHR' + char(7)

+ 'SBW' + char(7)

+ 'SAC' + char(7)

exec QBM_PModuleRemove @ModulesToRemove

go

f. If you delete the Business Roles Module (RMB), you must also delete the
entries in the OrgRoot table.

exec QBM_PDeleteDeep '<Key><T>OrgRoot</T><P>3031e9af-6a53-4876-bbfb-
0f7fbf264131</P></Key>

9. End single-user mode for the One Identity Manager database.

exec dbo.QBM_PSingleUserRelease @@spid

10. Update the One Identity Manager schema with the Configuration Wizard. Select all
remaining modules for updating.

11. If support sent you hotfixes for this version, then these hotfixes must also be
reinstalled.

12. Start the application server, the One Identity Manager Services and the web
applications.

Deleting One Identity Manager
databases

The Configuration Wizard provides support for deleting a One Identity Manager database.
Deleting a database also removes the database users, database roles, and server roles, as
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well as SQL Server logins.

NOTE: Always start the Configuration Wizard on an administrative workstation!

To delete a database

1. Start the Configuration Wizard.

2. On the Configuration Wizard home page, select the Delete One Identity Manager
database option and click Next.

3. On the Select database page, select the database and installation directory.

a. Select the database connection in the Select a database connection pane.
Select a user who at least has administrative permissions for the One Identity
Manager database.

b. In the Installation source pane, select the directory with the
installation files.

4. On the Database check page, errors are displayed that prevent the database from
being processed. Correct the errors before you continue updating.

5. To start the deletion process, click Next.

6. On the Processing database page, each step of the deletion process is displayed.

a. Read and check each step.

b. To run the step, click Confirm delete.

c. After the deletion process is complete, click Next.

7. On the last page of the Configuration Wizard, click Finish.

Log message for search index creation

Indexing log messages are stored in the application server log (\App_
Data\Logs\AppServer.log by default).

A new indexing run usually starts after the indexing interval period specified by the
Common | Indexing | Interval configuration parameter has elapsed.

If a table being indexed contains more objects to be indexed than the maximum specified
by the Common | Indexing | BatchSize configuration parameter, then the indexing
process for the table will stop.

A message is written to the application server log:

INFO (Indexing ): Index for Person partially updated, will continue at
next run

If at least one table has not been fully indexed, then indexing will restart after three
seconds. A message is written to the application server log:

INFO (Indexing ): Index is incomplete (28.06%); indexing will continue
in 3000 ms
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If a signal to reuse (<recycling>) the application pool has already been received, the log
message will read, for example:

INFO (Indexing ): Index is incomplete (28.06%); indexing will continue when
the application re-starts

As long as there is at least one incomplete table, then only the incomplete tables will be
indexed during an indexing run.

One Identity Manager 9.0 Installation Guide

Appendix: Troubleshooting
174



Appendix B

Appendix:Advanced configuration of the
Manager web application

NOTE: The Web Installer uses default values for most configuration settings. You can use
these values normally. It is recommended you check the settings with the help of the
Manager Web Configuration Editor.

You configure the Manager web application configuration with the Manager Web
Configuration Editor. The Manager Web Configuration Editor is part of the web application
and can be found in the install directory in the subdirectory WebConfigEditor.

To run configuration

1. Start the file WebConfigEditor.exe and log in to the One Identity Manager database.

The Manager Web Configuration Editor automatically opens the web.config file of the
web application.

2. Modify the configuration settings.

3. Save the changes.

Detailed information about this topic

l General settings of the Manager web application on page 176
l Database connection for the Manager web application on page 176
l Security settings of the Manager web application on page 177
l Debug settings of the Manager web application on page 178
l Performance settings of the Manager web application on page 179
l Settings for downloading the Manager web application on page 180
l ASP.Net basic settings for the Manager web application on page 180
l Configuring the application pool of the Manager web application on page 181
l Plugins for the Manager web application on page 182
l Load balancing of the Manager web application on page 183
l Manager web application single sign-on on page 184
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General settings of the Manager web
application

In the General pane of the Manager Web Configuration Editor, configure the appearance of
the Manager web application.

Setting Description

Language Language. The language influences how dates and numbers displayed
amongst other things.

Session
timeout

User's idle time in minutes after which the user is automatically logged
out. This value depends on the timeout mode and directly effects
memory requirements and therefore the application's performance.

NOTE: This value should be set as long as required and as short as
possible because orphaned sessions use memory and negatively effect
the application's performance.

Timeout mode Methods for determining timeouts. Permitted values are:

l TimeOut: A session is ended when the period of time defined
under the session timeout has elapsed with no user activity.

l HeartBeat: A session is ended when the period of time defined
under the session timeout has elapsed with no user activity. The
user's open browser window prompts automatically. The timeout
begins when the browser window is closed.

Visualization Visualization of the application.

Dynamic
design select

Not in use.

Enable portal
mode

Permits the application in a frame to be linked to another application.

Table 41: Meaning of general configuration settings

Database connection for the Manager
web application

In the Database connection pane of the Manager Web Configuration Editor, specify all
database parameters for the Manager web application.
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Setting Description

Database Database connection. You can select between a SQL Server database
connection and an application server.

Application Application which specifies the contents of the web application.
Usually, you selectManager.

Display name Name used as application name, as in the title bar of the browser, for
example.

Authentication Methods for authenticating the user when logging in to the application.

Single sign-on Specifies whether single sign-on is used. Set this option if you user
single sign-on. The application does not display a login page to the user
but tries to identity the user automatically.

Table 42: Meaning of database connection configuration settings

Security settings of the Manager web
application

In the Security pane of the Manager Web Configuration Editor, you define several
important settings that influence the security of the Manager web application.

Setting Description

Staging Default configuration of the staging environment. This setting also affects
other configuration groups. Permitted values are:

l Production: Recommended setting for all live installations.
l Test: Setting, if the application was installed for test purposes.
l Development: Setting, if the application was installed in a devel-
opment environment.

l Custom: Setting, if all settings are made manually.

Invalid
session
response
delay

Time in seconds that a client sided request with false session data is blocked.
This setting prevents possible "Brute force" access attempts.

Permit
login
without
cookies

The application uses session cookies to secure client-server communication.
Set this setting to allow user login without cookies. This would be the case,
for example, if cookies were forbidden in a company network.

NOTE: It is not recommended to enable this setting.

Table 43: Meaning of configuration settings for security
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Setting Description

Close
browser
window
after
logout

Specifies whether the browser window is closed after logging out. If this
setting is enabled, the application tries to close the user's browser window
after logging out. This function is not supported by every browser or only
when the browser prompts.

NOTE: By default, use of SSL is disabled. SSL can now be optionally enabled. To do this,
insert the following entry in the application section of the Manager web application's
configuration file (Web.config).

<add key="AllowSSL" value="True" />

Debug settings of the Manager web
application

The Debugging pane of the Manager Web Configuration Editor contains useful settings
for troubleshooting in the Manager web application. Normally, you cannot configure
anything here.

Setting Description

Log mode The amount of data to be logged.

NOTE: When the application is in productive operation, Normal
should be set.

Enable
documentation
mode

Specifies whether additional data is displayed in the application
interface, for example, the name of the active form. The effect
depends on the visualization selected.

NOTE: This setting should not be enabled in a live environment.

Enable SQL log Specifies whether the all database instructions are logged. The log is
written in the SQL log directory.

NOTE: This setting should not be enabled in a live environment.

Show ASP.Net
error messages

Specifies whether ASP.Net's own error messages are shown.

NOTE: This setting should not be enabled in a live environment.

Enable test
mode

Specifies whether automatic tests are supported.

NOTE: This setting should not be enabled in a live environment.

Table 44: Meaning of configuration settings for debugging
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Related topics

l Configuring the Manager web application's directories on page 181

Performance settings of the Manager
web application

In the Performance pane of the Manager Web Configuration Editor, you define several
important settings that influence the performance of the Manager web application.

Setting Description

Load balancing The mode of integrated load balancing. In most cases,
DistributeEqually should be selected.

Maximum
workload

Maximum number of user sessions an application accepts. The applic-
ation can be installed multiple times if a large number of sessions is
required because system resources for each application process are
limited.

Force
maximum
workload

The value inMaximum workload is overridden is this setting is not
set. However, it is used as a threshold value for the
DistributeSuccessively load balancing method.

Compress
HTTP transfer

Specifies whether use of compression for HTTP communication is set.

NOTE: Compression of HTTP communication must also be configured
for Internet Information Services. For more information see the Web
server documentation.

Host segment-
ation

Specifies host segmentation. This setting allows distribution of client
sided requests to several server addresses representing aliases for the
web front-end. This bypasses some of the browser limitation and can
therefore shorten loading time if the network connection is bad.

Table 45: Meaning of configuration settings for performance

Related topics

l Load balancing of the Manager web application on page 183
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Settings for downloading the Manager
web application

To enable the download of larger files, the Manager web application requires a directory in
which the download can be made available to the user. This effects reports, for example,
which are generated by the application and saved as PDF by the user. You can edit the
settings in the File download pane of the Manager Web Configuration Editor.

Setting Description

Enable file
download

Specifies whether file download is enabled. Enable this setting to allow
larger files, such as reports, to be downloaded. If file download is not set,
certain functions are not available.

Download
directory

Directory for the application to use to make download available. The applic-
ation requires full permissions to this directory.

Cleanup
interval

Time in minutes search for and remove redundant files.

Supply
time

Time in minutes before download is available to the user. Once a download
has been initiated, the application cannot verify when and if the download
was run by the user so that the download must be stopped after a set time
interval.

Table 46: Meaning of the configuration settings for the file download

ASP.Net basic settings for the Manager
web application

In the ASP.NET settings pane, you can see some ASP.Net settings that you can edit with
the Manager Web Configuration Editor.

Setting Description

Max request
length

Maximum length of the user request in kilobytes (KB). This limits, amongst
others, the maximum size of file that can be loaded.

Processing
timeout

Maximum time in seconds for processing a user request. The user request
is stopped abruptly if the timeout is exceeded.

NOTE: This time should not be too short because the user session can be
lost if the timeout is exceeded.

Table 47: Meaning of configuration settings for ASP.Net
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Configuring the Manager web
application's directories

In the Directories pane of the Manager Web Configuration Editor, configure all the
directories required by the Manager web application.

Setting Description

Application
directory

Full path to the application's installation directory. This is the directory
where you will find the file web.config.

NOTE: Ensure correct case.

Log
directory

Directory to which the application log is written. This directory can be
relative to the application directory.

Database
cache

Full path to the directory to save frequently used database contents.

Script
assembly
cache

Full path to the directory for caching assembler files.

SQL log
directory

Full path to the directory where database accesses are logged. The SQL log
is only used for finding errors and must be enabled through the Enable
SQL log option in the Debugging pane.

Table 48: Meaning of configuration settings for directories

Related topics

l Debug settings of the Manager web application on page 178

Configuring the application pool of the
Manager web application

In the Application pool view of the Manager Web Configuration Editor, you define all
applications that work together to make the application available to the user in
multiple languages.

l Click Add application to define another application.
l Click Remove application to select an application to remove.
l You can change the order by using the arrows on the right side.
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NOTE: You must at least define the currently configured application. The order has
immediately effect on login performance because the status of configured applications is
queried in the defined order.

Setting Description

Redirect URL Full address of the application. It must also be possible to resolve this
address on the client side through the user's browser.

NOTE: Ensure correct case.

Authentication The applications communicate with each other over the defined URL.
Permissions are required to do this if anonymous access is not
permitted. The application required the same permissions as required
when the URL is called by browser on the server.

Table 49: Meaning of the configuration settings for the application pool

Related topics

l Load balancing of the Manager web application on page 183

Plugins for the Manager web application

Plugins extend the functionality of the Manager web application. You can enable a plugin
by setting the option in front of the plugin name. You may find plugin specific settings
under a plugin. You can edit the settings in the Plugins pane of the Manager Web
Configuration Editor.

Plugin automatic update

This plugin runs automatic update.

Setting Meaning

Auto update Automatic update is enabled.

Severity code Severity of a change in order to start automatic update.

Table 50: Meaning of configuration settings

Related topics

l Manager web application update on page 154
l Automatic updating of One Identity Manager on page 87
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Load balancing of the Manager web
application

The Manager web application provides simple load balancing in order to distribute user
sessions and the resulting load across multiple processes or even servers. To do this, the
application is installed multiple times on the same or on other servers.

All collaborating applications that can be logged into, are declared in the applications'
Application pool. The selection algorithm for load distribution distributes user logins across
the defined applications.

NOTE: Even if only one application is installed, it must be defined in your application pool,
otherwise you cannot log in.

Algorithm Description

DistributeEqually This algorithm distributes user logins such that each
application in one language has the same number of active
users, if possible. This algorithm is the default and is required
in 99% of cases.

DistributeSuccessively This algorithm distributes user logins by order of application
definition in the application pool. First of all, all user logins are
forwarded to the first application in the desired language.
When this has reached it maximum load, logins are forwarded
to the next application.

Table 51: Supported algorithms for load balancing

Load balancing solves the following problems:

l Multilingual

Language is fixed for per application so that an application can only provide user
sessions in one language. If users can log in with multiple languages, at least one
application must be installed for each language.

l Bypassing resource limitations

If multiple web applications are installed and these are assigned to different Internet
Information Services application pools, these are started in separate processes.

l Increasing performance

Performance can be noticeably improved by installing on several servers.
l Redundancy

Multiple installation does not necessary complete outage if just one of the installed
application fails.
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Related topics

l Configuring the application pool of the Manager web application on page 181

Manager web application single sign-on

The Manager web application supports a single sign-on mechanism that enables
authentication of a user without the user having to repeatedly enter their user name
and password.

Prerequisites required:

l Anonymous access disabled.
l Configuration of an authentication module capable of single sign-on.

For more information about One Identity Manager authentication modules, see the
One Identity Manager Authorization and Authentication Guide.

l Permissions in the application’s own application pool

You can disable anonymous access on the web server. This means the user's browser must
provide the data required for authentication.

To disable the anonymous access

1. open the configuration of the Manager web application in the Internet Information
Services and activate the configuration for Authentication.

2. Change the value of the status to disabled in Anonymous Authentication.

Related topics

l Configuring the application pool of the Manager web application on page 181
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Appendix C

Appendix:Machine roles and installation
packages

Machine role Description of the installation package

Workstation Contains all basic components for installing tools
on an administrative workstation.

Administration Contains One Identity Manager administration
tools required by default users to fulfill their tasks
with One Identity Manager. In addition to the tools
that ensure basic functionality for working with
One Identity Manager, the administration machine
role includes the Manager as a main
administration tool.

Configuration Contains all One Identity Manager tools for the
default user and additional programs for
configuring the system. These include, for
example, the Configuration Wizard, Database
Compiler, Database Transporter, Crypto
Configuration, Designer, Web Designer, and
configuration tools for the One Identity Manager
Service.

Development &
Testing

Contains the One Identity Manager tools for
developing and testing custom scripts and forms,
for example, the System Debugger.

Monitoring Contains One Identity Manager programs for
monitoring the system status, for example, the
Job Queue Info program.

Documentation Contains One Identity Manager documentation in
different languages.

Server Contains all the basic components for setting up a
server.

Table 52: Machine role and installation package options
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Machine role Description of the installation package

Job server Contains the One Identity Manager Service and
basic processing components. Additional machine
roles contain connectors for synchronizing
individual target systems.
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Appendix D

Appendix:Configuration parameters for the
email notification system

Use the following configuration parameters to configure the email notification system.

Configuration parameter Meaning

Common | InternationalEMail Specifies whether international domain names and
unicode characters are supported in email
addresses.

IMPORTANT: The mail server must also support
this function. If necessary, you must override the
script VID_IsSMTPAddress

Common | MailNotification Specifies whether the configuration subparameters
that deal with notifications take effect.

Common | MailNotification |
AcceptSelfSignedCert

Specifies whether self-signed certificates for TLS
connections are accepted.

Common | MailNotification |
AllowServerNameMismatchInCert

Specifies whether server names that do not match
are permitted by certificates for TLS connections.

Common | MailNotification |
DefaultAddress

Default email address of the recipient of the
notifications.

Common | MailNotification |
DefaultCulture

Default language used to send email notifications if
a language cannot be determined for a recipient. All
the languages from the QBMCulture table are
permitted.

Common | MailNotification |
DefaultLanguage

Default language for sending email notifications. All
languages that are enabled in the DialogLanguage
table are permitted.

Common | MailNotification |
DefaultSender

Sender's default email address for sending
automatically generated notifications.

Table 53: General configuration parameters for mail notification
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Configuration parameter Meaning

Syntax:

sender@example.com

Example:

NoReply@company.com

You can enter the sender's display name in addition
to the email address. In this case, ensure that the
email address is enclosed in chevrons (<>).

Example:

One Identity <NoReply@company.com>

Common | MailNotification |
Encrypt

Specifies whether emails are encrypted.

Common | MailNotification |
Encrypt | ConnectDC

Domain controller of the requested domain to use.

Common | MailNotification |
Encrypt | ConnectPassword

Password of the user account. This is optional.

Common | MailNotification |
Encrypt | ConnectUser

User account for querying Active Directory. This is
optional.

Common | MailNotification |
Encrypt | DomainDN

Distinguished name of the domain to request.

Common | MailNotification |
Encrypt | Encryp-
tionCertificateScript

This configuration parameter contains the script
that supplies a list of encrypted certificates (default:
QBM_GetCertificates).

Common | MailNotification |
NotifyAboutWaitingJobs

Specifies whether a message should be sent if the
process steps have a particular status in the Job
queue.

Common | MailNotification |
SignCertificateThumbprint

SHA1 thumbprint of the certificate to use for the
signature. This can be in the computer's or the
user's certificate store.

NOTE: Ensure that the private key in the certi-
ficate is marked as exportable.

Common | MailNotification |
SMTPAccount

User account name for authentication on an SMTP
server.

Common | MailNotification |
SMTPDomain

User account domain for authentication on the
SMTP server.

Common | MailNotification |
SMTPPassword

User account password for authentication on the
SMTP server.
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Configuration parameter Meaning

Common | MailNotification |
SMTPPort

Port of the SMTP service on the SMTP server.
Default: 25

Common | MailNotification |
SMTPRelay

SMTP server for sending email notifications. If a
server is not given, localhost is used.

Common | MailNotification |
SMTPUseDefaultCredentials

Specifies which credentials are used for
authentication on the SMTP server.

If this parameter is set, the One Identity Manager
Service login credentials are used for authentication
on the SMTP server.

If the configuration parameter is not set, the login
data defined in the Common | MailNotification |
SMTPDomain and Common | MailNotification |
SMTPAccount or Common | MailNotification |
SMTPPassword configuration parameters is used.
(Default)

Common | MailNotification | Trans-
portSecurity

Encryption method for sending email notifications.
If none of the following options are given, the port is
used to define the behavior (port 25: no encryption,
port 465: with SSL/TLS encryption).

Permitted values are:

l Auto: Identifies the encryption method
automatically.

l SSL: Encrypts the entire session with
SSL/TLS.

l STARTTLS: Uses the STARTTLS mail server
extension. Switches TLS encryption after the
greeting and loading the server capabilities.
The connection fails if the server does not
support the STARTTLS extension.

l STARTTLSWhenAvailable: Uses the
STARTTLS mail server extension if available.
Switches on TLS encryption after the greeting
and loading the server capabilities, however,
only if it supports the STARTTLS extension.

l None: No security for the transport layer. All
data is sent as plain text.

Common | MailNotification |
VendorNotification

Email address of your company's contact person.
The email address is used as the return address for
notifying vendors.
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Configuration parameter Meaning

If the configuration parameter is set, One Identity
Manager generates a list of system settings once a
month and sends the list to One Identity. This list
does not contain any personal data. You can check
the latest system information at any time by
selecting Help > Info in the menu.

The list will be reviewed by our customer support
team, who will look for material changes in a
proactive effort to identify potential issues before
they materialize on your system. The lists may be
used by our R&D staff for analysis, diagnosis, and
replication for testing purposes. We will keep and
refer to this information for as long as your
company remains on support for this product.

Configuration
parameters

Description

QER | Attestation |
DefaultSenderAddress

Sender's default email address for sending automatically
generated notifications about attestation cases. Replace the
default address with a valid email address.

QER | ComplianceCheck
| EmailNotification |
DefaultSenderAddress

Sender's default email address for sending automatically
generated notifications about rule checking. Replace the
default address with a valid email address.

QER | ITShop |
DefaultSenderAddress

Sender's default email address for sending automatically
generated notifications about requests. Replace the default
address with a valid email address.

QER | Policy |
EmailNotification |
DefaultSenderAddress

Sender's default email address for sending automatically
generated notifications when company policies are checked.
Replace the default address with a valid email address.

QER | RPS |
DefaultSenderAddress

Sender's default email address for sending automatically
generated notifications about report subscriptions. Replace
the default address with a valid email address.

TargetSystem | ADS |
DefaultAddress

Default email address of the recipient for notifications about
actions in the Active Directory target system.

TargetSystem | ADS |
Exchange2000 |
DefaultAddress

Default email address of the recipient for notifications about
actions in the Microsoft Exchange target system.

TargetSystem | ADS |
MemberShipRestriction |
MailNotification

Default email address for sending warning emails.

Table 54: Additional parameters for email notifications
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Configuration
parameters

Description

TargetSystem | AzureAD
| DefaultAddress

Default email address of the recipient for notifications about
actions in the Azure Active Directory target system.

TargetSystem | AzureAD
| ExchangeOnline |
DefaultAddress

Default email address of the recipient for notifications about
actions in the Exchange Online target system.

TargetSystem | CSM |
DefaultAddress

Default email address of the recipient for notifications about
actions in the cloud target system.

TargetSystem | EBS |
DefaultAddress

Default email address of the recipient for notifications about
actions in the Oracle E-Business Suite target system.

TargetSystem | LDAP |
DefaultAddress

Default email address of the recipient for notifications about
actions in the LDAP target system.

TargetSystem | NDO |
DefaultAddress

Default email address of the recipient for notifications about
actions in the HCL Domino target system.

TargetSystem | SAPR3 |
DefaultAddress

Default email address of the recipient for notifications about
actions in the SAP R/3 target system.

TargetSystem |
SharePoint |
DefaultAddress

Default email address of the recipient for notifications about
actions in the SharePoint target system.

TargetSystem | Unix |
DefaultAddress

Default email address of the recipient for notifications about
actions in the Unix-based target system.

TargetSystem | UNS |
DefaultAddress

Default email address of the recipient for notifications about
actions in the custom target system.

TargetSystem | PAG|
DefaultAddress

Default email address of the recipient for notifications about
actions in the Privileged Account Management system.

Detailed information about this topic

l Setting up the email notification system on page 70
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Appendix E

Appendix:How to configure the One Identity
Manager database using SQL Server

AlwaysOn availability groups

Only the settings for working with One Identity Manager are described below. For more
information about SQL Server AlwaysOn availability groups, see Always On availability
groups: a high-availability and disaster-recovery solution.

NOTE: If you want to include a One Identity Manager database in a SQL Server AlwaysOn
availability group, note that one availability group is required per availability database.

Example:

You want two databases (for example, UAC and QA) to be part of an SQL Server
AlwaysOn availability group as availability databases. Each database requires its own
availability group (for example, AGUAC and AGQA).

Prerequisite

A failover cluster manager has been configured. Therefore, run the Server Manager on the
database server and install the Failover Clustering feature.

Installing One Identity Manager

1. Run the program Configuration Wizard against a cluster node and follow the
installation instructions.

2. Install and launch the One Identity Manager Service. After all processes in the Job
queue have been processed, stop the One Identity Manager Service.

3. Run the Designer and set up the staging layer for the database.

4. In SQL Server Management Studio, change the recovery model for the One Identity
Manager database from Simple to Full.

5. Create a full backup of the database.

6. Make sure that the firewall is configured to support cluster communication.

7. Run the SQL Server Configuration Manager and locate the SQL Server service. Open
the properties and enable Always-On Availability Groups. Restart the SQL Server
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service on all nodes.

For more information, see Enable or Disable Always On availability group feature.

Configuring the SQL Server AlwaysOn availability groups

1. In SQL Server Management Studio, connect the server instance that hosts the
primary node. To configure the availability groups, navigate to AlwaysOn High
Availability, right-click and select New Availability Group Wizard.

For more information about the New Availability Group Wizard, see Use the
Availability Group Wizard (SQL Server Management Studio).

2. In the New Availability Group Wizard, enter the name of the new availability group
and select the One Identity Manager database to be included in the new
availability group.

3. In the New Availability Group Wizard, you create and configure a replica for the new
availability group.

a. Add the secondary SQL Server cluster node.

b. Enable automatic failover and synchronous handover for both nodes.

c. Make all nodes a readable secondary node; select the Yes value.

d. Specify an availability group listener.

For example, for the DNS name, use the same name as the availability group
but with the suffix "L", and use port 1433. Assign an IP address on the same
subnet as the SQL Server.

For more information, see Specify Replicas Page (New Availability Group
Wizard: Add Replica Wizard).

4. In the New Availability Group Wizard, you define the settings for data
synchronization. The settings for data synchronization depend on your infrastructure.

If you are using a network share to synchronize data between replicas, select the Full
option and specify the network location. Server instances hosting a replica require
read and write access to the share.

One Identity Manager configuration

1. Run the program Database Compiler. Connect to the primary node and compile the
database. Do not change the database connection data at this time.

For more information, see the One Identity Manager Operational Guide.

2. Then update the database connection data in Designer.

a. Start the Designer and connect to the primary node.

b. In the Designer, select the Base Data > General > Databases category.

c. Select the database in the List Editor.

d. Select the Define connection string for database task.
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e. Enter the connection data for the database. Use the DNS name of the listener
instead of the server name.

For more information, see the One Identity Manager Configuration Guide.

NOTE: Repeat these steps for all associated One Identity Manager History
Database databases.

3. Run the program Database Compiler and compile the database. Use the listener.

4. Run the Job Service Configuration and change the connection details for the One
Identity Manager Service. Use the listener.

It is recommended to change the queue name to better reflect the cluster. Note that
you also update the queue name in Designer.

For more information, see the One Identity Manager Configuration Guide.

5. Ensure that Job servers, application servers, front-ends, web applications, and
synchronization projects use the listener to log in to the database.

Related topics

l Installing and configuring a One Identity Manager database on page 50
l Installing and configuring the One Identity Manager Service on page 77
l Logging in to One Identity Manager tools on page 156
l Database errors migrating a database to SQL Server AlwaysOn availability
groups on page 169
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About us

About us

One Identity solutions eliminate the complexities and time-consuming processes often
required to govern identities, manage privileged accounts and control access. Our solutions
enhance business agility while addressing your IAM challenges with on-premises, cloud and
hybrid environments.

Contacting us

For sales and other inquiries, such as licensing, support, and renewals, visit
https://www.oneidentity.com/company/contact-us.aspx.

Technical support resources

Technical support is available to One Identity customers with a valid maintenance contract
and customers who have trial versions. You can access the Support Portal at
https://support.oneidentity.com/.

The Support Portal provides self-help tools you can use to solve problems quickly and
independently, 24 hours a day, 365 days a year. The Support Portal enables you to:

l Submit and manage a Service Request
l View Knowledge Base articles
l Sign up for product notifications
l Download software and technical documentation
l View how-to videos at www.YouTube.com/OneIdentity
l Engage in community discussions
l Chat with support engineers online
l View services to assist you with your product
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